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Appendix B. Zeolite Specifications

P T L. :'4
St. Cloud Mining Company
P.O, Box 1670 Truthor Consequences, New Mexico 87901
Phone: 505-743-5215 Fax: 5(5-743 3333 webme Wi, slclnudmining com
Email:

St. Cloud Natural Ze()‘lite (Clinoptilolite)

Product Information Sheet
Natural zeolites are a unique type of microporous volcanic mineral with sieving and cation exchange
properties for use in agriculture, envxronmentai and industrial appllcatxons $t. Cloud Mining.Company is the
largest producer of natural zeolite in North América.

« Uses of St. Clood Zeaolite
St. Cloud Zeolite has hundreds of proven uses, and the Iist continues to grow. St. Cloud Zeolite is a natural
mineral produced by all natural means, and}is used as an animal feed supplement that has been shown to
improve health and reduce the negative effects of animal weste; as an additive to.animal stalls @nd pens to
redice ammonia and other emissions 1o air and water; as'a soil amendment to retain water and plant
nutrients in root zones, which conserves béth for a.number of other horticultural and agricultural uses,
including being the only zeolite endorsed for use in space by NASA; as o water filtration media that
removes ammonia, some heavy metals and other constituents; and dozens of other uses.

* Physical Properties
Bulk Derisity (In Place, dried) w.uussmessssmm] .87 Tbs/f2 (1,390 kg/m®)
Bulk Density (Aggregate, dried. Common sizes)
4 X 6 Mesh..... 44-48 Ibs/fY
6 X 14 Mesh 45-47.Ibs/f
14 X 40 Mesh.. 46:49 Ibs/iY
-40 Mesh 48-52 ths/ft’
-100 Mésh 49-53 lbs/ft?
<325 Mesh 43-47 [bs/ft"
Clinoptilolite content................ .75 to 85%
Cation Exchiange Capacity (CE 0.8 ~1.2 meg/g
Surface Charge density umumeeeeesseresessmens. . 10.1E-23 meq/A?
Color . White (85 !Jncal reflectance)
Crushing Strength 2,500 1bs/in” (176 kg/m”)
Hardness 3.5-4.0 Mohs
LA Wear (Abrasion IHdeX).... ... .seessoensed .24
Molecular Ratio ... : 5.1 (Si/Al)
pH (natural) . 7.5t0 8.0
pH Stability . 0-13
Permenbility ....... 107 mssec (1.4 - 0.4 mm pafticles)
Pore Size (dIAMELET) ...rvvuummseresrsncsnsssssssssen .4 - 7 angstroms
Pore Voliime s s52%
Resistivity : .~ 9,000 ohms/cm
Specific Gravity 22-24:1
External Surface Area........civememnminss 141015 m¥/g
Total Surface Area <800 mig
Swellmg Index ; L.nil
Thermal Stability Sunseen. 1,202° F (650° C)
Other........ nan-soluble, non-slaking, free flowing, readily mixable
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» Chemical Analysis

(Ca, Nay, K2){Al¢ Si0) 24H,0; Calcium:sodium-potassium aluminosilicate). In approximate weight percent

for major oxides:
CaQ 34% Mg0 1.5%
K0 3.0% PO,  0.05%

Na,O 0.3% Fe,03  1.6%
AlLQy 12.1% 8i0; 70.0%

» Chemical Composition for selected eletents by x-ray fiuorescence (in weight % or ppm, as noted)

Ca 24% Mg 09%
K 12% P 0.01%

« Cation Exchange Capacity
Total exchange capacity of 0.8 - 1.2

« Major Exchangeable Cations
Rb, Li, K, Cs, NH,, Na, Ca, Ag, Cd,
cations is & function of hydratéd mole

* Primary Adsorbing Gases:
CO, CO;, SO,, H,S, NH,;, HCHO, Ar,
mercaptans.

 Environmentel Properties
Zeolites are ngatx_:ral, inert, non-toxic

Na 01% Fe 06% Cu 10ppm
Al 3.1% St 32.9% Zn  S9ppm

meq/g total, and an external exchange capacity of about 0.1 meq/g.

Pb, Zn, Ba, Sr, Cu, Hg, Mg, Fe, Co, Al, Cr. (selectivity .of above
zcular size and relative concentrations).

0,3, N, H;0, He, H,, Kr, Xe, Ch;OH, Freon, formaldehyde, and

substances which are federally classified as GRAS (Generally

Regarded As Safe) in most appllcanons and exempted from most rc'gulatlons and reporting when used in

accordance with good agncultural pra

lce and when less than 2% in animal feed products (40 CFR, Part

180.1001 and elsewhere). St. Cloud Zedlite is USDA approvod as an absorbent for spills in food processing

[‘ac:lmes‘t;nd complies with federal an
detected and crystalline siliﬁa is presen
CAS No. 1318-02-1) for additional info

d state environmental requirements. No fibrous silicates have been
in quantities of less than 0.01%. Reference MSDS Sheet (product
mation.

» Location - St. Cloud’s Zeolite operation is centrally located near Winston, New Mexico, approximately 35
miles west of Interstate 25 midway between Albuquerque, New Mexico and El Paso, Texas.

» Reserves - An 18.3 million ton zeolite re’serve base mined from surface exposures 1.5 miles from plant site,

* Delivery and Freight - Motor camet‘s for packaged and bulk products for domestic and intemational
destinations. Bulk rail facilities are ava:lablc by special arrangement. UPS, LTL, and régional warshousing
services also available. Warehouse custgi)mer pick-ups 8:00 am-3:00 PM, 5 days per week, or 24 hrs per day

or hy prior arrangement. !

» Trade Names .
Sold by St. Cloud as Stone House® Cat Litter, Floor Drying Material and ‘Natural Zeolite Crystal, and
Heaven Scent®, Marketed or mcludcd products by . brokers, manufacturers and distributors s Ammo®
Chips, Litter and Rocks, Ammonia-X®) A-Stone®, Biolite®, Clinolite®, EcoFresh®, Ecolite®, E- -Z Dry®,
Hydrosii®, PD2® Sweet Stall®, Stall !-3 h® Zeofresh, ZeoPro and others.

= Packaging
Sta'n'dard, private label and custom pacléaging and palletizing available including 10, 25, 50'Ib. or other units
in paper or plastic with stitch, taped, va']ve packed or heat sealed closures. Other off-site special packaging
servicesavailable on request. Bulk packaging in appmxlmately 1-ton and other supersacks or directly
loaded in any bulk truck or rail cat configuration including 1op loading or pneumatic carriers.

Information herein is accurate to the best of olir knowledge, but may be subject to change withouit notice, Suggestions are

made without warranty or guaraniee of results. Beﬁ)re using, user should determine the sultability of the produci for its
Intended use and user assumes the risk and liability in connection kergwith.
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St. Cloud Zeolite Screen Size Analysis

st.cloud”

zeolite

Nomina! | Approx. | Microns| Miltmstors| 20 | Prant | Porcentage (%) Retalned on Laboratory Scraens
Particle. | Particlo:| (um) (w) | Opaning{Opentasl Powders: Sands Granules regates
Stzo Size | Approx.| Approx. |US'Stnaj MuGr.| 325 | 100 | <40 |40xe0]14xe0 domshx] 121nx[34 In
Mesh | Inchos (inches) | {inclios}] .Mosh | Mesh | Moah'{ Maah | -Meeti bl 12in | 34n | xtin
Theh™ [~ 1 25,000' | 2540 | 1.006 '~ 1:050{0.00 7| 0:00~| ~0:00"| ~0.00 "}~ 0:00~}°0:00i]- 0.00°[ 0.60°}- 0,00 —0:00|-~0:00- | -0
4 Inch 4 18,050] 1900 | 0750 | 0750 | 0.00 | 000 | c.00-{ 0.00 § 0.00 | 000|000 000| 000 000 | 000 | 400
142 Inch 12 127001 1300 | 0500 {.0500 | 0.00 | 000 | 6.00 | 000 { 000  0.00] 000|000 0.00] 000 | 8447 | 440
4 Mesh 712 4760] 470 0357 ; 0215 | 000 | 000 | 000 | 000 | 0.00 jooD| 000|000 0.04] 5080 | 3543 | 34
@ Mesh 884 3360 340 0132 | 0,39 § 0.00 ) 000 | 0.00 | 0.00 | 0.00 } 0.00 | 0.21| 1.08]7587| 4663 | 008 | 05
8 Mesh 7784 2380 240 6084 | 0400 | 0.00 { 000 | 0.00 | 000 | 0.00 | 1.2330.03|70.58} 23.32] wa ne | s
14 Mosh 3584 1410] 140 0.055 | 0054 | 0.00 | 0.00 | 000 0.00 | 012 [67.05]84.70{27.58f 058 | 472 | 0.05 | 0.8
20Mesh | 132 841] o084 0033 | 0038 | 000 | 000 | 000 | 0.55 [ 44.88 [1067] ra |- a | o | we na | nfa
40 Meth 1784 420] 042 0.017 0017 | 000 } 200 | 070 | 501 | 6366 | 047 | 431 | va | wa | 011 | 003 | 04
_ TOMash s 210] o2t 0008 | wa | 000 ) 800 |3040|9%7i| nia | e | a [ | nfa | we ne | wa
" 100 Mesh Mo | 18] o9s 0006 | wa | 000 | 6201480 204 | 482 | 0.10 008|021} 007 | 028 | .004 | 04
<100Mesh || nia | <d3) <15 <006 | wa | 000 | 83.70| 54.20| 068 | D6l | 049 {066|.065} 034 | 186 | 022 | 07
140 Mash na 5] 010 0004 | wa | 008 | 770 | 14.50| 000 | 0.00 | 0.00] 000 [ 000} 000 | .00 wa | 0.0
200 Mesh wa 7% 047 0003 { oa | 0,00} 850 | 7.70 | 000 | 0oo | oon] coo] 000 000 | 0.00 na |00
325 Mésh na 44§ 004 0002 | na | 150 {t0.80}-8.40 | 000 | 0.0 | 0.00]0.00.| 0,001 0.00 | 000 wa | o0,
. <325 Mesh | . nia ) <004 .| <0017 |. we | 98501 56.601:23.80) 000 | 000 javojooo]ooo) 0oo]| o0eo.{ wa. | 00
Typical Deasity {Ibam3) 1 450 | 515 | 50.3-[ 50.1 [ 48.0 [ 48.0 484 460 447 ] 490 | 50.5 | 485 |
[Typical Moisture % [85 170 [ 68 | 58 | 38 [20 ] 46135 35 ] 62 | 76 ] 72

Notaa: All Iaboratery analysis performed simiiar to ASTM D392, Method A, Laboratory Siaves ara U.S, Standard mash and plant screens
are stendard “mill grage”.

St: Cloud Zeolite - wwwstcloudmining.com
P.O. Box 1670 - Truth or. Consequences, New Mexico 87901.- Ph; 505 743.5215
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st.cloud’

zeolite :
Material Safety Data Sheet Section 4 — First Ald Measures
; . Ingestion: 1l ingested In large quantities, contact physidan for permission to Induce vomiting.
DahePrgplred: usf2z/20t4 lahalstion: Move subject ta fresh air, Rinse mauth & nasal passages with fresh water. if
es: 09/02/2013
irritation persists, seek medical attention.
Sectlan 1~ Praduct & Company Identification Skin Contact: Rinse with water. If Irritation persists, seek medical attention, )
Product Nama: Zechite {Chabazite, Clinnptilotite) Eya Contact: Remave contact lenses. Flush eyes with water for 15 minutes. if Irritation persists,
Part Numbers: Winston Cliao (NM-Caj, Ash Meadows Clino {NV-Na), Rome Mordenite - v sseek med‘ﬂd . 'B“IEM::P i matertals th e smecial
Bowie Chab: (AZUB), (AZLB-Na) & {A218-Ca) otes to Physidan: t. Cloud Natural Zeolite has na additivesor als that require sp
et ses WaterFlzation, Sorbent, o ControlDisiceat, Animal Feed Addtve oot SR e vt o 1 srpher 1 ahive toehe 5. Gt Honu e T
Product Description: White, Off White, or Tan Granules & Powders w/Dark Specs '
Manufocturer’s Name: 54, Cioud Minlng Compomy- oR = Ash Mea! - Section 5 ~ Fire Fighting Maasures
‘F"’" Address: el S;'o:b:: Rd. :'sw"s Meadows Rd. General Hozords! Product ks not considered flammatie or combustible,
Z':' ::u - :}?.;smn ‘NM oot N:’;’;f:"v'am“:: \vEs0 Flash Point {*Fh N/A  FemmableLimits (Vaportn Alr, Vol X):  N/A
pHER AR ’ g Fire Extingulshing Madla: N/A U 1 Fire & lon Hozards: N
Phone! 575.743-5215 Phone/Fax: 775-372-5524 ke M / sud Explos rds one
Faxt 575-743-3333 - Countrys- US.A
Section 6 Acddental Rel P
Saction 2 - Hazardous Ingredients Environmantal Hazards: No knawn adverse effects.
Hazardous Ingredionts: May contain greater than 0.10% free sifica Spilage Sweep, scoop, of vacuum discharged matertal.
dous C cii {olite Zeokite/p: ium, cakcium, sodium, 3luminosilicate, Waste Disposal Methad: Landfil} according to local, State & Federal ragulations.
frydrated (a)
Percent by Welght: 100% Section 7 — Het . Storag
CAS % 12173-10-3 {CHi ), 1318-02-1 {Chabazite) on 7 - Hendling & e
EINECS & Not found Preceutionst Keeprontalner closed when not in use. Protect containers from abuse; store ing
Haiard Symbol: Xn oool, dry area, Keep out of reach of children,
Risk Phrases: R20, 36/37/38

{0} CHnoptilofite Is not ksted on the Canodion DSL ar NOSL.

‘Section 3~ Hezards ldentification

Corcinogenidity:  NIFZ No TARC Monoarophs? N 0SHA Repuiatag? N

Oinoptilolite with a particle skze In the respirable range was testad for
cercinogenicity in rats by intratrachesl instiflation. No significant Increase in the

incidence of tumors was found.
Eye Contaxt: May cavse inftetion,
Skin Contact: May couse Irritation.
Inhaslation: Causes kritation.
ingestion: No hazards known or suspacted.

ChronicHazards:  No known chronic hazasds, 'Nat lsted by OSHA, NTP or JARC as a carcinogen,
Doas ngt contaln asbestes or fibrous reofite minerals. Crystaliing silica was not
detected by X-Ray Defraction Analysis, but may be present ahove tha notification
level of 0.30%. [Crystatfine sifta Is considered a hazard by Inhal Ouring
October 1956, ARC reviewad the literature for polymorphs of crystalline sifica and
determined that therp Issufficient evidence In humans for the earcinegenity o
inhaled crystalling sifica in the form of quartz orcxist from |
SOUICES,) )

Section 8 - Exposure Cantrols / Personal Pratection

- DSHA Permissibls Exposure Limit [or ACGIR): Values have not been astabilshed,
Recommended Threshold Limit: Celling Limit = 15 mg/m3 Total Dust
5 mg/m® Respirable Fraction
Exposure Analysis Mathads:

Respirable Szmpler oc Midget Impinger see:
L. Am. Ind. Hyx. Assoc.; 28:554 (1967)

Rasplratory Protection: Use NIOSH approved dust mask or respirator where dust oocurs.

Aefer to 29 CFR 1910.134 or Evropean Standord EN 149 for reguictions:
Gloves: Plastic, rubber or cotton,
Eya Protection: Safety glasses or chemlcal goggales.

Refer ta 29 CFR 1910.133 er Furopeon Standard EN1G6.
Other Protective Equipment: N/A
Personal Hyglena: Avoid bireathing dust.
Enginenring Contrel: Use with adequate ventilation;
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Product Nems: Zsolits {Chobaito, Clinogtiietits, }

Pagezof2

Materfal Safety Data Sheet
Date Preparad: .05/22/2014

Section 15 ~ Regulatory informatlon

TSCA {U.S.A. ~ Tox{c Substanica Control Act)
Alf components of this product ara listed on the U.S, Toxle Substances Control Act Chamicai inventory

Section 10— Stability and Reactivity

Stabifity: Stable Conditions to Avold: N/A
Incompstihifity (Moterlals to Avold): NJA Hazardous Decomposttion Productst None

NFPA Hezard Ratings: Heaith Harard: 1 Flammability Hazard: 0
Reactiuity: 0 Spechl Hawrd: Nane

Sectlon 11~ Toxicologlca! Information

‘Chabagite: CASH1318021  EINECS A (notfound) LC/LDS0 - N/A

Chnontilolite: CAS#1217310-3  EINECS # (nat found) (CADSD- N/A

Sectlon 12— Ecclogical Inf "

No data avallable. None of the ingred classified a5 a Marine Pollutant.

© WIGK Water Quality indax: nwg

- s: 09/23/2019 or are exempted from listing because a Low Volume or Polymer Exemption has been granted In
Section §—Phystcal & Chemical Properties accoedance with 40 CFR 72350, )
Appeziance & Odor: Chabartte = Dry, ton granules & px Odorfess. SARATITLE Hi (U.S.A. - Suparfund d £ Resuth act)
Clinoptilolie = Ory, white to off-white grenules & powders with specs, 311/312 Hazard Categodes-lmmedlam Health, 313 Reportable ngredients-None
Specific Gravitys Chobatite = N/A {Ugilds Only), Clnopticlite = 2.2~ 2.4 .. = Com Compensation & Lsbiity Act
Solubility in Water: Chabazlte = Negligible, Clinoptitolite <0 Callfomlz Prop 65, Safe Drinking Water & Toxk Enforcement Act of 1986
There are no chemicals present known to the State of Californla to cause cancer or reproductive
Vapor Density: N/A roxieiy.
Vspor Prassura: Chabazite = N/A {mm Hg at °F, Nonaqueous Ligudds Only) CPR {Canadian C Products R
dinoptifolite =N/A This product has been classifled In acoordance with the hazard eriteria of the Controlled Products
Regulations and the MSDS contalns 21l the Information required by the Controiled Praducts
Braporation Rato: g;::a::::“:“f J:‘XUM Acatata = 100; Nonaqueous Liquids Only) Regulations. WHMIS Classification; Not controlled
3 IDL (Cansd!an ingredient Disclosure Ust}
Solids Contentt Chabazte = N/A (Sclutions, Disperstons of Pastes Galy} Components of this prodisct identified by CAS number and listed on the Canadian Ingredient
Clinoptilolite = N/A Disdlosure tist are shown In Section 2
Iy . DSL/NDSL (Canadian D e Sub st/ Non-D Substances List)
. Meting Point: Chabatite = N’F‘ Clinoptllolite lm Companents of this product identifled by CAS number are not listed on the DSt or NDSL, or are
Bolling Pointt ‘Chobaiite = NJA (°F, Nonaqueous Liquids Only, CInopHIoite = NJA rWe th Complance 0 ubiances Mot Teg! rs. Oy ngredlere |
dassifled as “hazardous™ are listed In Section 2 unkess otherwise Indlcated
pH: Chabazite 2 N/A (Aqueous Liguids Only), Cinoptilolite = N/A EINECS (Eurcpean y of Existing C sal Chemical Sisk

Components of this product identified by CAS numbers are on the European Inventory of Existing
Commescial Chemizal Substances unlass Indicated as “not found™.
z VbK Inden: notappiicable

Sectlon 16 — Other Information

Notes & Rull R-Phrase Tont: R20 Harmful by inhalation
R36/37/38 lrritating to eyes, respiratory system and skin
HMIS5 Hazard Ratings: Health=1 Flammabliity = 0

Physical Hazard =D Persopal Safety Equipmentn E

Deflaitions: * = Chroale Health Hozord, O = insignificont, 1 = Stight, 2 = Moderate, 3 = High,
4 a Exteeme, £ = Sofety Glasses, Gloves, Oust Resplrator

Ravision Suramary: This MSOS has been revised as follows - Updated Format & Data

Section 13- Disposal Consldérations

Dispose of In socordance th Lo(zl. State and Federal Regulations, Froduct ks classified as non-

rials may become hatardous waste upan contact with other
products. Refer to '40 CFR Protection of Environment Parts 260-293" for complete waste disposal
regulations. Cansult your loca), state or Federal Environmantal Protection Agency before disposing of
2ny chemitals. According to the Europesn Waste Cataiogue, waste codes are eppfication-spedficand
should be assigned by the user hased on the application for which the produtt is used.

Saction 14 - Transport Infor
DOT Shipging Name: Non-Hazardous for Transport

IMDG Harord Class:  Not Regulated

DOTHazad Class:  Not Regulated {ATARazard Class:  Not Regulated
UN/NAIDNo.: None RIDJADR Codo: Not Regulated
UN TG Choss: Not Regulated Lahal None Required

Razned 1d No. (HiN):  None Hazard Symbodss None

Additional Contact information

Contact: Da"n!e{ T. Eyde, Chief Technology Officer
) o dmidin o0
Phone: *{520) 744-8845

Contsct:  Joseph P. McEnaney, Vice President-Sales
g

Emali:
Phono: {203} 761-1291

URLs https//www.stloudmining.com
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Univar USA Inc Safety Data Sheet

HOMESTAKE MINING CO.
ALBQ. WEST ON I-40

SEE INSTRUCTIONS ON
GRANTS
NM 87020

SDSNo:  [CDS2441 |

.Version No: |001 01/15/15
Q{Se’ No: |AQ322380 |

3075 Highland Pkwy, Ste 200, Downers Grove, IL 60515
{425) 889 3400 -

Emergency Assistance

For emergency assistance involving chemicals call
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COMPANY IDENTITY: Univar : " SDS DATE: 01/15/2815
PRODUCT IDENTITY: SULFURIC ACID 93% ‘ .y . ORIGINAL: ©1/15/2615

-SDS NUMBER: CDS-2441
‘ SAFETY DATA SHEET

This Safety Data Sheet conforms to ANSI 7400.5, and to the
format requirements of the Global Harmonizinﬁ
THIS SDS COMPLIES WITH 29 CFR 19108.1208 (HAZARD COMMUI ICATION STANQARD)
IMPORTANT: Read this SDS before handling & disposing of this product. , ) , .
Pass this information on to employees, customers, & users of this product , -

SECTION 1. IDENTIFICATION OF THE SUBSTANCE OR MIXTURE AND OF THE SUPPLIER

PRODUCT IDENfITY:'SULFURIC ACID 93% (
PRODUCT USES: Mineral Acid i

COMPANY IDENTITY: Univar

COMPANY ADDRESS: 17425 NE Union Hill Road

COMPANY . CITY; Redmond, WA 98@52

COMPANY PHONE: 1-425- 889 3400 .

EMERGENCY PHONES: CHEMTREC: 1-808-424-9300 USAK :
CANUTEC: 1-613-996-6666 (CANADA)

SECTION 2, HAZARDS IDENTIFICATION

DANGER! !

2.1 HAZARD STATEMENTS: (CAT Hazard Category)
(HZGBS) PHYSICAL: Corrosive To Metals:
H298 MAY BE CORROSIVE TO METALS.(CAT:1)
MMIHBOGS) HEALTH: Skin Corrosion/Irritation
1314 CAUSES SEVERE SKIN BURNS AND EYE DAMAGE (CAT 1)
“13995& HEALTH: . Acute Toxicity, Inhalation:
H332 HARMFUL IF INHALED.(CAT:4)

2.2 PRECAUTIONARY STATEMENTS: .
EXPOSURE PREVENTION: AVOID ALL CONTACT!
PREVENT DISPERSION OF MISTS OR. ousn

P160@s = General, P200s = Prevention,
P300s = Response, P48@s = Storage P5e0s = Disposal
P234 Keep only in orig inal container :
P260 Do not breathe dust/fume/ as/mist/vagors/spray.
P262 ‘Do not get in eyes on skin, or on ¢ ing.
P264 Wash hands thoroui 1y after handlin§
- P280 Wear protective gloves/protective ¢ othing/eye protection/face praotection..

P361+33€+331 IF SWALLOWED: Rinse mouth. Do NOT induce vomiting
P363+361+353 IF ON SKIN (OR HAIRI ‘Remove/Take off immediately all
‘ contaminated clothing. Rinse skin with water/shower.
P304+340 IF INHALED: Resove victim to fresh air & keep at rest in a position
~ comfortable for breathing.
P305+351+338 IF IN EYES; Rinse cautigusly with water for several minutes.
Remove contact lenses if present & easy to do & Continue rinsing

P310 Immediately call a POISON CENTER or doctor/physician.

P363 Wash contaminated clothing before reuse,

P39a .Absorb spillage to prevent material damage.

P404 Store in a closed container.

P405 Store locked up.

ese1 Dispose of contents/container to an approved waste dispasal plant,

SEE SECTIONS 8, 11 & 12 FOR TOXICOLOGICAL INFORMATION.
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COMPANY IDENTITY: Univar
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SDS DATE: 81/15/2015

PRODUCT IDENTITY: SULFURIC ACID 93% - ' ORIGINAL: 01/15/2015.
SDS NUMBER: - CDS-2441 ' = . ot i
SECTION 3. COMPOSITION/INFORMATION ON INGREDIENTS
MATERIAL cas# CEINECS# © WT
Sulfuric Acid o - 7664-93-9 231-639-5 - 93
Water o S 7732-18-5 C231-791-2- . 7

TRACE COMPONENTS: Trace ingredients (if .any) are present in < 1¥ concentration,.

(< 0.1% for potential carcinogens, repraoductive toxins, respiratory tract mitagens,

and sensitizers). None of the trace‘ingredientS'contriﬁute significant ‘additional
hazards at the concentrations that may be. present in this product. All: pertinent hazard
information has-been provided in this document, per the requirements of-the Federal :
Occupational Safety:and Health Administration,§tandard (29 CFR 1910.1200), U.S5. State
equivalents, and Canadian'Hazardous Materials Identification System Standard (CPR 4).

SECTION 4. FIRST AID MEASURES

4.1 MOSY IMPORTANT SYMPTOMS/EFFECTS, ACUTE & CHRONIC:
See-Section 11 for symptoms/effects, acute & chronic.

4.2 GENERAL ADVICE: - A o
First ‘Aid responders should an.attention to self-grotection and use the recommended "
protective clothing (chemical resistant gloves, splash protection;;‘lf potential for .
exposure exists, refer to Section 8 for specific personal protective equipment.. :

4.3 EYE CONTACT: S - oo " '
If this product enters the eyes, check for and remove any contact lenses. -Open eyes while
under gently running water. Use sufficient force to_Oﬁen eyelids, "Roll" e¥es.to expose
. more surface. Minimum flushing is for 15 minutes. Seek immediate medical attention.” .
. )

.4 SKIN COMTACT: . . R ’ ‘ .

f the product contaminates the skin, immediately begin decontamination with running

ater, Minimum flushing is for 15 minutes. Remove contaminated clothing, taking :care not
sto contaminate eyes. It skin becames irritated and irritation persists, medical attention -
may be necessary. Wash contaminated clothing before reuse, discard contaminated shoes. - & .

4.5 INHALATION: s L P PR '
After high vapor exposure, remove to. fresh air. If breathing is difficult, give
oxygen. If'breathinﬁ has stopped, trained. personnel should-immediately begin artificial
respiration. If the heart has'stoR ed, trained personnel should immediately begin ..
cardiopulmonary resuscitation (CP 9. Seek immediate medical attention, o

4.6 SWALLOWING: » L : ' SR e L
If swallowed, CALL PHYSICIAN OR POISON CONTROL CENTER #OR MOST CURRENT INFORMATION. If
rofessional advice is not available, give two glasses of water to drink. DO NOT: INDUCE
OMITING. Never induce vomiting or Eive liquids to someone who is unconscious, having

convulsions, or unable to swallow, Seek immediate medical attention., -

3

4,7 RESCUERS: Victins of chemical ex osure must be takén for medicél atﬁéntion. Rescuers
should be taken for medical attention, if necessary. Take a copy of label and SDS to
physician or health professional with victim. o . _ .

4,8 NOTES TO PHYSICIAN: o o : : - s e
There is no specific antidote. Treatment of overexposure  should be . directed .at the:control
of symptoms and the clinical condition of the patient. Any material aspirated during .
vomiting may -cause 1un§ injury. Therefore, emesis should not be induced mgghanica11¥jon_~
pharmacolos cally. If it is consldered necessary to evacuate the stomach coptents, this
should ‘be done by means least likely to cause aspiration -(such as: Gastric lavage after-
endotracheal intubation). ‘ . e T - ’ :

" SECTION 5. FIRE FIGHTING MEASURES

5.1 FIRE & EXPLOSION PREVENTIVE MEASURES: : R ot
Isolate fram alkalies, oxidizers, organics; extreme heat and open fTlames.
5.2 SUITABLE i& UNSUITABLE) EXTINGUISHING MEDIA: B '
Use extingulshing agent “appropriate for. surrounding fire.

fﬁﬁﬂ_SPECIAL PROTECTIVE ESUIPMENT & PRECAUTIONS FOR FIRE FIGHTERS:

- * “jater spray may be ineffective on fire_but can protect fire-fighters

(:4d cool closed containers. Use fog nozzles if water is used. - .
Do not enter confined fire-space without full bunker gear. :
/(Helmet with face shield, bunker coats, gloves & rubber boots).
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SECTION 5. FIRE FIGHTING MEASURES (CONTINUED)

5.4 SPECIFIC HAZARDS OF CHEMICAL & HAZARDOUS COMBUSTION PRODUCTS:
. SLIGHTLY COMBUSTIBLE! i ) St
Reacts with most metals groducing hydrogen which is extremely flammable & may explode.
Keep container tightly closed. Isolate trom oxidizers, alkalis, heat, & open flame.
Applying to hot surfaces requires special precautions. Closed containers may explode

if exposed to extreme heat.,Continuevagl label precautions!
SECTION 6. ACCIDENTAL RELEASE MEASURES

£.1 SPILL AND LEAK .RESPONSE AND ENVIRONMENTAL PRECAUTIONS: . .
"Uncontrolled releases should be responded to by trained gerSonnel using pre-planned
procedures. Proper protective equipment should be used. In case of a spill, clear the
affected area, protéct people, and respond with trained personnel: ELIMINATE all
ignition sources ino smoking, flares, sgarks, or flames in immediate area).
Prevent additional discharge of material, if possible to do so without hazard.
For large spillse, implement cleanup procedures and, if in public area; advise authorities.

6.2 PERSONAL PRECAUTIONS, PROTECTIVE EQUIPMENT, EMERGENCY PROCEDURES: . . ey
" The proper personal protective equipment . for incidental releases (such as: 1 Liter of the .
roduct released in a well-ventilated area), use impermeable gloves, they should be Level
:..triple-gloves (rubber gloves and nitrile gloves over latex gloves), chemical resistant
sult and boots, hard-hat, and Self-Contained Breathing Apparatus-spe:ific For the material
handled, goggles, face sﬁiéld, and appropriate body protection. In the event of a large
release, use impermeable Eloves, specific for the material handled, chemically resistant R
suit and boots, and hard hat. Self-Cantained Breathing Apparatus or respirator may be
required where engineering controls are fiot adequate or conditions for potential exposure
exist. When respirators are required, select NIOSH/MSHA approved based on actual or
potential airborne concentrations in accordance with latest OSHA and/or ANSI

recommendation‘s. _
/3 ENVIRONMENTAL PRECAUTIONS: ‘

" Stop_spill at source. Construct temporary dikes of .dirt, sand, or any apgnopriate readily
available material to Erevent spreading of the material. Close or cap valves and/or
block or plug hole in leaking containesr and transfer.to another container. Keep from
entering storm sewers and ditches which lead to waterways, and if necessary, call the
local fire or police department for immediate emergency assistance. ;. ’

6.4 METHODS AND MATERIAL FOR CONTAINMENT & CLEAN-UP: '
Absorb spilled liguid with po%ypads or other suitable absorbent materials. If necessary,
neutralize using suitable buffering material, iacid with soda ‘ash or. base with phosphoric
acid), and test area with litmus paper to confirm neutralization. Clean up with
non-cambustible absorbent (such as: sand, soil, and so on). Shovel up and Elace all spill
residue in suitable contalners. dispose of at an appropriate waste disposal facility . |
according to current applicable laws and re§u1ations and product characteristics at time .
of disposal (see Section 13 - Disposal Conslderations). ' .

' SECTION 7. HANDLING AND STORAGE

7.1 PRECAUTIONS FOR SAFE. HANDLING: - :
Isolate from oxidizers, alkalis, heat, & open flame, Use only with adequate ventilation. -
Do not get in eyes, on skin or clothing. Wear OSHA Standard Ffull face shield. Consult Safet¥ .
Equipment Suppller. Wear gogglgs face shield, ploves, -apron & footwear impervious to material.
Wash clothinﬁ before reuse, ‘ontinue all label precautions! NEVER pour water into this
substance. When dissolving or diluting, always add it slowly to the water.

7.2 CONDITIONS FOR SAFE STORAGE, INCLUDING AMY INCOMPATIBILITIES: , .
Keep separated from strong oxidants, strong bases, combustible & reducing substances, metals,
food & feedstuffs, incompatible materials. May be stored in stainless steel containers.

See: Section 18, <Materials to Avoid>. Do not store above 49 C/120 F. o

Keep container tightly closed & uprisht when not in use to Erevent leakage.

Reacts with most metals gnoducing hydrogen which is extremely flammable & may explode.
Wear full face shield, gloves & full protective ‘clothing when opening or handling. .
When empty, drain completely, replace bungs securely. _ o

.3 NONBULK: CONTAINERS: : . ’ - ’

wStore containers in a cool, dry location, away from direct sunlight, sources of intense
sheat, or where freezing is possible., Material should be stored in secondarx containers or
in a diked -area, as approprlate. Store containers away from incompatible ‘chemicals (see
Section 10, Stability and Reactivityz. Post warning and "NO SMOKING" signs in storage and
use areas, as appropriate. Empty containers should be handled with care. Never store food,
feed, or drinking water in containers which held this product.
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7.4 BULK CONTAINERS:

SECTION 7. HANDLING AND STORAGE (CONTINUED)

All tanks and pipelines which'contain this haterial must be labelédf‘Perfobh rodtine‘ .
maintenance on tanks or pipelines which contain this product. Report all leaks immediately .

to the proper personnel.

7.5 TANK CAR SHIPMENTS:

Tank cars carrylng this product should be loaded and unloaded in strict accordance with
tank-car manufacturer's recommendation and all established on-site safety procedures.
Appropriate personal protective eguipment must be used (see Section 8, Engineering .
Controls and Personal Protective ‘Equipment.). All loading and unloading equipment must be
inspected, prior to each use. Loading and unloading operations must be attended, at all
times. Tank cars must be level, brakes must be set or wheels must be locked or_blacked
prior to 1oadin§ or unloading. Tank car (for loading) or storage tanks {for unloading)
must be verified to be correct for receivinﬁ this product and be proper ¥ prepared,
prior to starting the transfer operations. Hoses must be verified to.be in the correct
positions, before starting transfer operations. A sample (if required) must be taken
and verified éif requiredg

blown-down an

prior to starting transfer operations. All lines must be
purged before disconnecting them from the tank car or vessel, :

7.6 PROTECTIVE PRACTICES DURING MAINTENANCE OF CONTAMINATED EQUIPMENT:

7.7 EMPTY CONTAINER WARNING:

.3 EXPOSURE LIMITS:
HATERIAL :

Follow practices indicated in Section 6 (Accidental Release Measuresl. Make certain
aﬁplicatiOn equipment -1s locked and tagged-out safely. Always use this product in areas
where adequate ventilation is grovided. Collect all rinsates and dispose of according . -
to applicable Federal, State, Provincial, or local procedures. '

Empty contalners may contain residue and can be dangerous. Do not attempt to refill or
lean containers without proper instructions. Empty drums should be completely drained
nd safely.stored until appropriately reconditioned or disposed. Empty containers should
e taken for recycling, recovery, or disposal through suitably qualified or licensed "=
contractor and 1n‘accordance-w1tﬁ Eovernmental regulations.” DO NOT PRESSURIZE, CUT, WELD,
BRAZE, SOLDER, DRILL, GRIND, OR EXPOSE SUCH CONTAINERS TO HEAT, FLAME, SPARKS, STATIC
ELECTRICITY, OR OTHER SOURCES OF IGNITION. THEY MAY BURST AND CAUSE INJURY OR DEATH.

SECTION 8, EXPosﬁRE coNTRdLs/PERsouAL PROTECTION &

"BAT _ CAS# EINECS# TWA (OSHA) TLV (ACGIH)  IDLH (N;dSH)
“Sulfuric Acid 7664-93-9 231-639-5 1.6 mﬁ/mv_ 1.8 mg/ -~ 15-.mg/m° -
Water : © 7732-18-5° 231-791-2 WNone Known :

This product contains no EPA Hazardous Air Pollutants (HAP) in amounts > G.Iﬁ,

mi m
_, None Knaown

8.2 APPROPRIATE ENGINEERING CONTROLS: '

- jressure Self-Contained Breathing Apparatus.

RESPIRATORY EXPOSURE CONTROLS . o . T
Airborne concentrations should be kept to lowest levels possible. If vapor, dust or mist
is generated and the occupational exposure limit of the product, or any component of the
product, is exceeded, use appropriate NIOSH or MSHA approved air purifying or air=supplied
respirator authorized 'in 29 CFR 1910.134; European Standard EN 149, or applicable State .
regulations, after determining the airborne concentration of the contaminant. Air supplied
respirators should always be worn.when airborne concentration of the contaminant or
oxygen content is unknown. Maintain airborne contaminant concentrations below exposure
limits. If adequate ventilation is not available or there is potential for airborne o
exposure above the exposure limits, a respirator may be worn up to the respirator exposure .
limitations, check with respirator equipment manufacturer's recommendations/limitations.

For particuiates, a particulate respirator §NIOSH Type N95 or better FTilters) may be worn.
If oil garticles {such as: lubricants, cutt HE fluids, glycerine, ‘and so on) are present,
use a NIOSH Type R or P filter, ‘For a higher level of protection, use positive pressure
supplied air respiration protection or Self-Contained Breathing Apparatus or if oxygen
levels are below 19.5% or are unknown. )

EMERGENCY OR PLANNED ENTRY INTO UNKNOWN CONCENTRATIONS OR IDLH'CONbITIONS o
Positive pressure, full-face piece Self-Contained Breathing Apparatus; or EOSitive . .
ressure, full-face pliece: Self-Contalned Breathing Apparatus with an auxilliary positive
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SECTION B. EXPOSURE CONTROLS/PERSONAL PROTECTIQN (CQNTINUED)

VENTILATION ‘ .

LOCAL EXHAUST: - Necessary MECHANICAL (GENERAL): Necessary

SPECIAL: No HER: N

ne . OT : P None . .
Please refer to ACGIH document, "Industrial Ventilation, A Manual of
Recommended Practices”, most recent edition, for details. : .

Bé351235¥ég¥§3NPROTECTION MEASURES, SUCH AS PERSONAL PROTECTIVE EQUIPMENT:

Y e . . - : . : -
Safety eyewear complying with an approved standard should be used when a risk o
assessment indicates thils is necessary to avoid exposure to_liquid splashes, mists or -
dusts. If contact is possible, chemical splash goggles should ‘be worn, when a higher
degree of protection is necessary, use splash goggles or safety glasses. Face-shields
are recommended when the operation can generate splashes, sprays or mists. .

HAND PROTECTION: . ° ; o . - L

Use gloves chemically resistant to this material.- Preferred examples: Butyl rubber,
Chlorinated Polyethylene, Polyethylene, Ethyl vinyl alcohol laminate i"EVALﬁ)

Polyvinyl alcoh01~('PVA"5. Examples of acceptable.glove barrier mater als,inciude:
Natural rubber i"latex")f Neoprene, Nitrile/butadiene rubber (“"nitril”) or ("NBR"),
Polyvinyl chloride ("PVC") or “vinyl"), Viton, Chemical-resistant imﬁePVious gloves
complying with "an approved standard should be worn at all timeS»wﬁen'handling chemical
products if a risk assessment indicates this is necessary. Considering the parameters
sgecified by the glove manufacturer, check dUring use that the gloves are still retaining
their protective properties. It should be noted that the time to breakthrough for any
glove material may be different for different glove manufacturers. In the case of
mixtures consistinﬁ of several substances, the protection time of the gloves cannot be
accurateiy estimated. . : - . B

~JDY PROTECTION: . ’ o

sUse bady protection appropriate for task. Cover-all, rubber aprons, or chemical protective
clothing made from impervious matErials'are‘gengraliy acceptable, depending on the task:

WORK & HYGIENIC PRACTICES: : ' ) . , L o
Wash hands, ferearms and face thoroughly after hand}ing chemical products, before eatinﬁ,
smoking and using toilet facilities and at the end of the working period. Provide readily
accessible eye wash stations & safety showers. Remove clothing that becomes contaminated.
Destroy contaminated leather articles. Launder or discard contaminated clothing.

SECTION 9. PHYSICAL & CHEMICAL PROPERTIES

APPEARANCE: s - giiy.Liquid, Water-White to slightly yelloow
H one ’ o .
ODOR THRESHOLD: Not Available
ﬂH (Neutralityg: . . <1 )
ELTING POINT/FREEZING POINT: _ -29 C / -20

F - o
BOILING RANGE éIBP,Drﬁ Point): . : 276 to 281 C / 528 to 538 F
FLASH POINT (TEST MET ODi: o ) " Not Applicable - . -
EVAPORATION RATE §néBut Acetate=1): Not Applicable =
FLAMMABILITY CLASSIFICATION:. e : Noncombustible e
LOWER FLAMMABLE LIMIT IN AIR (% by vol): 18,09 (Lowest Component)
UPPER FLAMMABLE LIMIT IN AIR (% by vol): .. Not" Available

VAPOR PRESSURE (mm of Hg)@2e C ' < 0.3
VAPOR DENSITY air=1&:A : ' 3.4
GRAVITY QYGB/G F / 20/20C: o
DENSITY: : S 1.830
SPECIFIC GRAVITY (Water=1): 1.835
POUNDS/GALLON: - T 15.3
WATER SOLUBILITY: Complete

PARTITION COEFFICIENT (n-Octane/Water):
AUTO IGNITION TEMPERATURE:
DECOMPOSITION TEMPERATURE:

VOCs (>8,e44 Lbs/Sq In) -

TOTAL VOC'S (TVOC)*: ,
NONEXEMPT VOC'S (CVOC)*: %
T2AZARDOUS AIR POLLUTANTS (HAPS):

.sSCOSITY @ 168 C (ASTM D445) 514.
“VISCOSITY @ 20 C iASTM D445):
* Using CARB (Cal

EXEMPT VOC PARTIAL PRESSURE (mmaof Hg @ 20 C)

fornia Air Resources Board Rules).

Not Available

Not” Applicable . )
Not Available . .

. 90 Lbs/Gal

0.8 VolX /0.0 g/L / 6.0

9.0 Vol% /8.0 g/L / 0.000 Lbs/Gal
0.8 Vol% /0.8 g/L / 0.080 Lbs/Gal
2.0 Wt% 7.8 g/L / 0.000 Lbs/Gal

Not Available '
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SECTION 18. STABILITY & REACTIVITY

10.1 REACTIVITY & CHEMICAL STABILITY: ’
Stable under -normal conditions, but Reacts with “most metals producing hydrogen
which'is extremely flammable & may explode. .

16.2 POSSIBILITY OF HAZARDOUS REACTIONS & CONDITIONS TO AVOID
Isolate from sources of ignition, heat, & open flame. Reacts vigorously with water.

10,3 INCOMPATIBLE MATERIALS: '
The substance.is a strong acid, reacts violently with bases and is corrosive:
ﬁon heating, irritating and toxic fumes are formed including sulfur oxides.
The substance 1s a strong oxidant & reacts violently with combustible & reducing materials:
Corrosive to most common metals, forming flammable/explosive §as {hydrogen).  Sulfuric acid
reacts violently with water & organic materials with much heat., Hazardous gases are evolved
on contact with chemicals such as cyanides, sulfides,,and carbides.

‘10 4 HAZARDOUS DECOMPOSITION PRODUCTS'
Upon heating, irritating and toxic fumes are formed including sulfur oxides.

10.5 HAZARDOUS POLYMERIZATION:
Will not occur.

_ SECTION 11. TOXICOLOGICAL INFORMATION
.11.1 ACUTE HAZARDS

11.11 EYE & SKIN CONTACT: '
mSevere burns to skin, defatting, dermatitis.
nimal testin% indicates this material is corrasive to the eye.
Severe burns to eyes, redness, tearing, blurred vision.
Liquid can cause severe skin & eye burns. Wash thoroughly after handling

11.12 INHALATION
Severe respiratory tract irritation may occur. Vapor harmful

11.13 SNALLOWING:
Harmful or fatal if swallowed.

11,2 SUBCHRONIC HAZARDS/COﬁDiTIONS AGGRAVATED
MEDICAL CONDITIONS AGGRAVATED BY EXPOSURE: ) ’
Pre- existing disorders of ang “target organs mentioned in this Document can be -
aggravated by over-exposure by routes of entry to components of this product.
Persons :with these disorders should avoid use of this product
1. 3 CHRONIC HAZARDS

11.31 CANCER, REPRODUCTIVE & OTHER CHRONIC HAZARDS:
PROVEN Carcinogen, Human, Group 1 (IARC), SUSPECTED Carcinogen, Human, Group A2 (ACGIH).

11.32 TARGET ORGANS: May cause damage to target drgens; based onlanimai datet
11.33 IRRITANCY: Irritating to contaminated tissue, -
11.34 SENSITIZATIONi No component is known as a sensitizer.

11.35 MUTAGENICITY: No known reports of mutagenic effects in humans.
‘11.36 EMBRYQTOXICITY: No known reports of embryotoxic effects in humans.

11.37 TERATOGENICITY: No known reports of teratogenic e?feéts<in humans.

11.38 REPRODUCTIVE TOXICITY: ‘No known reports of reproductive effects in humans.
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SECTION 11. TOXICOLOGICAL INFORMATION (CONTINUED)

A MUTAGEN is a chemical which causes permanent chanies to ﬁenetic material (DNA) -~
such that the changes will propagate:across generational lines. An EMBRYOTOXIN

is a chemical which causes damage to a developins embryo (such as: within:the first
8 weeks of Rregnancy in humans&, but the damage does not propagate across
enerational lines. A TERATOGEN is a chemical which-causes damage to a developing
etus, but the damage does not propagate across generational lines. A REPRODUCTIVE
TOXIN is any substance which interferes’'in -any way with the reproductive process.

11.4 MAMMALIAN TOXICITY INFORMATION

LDS@ (Oral, Acute): " 2140 mg/ke (Rat C '
LC50 5 2 hours: _ . 51@ mggmy'(ﬂat)3 320 mg/m’> (Mouse)

SECTION 12, ECOLOGICAL INFORMATION
12.1 ALL WORK PRACTICES MUST BE AIMED AT ELIMINATING ENVIRONMENTAL CONTAMINATION.

12.2 EFFECT OF MATERIAL ON PLANTS AND ANIMALS: ‘ . : L
This product may be harmful or fatal to plant and animal life if released
into the environment. Refer ta Section 11 (Toxicological Information) for
further data on the effects of this product’s components on test animals.

12.3 EFFECT OF MATERIAL ON AQUATIC LIFE: . v
The substance is harmful to aquatic organisms..

LC50 / 48 hours: -49 mg/L, Tap Water, 20 C (Bluegill sunfish)
LC5@ 7/ 48 hours: 100 - 330 mg/L, Aerated Water (Flounder)

").4 MOBILITY IN SOIL S _
Mobility of this material has not been determined.

12.5 DEGRADABILITY _
This product is completely biodegradable.

12.6 ACCUMULATION . S ‘ ,
Bicaccumulation of this product has not been determined.

SECTION 13. DISPOSAL CONSIDERATIONS

Processini, use or contamination may change the waste disposal requirements. Do not
dispose of on land, in surface waters, or in storm drains. Waste should be recycled
or dispased of in accordance with regulations. Large amounts should be collected
for reuse or consigned to licensed hazardous waste haulers for disposal. -

ALL DISPOSAL MUST BE IN ACCORDANCE WITH ALL FEDERAL, STATE, PROVINCIAL, AND LOCAL
REGULATIONS. IF IN DOUBT, CONTACT PROPER AGENCIES. EPA CHARACTERISTIC: D092 :

_ SECTION 14. TRANSPORT INFORMATION

MARINE POLLUTANT: No )
DOT/TDG SHIP NAME: UN183@, Sulfuric acid, 8, PG-II

DRUM LABEL: {CORROSIVE
IATA / ICAD: UN183@, Sulfuric acid, 8, PG-II
IMO / IMDG UN183e, Sulfurlc acid, 8, PG-IIX

EMERGENCY RESPONSE GUIDEBOOK NUMBER: 137




ORDER NO:AQ322380 MATERIAL SAFETY DATA SHEET U MSDS NO:CDS2441

N CUST:HOMESTAKE__ MIN!NG CO. | : VEHSION 001 01/1 5/15
‘ ' Page 8 of 8 o . .
COMPANY IDENTITY: Univar - B ' sps DATE: ©1/15/2015
PRODUCT IDENTITY: SULFURIC ACID 93% _ | 'ORIGINAL: @1/15/2015

SDS NUMBER: CDs-244

SECTION 15. REGULATORY»INFORMATION‘»

15.1 EPA REGULATION:
SARA SECTION 311/312 HAZARDS Acute Health, Chronic Health, Reactivity

All components of this product are on the TSCA list.
© SARA Title III Section 313 Supplier Notification
. This product contains the indicated <*> toxic chemicals subject to the '
reporting requirements of Section 313 of the Emergency Planning & Community
Right-To-Know Act of 1986 & of 40 CFR 372. This information must be
included in all MsDSs that are copied and distributed for this material.

SARA TITLE III:INGREDIENTS ' CASH# EINECS# T WT% REG.SECTION) RQ(LBS)
*Sulfuric Acid 7664-93-9 231-639-5’ 83 302,311,312,313) - 100 -

15.2 STATE REGULATIONS

CALIFORNIA SAFE DRINKING wATER & TOXIC ENFORCEMENT ACT (PRDPOSITION 65):
This product contains no chemicals known to the State of California
to cause cancer or reproductive toxicity.

15.3 INTERNATIONAL REGULATIONS
The identified components of this product are listed on the chemical inventories

of the fol owin countries: .
Australia Z Canada (DSL or NDSL), China (IECSC), Europe (EINECS, ELINCS),
Japan (MET /CSC MHLW/ISHL), South Korea (KECI), New Zealand (NZIgC),
Philippines (PICCS), Switzerland (SWISS), Taiwan (NECSI), USA (TSCA).

.15 4 CANADA: WORKPLACE HAZARDOUS MATERIALS INFORMATION SYSTEM (WHMES)
D2B: Irritating to skin / eyes.
E:  Corrosive Material. '

b
. This product was classified using the hazard criteria of ‘the Controlled Products
Regulations (CPR). This Document contains a11 information required by the CPR.

SECTION 15. OTHER mronmumm '

16.1 HAZARD RATINGS: . .
HEALTH (NFPA): 3, = HEALTH (HMIS): 3, FLAMMABILITY: 8, PHYSICAL HAZARD: 2
Personal Protection Rating to be supplied by user based on use conditions )
his information is intended solely for the ‘use of individuals
trained in the NFPA & HMIS hazard rating systems

16.2 EMPLOYEE TRAINING .
See Section 2 for Risk & Safet Statements Employees should be made aware
of all hazards of this material (as stated in this SDS) before handling it.

16.3 SDS DATE: ©1/15/2815
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For Additional Information contact SDS Coordinator during business hours, Pacific time: (425) 889-3400

Notice

Univar USA Inc. ("Univar”) expressly disclaims all express or implied warranties of merchantability and fitness for
a particular purpose, with respect to the product or information provided herein, and shall under no
circumstances be liable for incidental or consequential damages. )

Do not use ingredient information and/or ingredient percentages in this SDS as a product specification. For
product specification information refer to a product specification sheet and/or a certificate of analysis. These
can be obtained from your local Univar sales office.

All information appearing herein is based upon data obtained from the manufacturer and/or recognized
technical sources. While the information is believed to be accurate, Univar makes no representations as to its
curacy or sufficiency. Conditions of use are beyond Univar's control and therefore users are responsible to

C.arlfy this data under their own operating conditions to determine whether the product is suitable for their
particular purposes and they assume all risks of their use, handling, and disposal of the product, or from the
publication or use of, or reliance upon, information contained herein.

This Information relates only to the product designated herein, and does not relate to its use in combination
with any other material or in any other process
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Specialized Equipment Standard Operating Procedure (SOP)

For the use. of the

Kinetic Phosphorescence Analyzer (KPA)
for Dissolved U(VI) Analysis

Operations Reminders

Replace the reference solution in the instrument: Once per day

Generate a new calibration curve

(i.e., run the calibration standards): Once per week

Prepare fresh dilute Uraplex solution from the stock: Once every 2 months or more frequently
Prepare fresh calibration standards: Once every 4 to 6 months

Replace the laser dye: Once every 6-8 months

(Check periodically for evaporation/precipitation)

1. Starting the Instrument and Software

1.1) Ensure that the KPA is turned ON. Check for the green light on the front panel of the instrument
(the green light will be on when the instrument is on). The power switch is located on the back
panel immediately above the power cord.

1.2) Let the instrument warm up for at least 1 hour. You can consider turning the instrument on the
night before to save time.

1.3) Turn the computer on and log in: Select: “Chemchek”

User: Chemchek
Password: kpat1

If the password expires, change it back to "kpa11".

1.4) Start the KPA software by double-clicking the "KPAWIn" icon on the desktop or single-clicking
the icon on the task bar ,
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1.5)

1.6)

1.7)

Click on "Security” - "Login” to log into the software:

User: Supervisor
Password: . Supervisor (note capital S)

If the computer and the KPA were off when you started, test the connection between the
computer and KPA. Click on “Tools” -> “Diagnostics” - “Probe KPA Unit". Ensure that there
are no error messages and the light on the front of the KPA is still green.

Click on the “Analysis Input Form” icon (red vertical bar just to the right of the stop sign) in the
upper left to start analyses. (You can also click on “Analyze” = “Sample Input”.)

e This will open up the previous "Sample Input Configuration” window, including the
calibration and the standards that were processed during the last run. If you wish to
use the previous calibration curve, do not remove any of the samples from this input
form; just continue to add samples to the current form.

» If you wish to create a new calibration curve, then clear the current grid and enter the
parameters for the new calibration curve (see below). Clear the current grid by clicking
on “Analyze” - “Remove All”, and clicking “Yes" at the prompt.

2. Replacing the Reference Solution

At the beginning of each day's run, the reference solution needs to be changed.

NOTE: Pipetters and any other debris or waste generated should only be discarded in the trash can
in the lab. Do not discard any materials in any other trash can.

2.1)

2.2)
2.3)

2.4)

2.5)

2.6)

Wear gloves when handling solutions and cuvettes.

Remove the reference (quartz glass) solution cuvette from the KPA. The reference solution
spot is the one closer to the door hinge.

Ensure that the cuvette is clean. Rinse the inside with distilled water (fill with distilled water then
evacuate the water using a pipette; repeat three times) and wipe the outside with a kimwipe.

Transfer 1.5 mL of dilute Uraplex solution into the cuvette using the adjustable pipetter.

NOTE: The Uraplex solution is kept in the refrigerator in the men's restroom. Be sure to check
the date of the Uraplex solution. If the Uraplex solution is older than 60 days, prepare a new
solution using the procedure in Attachment 1.

Transfer 1.0 mL of 100 ppb uranium standard solution into the cuvette using the adjustable
pipetter and a clean pipette tip.

Mix thoroughly by réplacing the cap on the cuvette and turning upside down several times, or
by withdrawing and replacing solution 3 to 4 times with the adjustable pipetter. -
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2.7) Place the cuvette back into the proper position (i.e., the slot closest to the hinge in the front
door) in the KPA.

.3. Running the Calibratidn Standards

Uranium concentration is determined in samples by comparison against a calibration curve. This
calibration curve is generated by running calibration standards. A new calibration curve should be
generated by re-running the calibration standards at least once per week. It may be useful to get into the
following routine:

e |[f the instrument is being run once per week or less, plan on running a calibration set every time
you. run.

e |f the instrument is being run more than once per week, plan on running a calibration on the first
day the instrument is run in a given week.

Add the calibration standards to the sample input form using the following procedures:

3.1) If you wish to run a new calibration standard, clear the current sample analysis grid by clicking
on "Analyze” - “Remove All", and clicking "Yes" at the prompt.

3.2) The standard calibration set can be loaded into the sample analysis form by clicking on “File” >
“Open”, highlighting “WeekCal”, and then clicking “Load”. This should ioad the following set of
calibration standards into the sample analysis form:

Sample ID: Description: Sample Type: Range:
weakHNO3 2% HNO;3 background BckGnd Both
5ppb_std 5 ppb standard CalStd Both
10ppb_std 10 ppb standard - CalStd Both
50ppb_std 50 ppb standard CalStd Both
100ppb_st 100 ppb standard CalStd High
1000ppb_st 1000 ppb standard CalStd High

100ppb_ch 100 ppb check standard CChkStd High

If the form was populated correctly, proceed to step 3.8 below.

If the “WeekCal" file is not present or if a modified calibration set is to be used, the calibration set can be
entered manually:

3.3) Add a new sample to the input list by clicking the “+" icon. The first sample should be
“BckGnd". Provide the following information for the sample

o Sample D example: weakHNO3 (don't use spaces)

o Sample Type Leave this as “BckGnd” and plan on runmng a 2% HNO3 blank.
o Description = Your preference, spaces allowed.

o Preferred Range Both
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Note that all RED fields need an entry, but you will leave the defaults for most of them
(Alarms/Marnings, Calibration Config, KPA Unit Settings, Performance Limits, QC Limits, and
Concentration Units).

3.4) Click on the “+" iéon again, and provide the fdllowing information for the fifst calibration

standard:
o Sample D example: 5ppb_std (don't use spaces)
o Sample Type CalStd (choose from drop-down)
o Description Your preference, spaces allowed
o Standard ID Keep this simple; example: §
o Standard Concentration (ug/L) example: 5
o Preferred Range Low/High/Both/Auto (see guidelines below)

Leave other RED fields at their default values..
3.5) Repeat step 3.4 for each of the calibration standards.

3.6) Before moving on to sample analyses, it is recommended that a calibration check standard be
run. This may consist of any of the calibration solutions. Click on the “+" icon, set the Sample
Type to “CChkStd”, and follow the steps above to fili in the sample information.

3.7) If desired, save the details of the calibration set to a file so they can be quickly recalled the next
time you run a calibration set. Click on “File” > “Save As", specify a file name in the "Enter
Sample Name ->" box, and click “Save All” (be careful to click Save All instead of Save, or else
it will only save details for the last sample in the list).

Prepare and run the calibration standards using the following procedures:
NOTE: For the first standard for the weak HNO3 solution, use 1.5 mL Uraplex and 1.0 mL of 2% HNO3.
3.8) Add 1.5 mL of dilute Uraplex solution + 1.0 mL of the desired standard solution to the cuvette.

o If using the quartz glass cuvette, be sure it is thoroughly cleaned with distilled water
before use.

o If using a plastic cuvette, use a clean fresh cuvette and dispose after use. Use a kimwipe
to lightly wipe away any dust or Styrofoam particles. Do not rub too vigorously, or you
may create an electrostatic charge on the plastic.

3.9) Insert the cuvette into the sample position in the KPA (slot furthest from the sample chamber
door hinge). Ensure that the Reference Solution is also in place (slot closest to the door hinge).

3.10) Click on the "Analyze Selection” (lightning bolt) icon to start the run. Follow the prompts as they
appear on the screen, loading each calibration in sequence into the KPA.
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Assess the quality of the calibration curve:

3.11)

3.12)

3.13)

3.14)

3.15)

3.16)

Once all of the calibration standards have been run, click on the "Display Calibration” icon to
view the calibration (it is the icon that looks like a book, next to the lightning bolt). This brings
up the “Select Calibration Samples” window.

Review the data. If satisfied with the calibration, PRINT the screen for recordation and file
appropriately. If not satisfied, repeat calibration. [f not satisfied after multiple attempts, see

Troubleshooting Steps.

Inspect the R? values for both the low range and high range calibration curves. Thisis a
measure of the goodness-of-fit of the line fitted to the individual calibration data points. The R?
value should be very close to 0.999 or higher for both curves; if it is close to 0.98 or below, the
calibration may be poor. Repeating the calibration process with new standards may be

required.

Inspect the “% Disc” for each of the individual calibration standards. This is a measure of how
much a given data point differs from the fitted line. If any of these values are substantially
outside +/~10%, that particular calibration standard may not be accurate. The calibration
process may need to be repeated with freshly-prepared standards.

If you want, you can view a plot of the calibration curve by clicking the “Plot” button. Return to
the previous view by clicking the “Grid" button.

Return to the "Sample Input Configuration” window by closing the "Select Calibration Samples”
window.

4. Running Samples

4.1)

4.2)

4.3)

Before sample analyses, ensure that the following pre-operation checks have been made:

o Did you replace the Reference Solution?
o Do you need to re-run the Calibration Standards?
o Is the dilute Uraplex solution fresh?

o Have the samples been properly digested?

Add a new sample to the input list by clicking the “+” icon within the “Sample Input
Configuration” window.

Add infermation for the following (note that all RED fields require a value, but some you will not
change from the default):

o Sample ID Use sample name (no spaces)

o Sample Type Sample (pick from drop-down)

o Description Your preference, spaces allowed

o Prediluted Volume (mL) see below (Sample Volume Information)
o Diluted Volume.(mL) see below (Sample Volume Information)
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o Sample Volume (mL) see below (Sample Volume Information)
o Analysis Volume (mL) see below (Sample Volume Information)
o Preferred Range Low or High (see guidelines in step 6 below)

4.4) Add 1.5 mL of dilute Uraplex solution and 1.0 mL of the desired sample solution into the cuvette
(quartz or disposable plastic) using the adjustable pipetters.

4.5) Click on the "Analyze Selection” (lightning bolt) icon to start the run.

You have the option of adding muiltiple samples to the input list before clicking the “Analyze Selection”
option (click the “+" before clicking the lightning bolt). (NOTE: The volumes need to be entered before
the “Analyze Selection” button is pushed.) The software will then prompt you when it is time to load each
sample into the instrument. However, it is advisable to run each sample before adding the next sample to
the input list, rather than adding several samples to the input list at once. There are two reasons for this:

e Ifthere is a problem with the current sample being run, you may wish to modify the planned
sample sequence (for example, re-run the current sample).

e [t will be easier to view the results of the current sample in the results window before it is
displaced by the result of the next sample (this is described in more detail below).

Sample Volume information

The KPA software contains four input fields for sample volumes, which automatically accounts for two
sample dilutions.

The first two fields should be used to account for dilution during sample preparation:

Prediluted Volume = Volume of sample added to the digestion vial
Diluted Volume = Final solution volume in the vial after digestion
Example: You could perform a digestion by adding 3 mL of your sample to a

digestion vial, plus some acid, plus some peroxide. Then you heat the
sample to complete dryness during the digestion, and then you add 5 mL
of acid solution to redissolve. The prediluted volume would be 3 mL and
the diluted volume would be 5 mL.

See Attachment 1 for more detail on sample preparation and dilution procedures.

The second two fields should be used to account for any additional dilutions that are made following the
initial sample preparation.

Sample Volume = Volume of sample added to the vial

Analysis Volume = Volume of solution in the vial after adding sample and diluent
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Example: You could prepare a 10x dilution by adding 0.5 mL of sample to 4.5 mL
of 2% nitric acid (for a total volume of 5 mL); Sample Volume = 0.5 and
Analysis Volume = 5.0.

Example: You can also dilute directly into the cuvette for the analysis. Instead of
adding 1.5 mL dilute Uraplex + 1.0 mL of sample to the cuvette, you
could add 1.5 mL of dilute Uraplex, 0.2 mL of sample, and 0.8 mL of 2%
| nitric acid. This would yield a 5:1 sample dilution: Sample Volume = 0.2
f mL, Analysis Volume =1.0 mL (=0.2 mL+ 0.8 mL).

If no dilution is made in the second step, then Sample Volume and Analysis Volume shouid be the same
(you can simply enter 1.0 and 1.0).

5. Running Calibration Checks

While you are running the instrument, it is recommended that you run a calibration check once per every
8 to 10 samples, as well as at the beginning and end of the sample run.

s The calibration check standard may be something different each time

¢ The calibration check standard can either be one of the calibration standards you prepared in-
house, or one of the PerkinElmer lab-prepared standards. It is recommended that you alternately
run both.

¢ Calibration check blanks should also be run periodically, consisting of 2% nitric acid.

¢ As with all samples and standards, the calibration checks (standards and blanks) must be
prepared with 1.0 mL sample and 1.5 mL dilute Uraplex.

The following is a hypothetical sample list for a given day’s run:

‘Sample Type:

e Background (2% nitric acid) BckGnd

e Calibration standards (typically 5) CalStd

¢ Calibration Check (1 std; e.g., 100 ppb) CChkStd

¢ Sample set (8 to 10 or less) Sample

e Calibration Check (1 std; e.g., 10 ppb) CChkStd

¢ Sample set (8 to 10 or less) ' Sample

e Calibration Check (1 std; e.g., 100 ppb) CChkStd

¢ Calibration Check Blank (2% HNO;) CChkBIk

Use the following procedures to add calibration checks to the sample run:

5.1) Add a new sample to the input list by clicking the “+" icon.
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5.2) Add information for the following (note that all RED fields require a value, but some you will not

5.3)

change from the default):

o Sample D . example: 100ppb_Chk

o Sample Type CChkStd or CChkBlk

o Description Your preference, spaces allowed

o Standard ID example: 100

o Standard Concentration (ug/L) example: 100

o Preferred Range Low or High or Both (see guidelines below)

Both (if running a check biank)

Add 1.5 mL of dilute Uraplex solution and 1.0 mL of the desired calibration standard/blank into
the cuvette (quartz or disposable plastic).

5.4) Click on the “Analyze Selection” (lightning bolt) icon to start the run.

6. Choosing the Appropriate Analysis Range

The cutoff for operating in the low range of the KPA is approximately 50 to 100 ppb uranium. Above this
value, the intensity is too high for the detector to measure accurately. For samples above this cutoff, an
aperture is placed in the path of the phosphorescence to limit the amount of light reaching the detector —
this allows the KPA to operate in the high range.

The following are some guidelines for choosing the appropriate range:

Because the highest concentration standard within the low range is 50 ppb, the low range should
only be used up to that concentration. For samples with higher concentration, the high range
should be chosen.

If the sample concentration is higher than the highest standard used in the high range (1000 ppb),
the sample must be diluted such that it falls either within the low range or the high range.

For many concentration standards and blanks, the range will be set to “Both” (such that the
sample is run under both the high and low range).

If it is unknown whether the sample concentration falls within the high or low range, the range can
be set to “Auto”. However, this is generally not recommended, as this does not always work
(sometimes the sample is run in the low range even though it is more appropriate in the high
range).

If you are unsure which range is appropriate, a good policy is to run it in the high range. If you
find that the raw concentration (i.e., concentration measured by the instrument before correction
for dilution) is below 100 ppb, re-run the sample in the low range to get a more reliable
concentration,
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7. Viewing Results during the Run

At the end of each sample analysis, the results of that analysis are automatically displayed in a results
window. It may be labeled “high” or “low” depending on the range run; if both ranges were run, two
results windows will be present. However, this window is often hidden beneath the “Sample Input
Configuration” window.

7.1) Minimize the Sample Input Configuration window and inspect the results window. Note that this
window will not update until the current sample is done processing (this may take several
seconds).

7.2) Record the information by outputting to a designated Excel file at the end of the run (See
Section 8).

7.3) Note that TWO concentrations will be displayed in this window:

o The "Concentration” value, which is included in the “Results” outlined box. This is the
concentration measured by the instrument (non-dilution corrected)

e The “Final Result” is the concentration corrected for dilutions. This is the actual
~ uranium concentration in the original sample.

Check the "Concentration” value and make sure that it is within range of the calibration used: ‘

s [f the "Concentration” is higher than the highest standard used (typically 1000 ppb), the
sample will need to be diluted and re-run. [f dilution is required to get below the highest
standard used, refer to Attachment 1.

¢ If the sample was run in the high range and the “Concentration” is below 100 ppb,
consider re-running the same sample in the low range.

7.4) Check the sample lifetime. The sample lifetime should be between approximately 250 to 350
ns. Lifetimes below 250 pus indicate substantial quenching, and the uranium concentrations
obtained may be highly erroneous.

7.5) Check the reference ratio. This number should be very close to 1; if it's not, this may indicate
that the reference solution may need to be changed, or the calibration standards may need to
be re-run.

7.6) The Sample R? value should be very close to 1; if not, the uranium concentration obtained is
likely erroneous (it is likely that the Sample Lifetime will also be low).

7.7) Check for any alarms/warnings that went off during the sample run, and determine the extent to
which data quality was impacted. A guide to the alarms and warnings is included in the
Chemchek attachments.

Note that the results window only contains information for the most recent sample analysis completed.
‘When another sample is run, the results for this sample will displace the results for the previous sample;
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therefore, you will want to view and record the results for a given sample before it is displaced by the
next sample in line.

8. Downloading and Pfinting the Data

At the completion of the day's run, particularly if concentration information for each sample was not
written down during the run, export the concentrations to a text file using the following procedure.

8.1) Click on the Sample Reports icon (white paper icon just to the right of the upper stop sign icon)
to open the Sample Reports window.

8.2) Choose the date range for which you want to retrieve samples. If you only want to download
the current day's samples, click the “Between” button in the “Date” box and enter the current
day's date in both boxes.

8.3) Leave all other fields in their default settings.

8.4) Click the “Retrieve Samples” button. The sample list of interest should appear in the window. If
the samples of interest are not in the window, double-check the date range and click “Retrieve”.

8.5) To export the data, the number next to each sample in the “Sample Key” column needs to be
highlighted. To export all samples in the window, click on the first “Sample Key" value (it should
then be highlighted blue), use the window scroll bar to scroll down to the bottom of the list, hold
the Shift key down, and click on the last “Sample Key” value. This should highlight all of the
Sample Key values blue.

8.6) Click the "Export Reports” button. This should bring up a new window.

o IMPORTANT: Ensure that both “Result-AnalyticalResult” AND “Result-FinalResult” are
included in the "Included Export Fields” list (see step 8.12 below). By default, the
Analytical Result may be in the list, but not the Final Result. If the Final Result is not
listed, then find it in the "Available Export Fields" list, highlight it, and then click the "Add
Field(s)" button.

8.7) Click the "Export Data” button. If this button is grayed out, you may need to click the "Apply”
button first. '

8.8) This should bring up a “Save As” window. Give the file a name of your preference (a date
stamp is a good choice; e.g., KPAEXPORT_07Jan2014.TXT), but retain the “.TXT” extension.
It is recommended that you save the file to the computer in a common folder (check the
“Documents” - “KPA OQutput” folder).

8.9) Once saved, open Windows Explorer and then copy the file from the common folder on the
computer to a USB key.

This procedure saves a comma-delimited text file. The results are most easily viewed by importing the
data into Microsoft Excel. '
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9.

8.10) Open Microsoft Excel, and go to [Windows Icon] - "Open”.

8.11) In the "Open” window, be sure that “All Files (*.*)" is highlighted in the drop-down, and then
open the KPA export text file.

8.12) This should bring up a "Text Import Wizard” window. The text file is comma delimited. To
import the text, highlight "Delimited” (rather than “Fixed width”), click the "Next" button, and then
check the “Comma” box. Then click “Finish".

8.13) Sample results and statistics should now be listed in separate Excel columns. Note the
following:

o As described above, the "Analytical Result" is the concentration measured in the solution
by the instrument — this does not correspond to the uranium concentration in your sample
if any dilutions or digestions have been performed. Based on the dilution information
entered when you ran the sample, the “Final Result" is calculated — this is the actual
concentration of uranium in your sample.

o This should also contain other important details on your sample run: R? value, sample
lifetime, etc. Review these parameters for quality as outlined above.

8.14) Save the Excel file by clicking “File” - “Save As”; with "Save as type:" set to "Excel Workbook"
(with the “.xIs" or “.xIsx” extension). Additional recommendations for data analysis are as
follows:

o Do not modify the data in the original worksheet tab that you imported; instead, make a
copy of the worksheet within the same workbook for data analysis and plotting. That
way, the original tab includes all of the “raw” data. To do this, right-click on the tab at the
bottom of the worksheet, click “Move or Copy...", check the “Create a copy” box, then
click "OK”. Do this as many times as you like to have separate data analysis/plotting
tabs. ‘

o When sample names only consist of numbers, Excel will interpret that as a number. This
can be switched back to text by putting an apostrophe at the beginning of the number
{Excel then interprets it as text).

Shutting Down the Instrument

9.1) Remove the sample cuvette from the instrument. If using the quartz cuvette, thoroughly rinse
with distilled water and wipe the outside dry with a kimwipe. The cuvette can be stored in the
instrument for later use.

9.2) Remove the Reference Solution cuvette, dispose of the solution, and clean the cuvette. Store
in the instrument.
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9.3) After downloading the data (step 8 above), close all open windows within the main KPA Win
window by clicking the X's in the upper right. Do not close the main KPA Win window with the
X.

9.4) Once all open windows are closed, click oﬁ "File” > “Exit" to close the software.

9.56) If you plan to run the next day, you can leave the computer and the KPA instrument on. If you
do not intend to run the instrument again soon, shut down the computer and turn off the KPA
instrument (the power switch is located on the back panel immediately above the power cord).

10. GENERAL TROUBLESHOOTING:
Calibration Issues:

1. Check the Standard.

a. [f the calibration date is suspect, try:
i. Using an auxiliary Standard
ii. Order a new Standard from the lab.

b. If the integrity of the bottle is suspect; look for contamination or fouling in the solution. If

found:

i. Use the auxiliary Standard
ii. Order a new Standard from the {ab.

2. Check the Reference Solution
a. The reference solution should be replaced each day. If a fresh reference solution was
not used, or is suspect, repliace the reference solution and repeat the calibration
procedure.
b. If the reference solution is believed to be contaminated, replace the reference solution
and repeat the calibration procedure. :
¢. Review the steps in the sample preparation. Ensure the agents into the solution were
properly dosed.
i. Check that the HNO3 concentration is accurate; if a formula was used to
determine the dilution ratio, then:
1. Verify the original concentration of the HNO3 solution.
2. Re-check the calculation.
ii. Prepare a new solution

3. Check the Quartz Vial
a. The quartz vial needs to be clean. This means: Free of scratches and free of air bubbles
when the solution is being analyzed. Inspect the quartz vial:
i. If scratches are found, discard the container and replace with a new one.
ii. If air bubbles are present in the solution, gently agitate until the air bubbles are
released to the surface of the solution. Be sure to wipe the outside of the
container with a kimwipe (or other lint free wipe) before replacing.
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b. The quartz vial needs to be positioned properly. This means: Squarely in position, and
fully seated. Check to ensure both of these items and correct as necessary.

4. Check the Laser Dye. . .
a. The laser dye neéds to be replaced every 6 to 8 months. Check to ensure this has been
done.
b. Check for evaporation or precipitation. If either is present, replace the dye.

5. If calibration issues still persist:
a. Consult the KPA User's Manual.
b. Call technical support.

| Other Issues:
For additional technical support, it may be necessary to call an outside consultant for help.
Attachments

Attachment 1: Procedures for Sample and Reagent Preparation
Attachment 2: Procedure for Preparation of Calibration Standards
Attachment 3: Procedure for Replacement and Preparation of Laser Dye
Attachment 4: List of Supplies and Vendors

Attachment 5: KPA Instrument Operation Manual (Chemchek)
Attachment 6: KPAWIn Software User's Guide (Chemchek)

Attachment 7: Potential consulting contacts for technical support
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Attachment 1

Sample Preservation, Digestion, Dilution, and Reagent Preparation

Units:

Volume: 1 liter (L) = 1,000 milliliters (mL)
1 mL = 1,000 microliters (L)

Concentration; 1 milligram per liter (mg/L} = 1 part per million (ppm)
1 mg/L. = 1,000 micrograms per liter (ug/L)
1 ug/l. = 1 part per billion (ppb)

Contents:

» Preservation of Freshly-Collected Samples

» Sample Digestion on the Hot Plate

Sample Dilution

e Reagent Preparation: 50% HNO;, 2% HNO;, and 20x Dilution Uraplex

1) Preservation of Freshly-Colleéted Samples

Aqueous samples should be preserved with acid to prevent potential metals precipitation and adsorption
to storage bottles. Acid preservation involves acidification of the sample to below pH 2 using
concentrated nitric acid (HNO3). This is typically achieved by addition of 1.5 mL of 70% w/w nitric acid
per liter of sample.

Acid dosing for sample preservation (use EITHER concentrated HNO; OR 50% HNO,, not both):

Sample Volume Acid Dose OR Acid Dose
(Concentrated HNO,) 50% HNO,

20 mL 0.03 mL 0.06 mL (60 pL)

50 mL 0.075 mL 0.15 mL (150 pL)

100 mL 0.15mL _ 0.3mL (300 uL)

250 LOBTEML 075 L7507

500 mL 0.75 mL 1.6 mL

1000 mL ~1.5mL 3.0mL
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2) Sample Digestion on the Hot Plate

Sample “digestion” may need to be performed for several reasons, primarily to remove chloride from the
solution because it interferes with the uranium analysis. Digestion to remove chloride involves addition of
acid and evaporating the sample to complete dryness; this causes chloride to evaporate with water as
hydrochloric acid (HCI), thereby removing it from the sample. Other dissolved solids (including uranium)
do not evaporate; they precipitate in soluble salts at the bottom of the digestion vial and are redissolved
with addition of 2% HNO3.

o Label a set of fresh 20 mL scintillation vials according to the sample names using a permanent
marker.

e Transfer sample solutions to the scintillation vials usmg the adjustable pipetter. See the
suggested volumes below.
o Itis recommended that a new pipette tip be used between each sample. An acceptable
alternative may be to rinse the pipette tip between each use by pulling clean water into
the pipette.

o Add 50% HNO; solution to each of the scintillation vials containing the aqueous sample (see
suggested volumes below).

 Remove the cap from the vials and place the samples to be digested on the hot plate and turn the
ot plate on until all water has evaporated. The dial setting should be at approximately 2.5 or 3.0.

Suggested volumes for digestion (adjust as necessary):

Add to vial before heating:

Sample volume: 2mL
50% HNO; volume: 0.3 mL '
3% H,0, 1mL Use ONLY if first attempt at digestion yielded a low solution

lifetime on the KPA

Add to vial after heating to complete dryness:
2% HNO3 volume: 3mL Add to sample after heating to complete dryness.

3) Sample Dilution

To obtain accurate measurements with the KPA, the sample concentration needs to be lower than the
highest concentration standard used, which is typically 1,000 ppb. If the sample concentration measured
by the KPA is above 1,000 ppb, then the sample must be diluted and re-run. The following procedures
should be used:

¢ Run the sample on the KPA using the procedures outlined in the Main SOP. Be sure to account
for any dilutions performed during the digestion step (see Section 4, "Sample Volume
Information”, Main SOP), but start by running the sample without additional dilution.
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e After the sample run is completed, check the “*Concentration” value in the results window (see
Section 7.2, Main SOP). [f this concentration is above 1,000 ppb, dilute the sample and re-run.
The following guidelines are suggested:

Dilution Into Vial Dilution Dlrectly Into Cuvette

---------

Ly

1,000 to 2,000 5x 1 4 5 0. 0.8 1

2,000 to 5,000 10x 0.5 45 5 0.1 0.9 1
5,000 to 10,000 20x 0.5 9.5 10 — not recommended -—
10,000 to 50,000 50x 0.2 9.8 10 ~--- notrecommended ---—

.« Account for the dilutions above in the “Sample Volume” and “Analysis Volume” boxes in the KPA
window, where the “Analysis Volume” is the Total Volume indicated in the table.
+ For concentrations above 50,000 ppb (50 ppm), a serial dilution may be required (e.g., perform a
100x dilution by performing a 10x dilution on the sample, then another 10x dilution on the diluted
sample).

4) Reagent Preparation: 50% HNO3, 2% HNO3, and 20x Dilution Uraplex

Preparation of 50% Nitric Acid

The 50% nitric acid solution is prepared on a volume basis, simply by adding 1 part concentrated acid to
1 part water. Strictly speaking, this yields a solution less than 50% nitric acid by volume (since
concentrated nitric acid is typically 70% HNO, by volume, a 1:1 dilution in water yields a 35% solution by
volume). More accurately, the acid stock used (70% HNO,) is a 16 M (moles per liter) nitric acid solution,
and the "50% Nitric Acid” solution prepared below is an 8 M nitric acid solution.

Procedure for preparation of 100 mL of 50% (8 M) nitric acid:

» Add 50 mL of clean water to a clean, empty 100 mL or 250 mL plastic bottle. Label as “50%
Nitric Acid (8 M)" using a Sharpie pen. This can be done in one of two ways:
o Fill a 50-mL volumetric flask with clean water up to the line, then pour from the flask into
the clean plastic bottle, OR
o Place the plastic bottle onto the electric balance, Tare (zero) the balance, then fill with
clean water up to 50 g.

o Using the rubber bulb, pull acid from the jér into the graduated acid dispenser such that more
than 50 mL is present in the dispenser.

¢ Dispense 50 mL acid into the plastic bottle containing water, using the graduations on the acid
dispenser as a guide. (REMEMBER: Always add acid to water, not the other way around.)

Preparation of 2% Nitric Acid

The 2% nitric acid solution is prepared via 25X dilution of the 50% nitric acid stock.

Procedure for preparation of 100 mL of 2% nitric acid (Volumetric Flask method):
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o Fill a clean 100 mL glass volumetric flask approximately halfway with clean water.

» Using the adjustable pipetter with a clean tip, add 4 mL of 50% nitric acid stock to the water within
the volumetric flask.

e _ Continue to fill the volumetric flask to the white line with.clean water.

»  Mix well (end-over-end), then transfer the solution to a clean 100 mL or 150 mL plastic bottle.

Preparation of 20x Dilution Uraplex

Fresh dilute Uraplex solution should be prepared at least once every one to two months. When not in
use, it may be stored in the refrigerator, but it is advisable to remove it from the refrigerator the day before
use so that it may come up to room temperatuire.

Procedure for preparation of 100 mL of 20x Dilution Uraplex:
¢ Fill a clean 100 mL glass volumetric flask approximately halfway with clean water.
¢ Using the adjustable pipetter with a clean tip, add § mL of concentrated Uraplex solution to the

water within the volumetric flask. (The concentrated Uraplex solution should always be stored in
the refrigerator.)

e Continue to fill the volumetric flask.to the white line with clean water.
e Mix well (end-over-end), then transfer the solution to a ciean 100 mL or 150 mL plastic bottle.

« Add date to the bottle of all newly prepared solutions using a permanent marker.
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Attachment 2

Preparation of Uranium Calibration Standards

Updated: 10/26/2015
Standard solutions must be prepared at least once every 4 to 6 months and stored tightly capped, in a
cool place (ideally in the refrigerator) to avoid evaporation. Wear disposable gloves and eye protection

while handling stock and standard solutions.

The procedure outlined is for the preparation of uranium calibration standards from a 1000 ppm stock at
the following concentrations:

e 5ppb (ugl)

» 10ppb

s 50 ppb:

s 100 ppb ’
e 1000 ppb

Use the pre-labeled 100-mL volumetric flasks for preparation of the standards. You will also need
distilled water (1-gallon plastic jugs purchased from Walmart) for glassware rinsing as well as deionized
water (supplied by ARCADIS laboratory) for preparation of solutions. Although the distilled water is very
clean and appropriate for rinsing of glassware before use, the deionized water is even cleaner and should
be used for preparation of solutions.

1) Ensure that glassware is clean and dry, following rinsing with tap water and then with distilled
water. Ensure adjustable pipetter is functional and accurate, and there are enough disposable
tips available before starting work. Tips should be changed after every use.

2) Check to make sure that you have six 100-mL volumetric flasks with glass stoppers, labeled “10
ppm”, “1000 ppb", “100 ppb", 50 ppb”, “10 ppb”, and "5 ppb”.

3) Fiii the “10 ppm” (not the “10 ppb”) 100-mL volumetric flask about halfway with deionized water.
Using the adjustable pipetter, add 1 mL of the stock uranium solution (1000 ppm U) to the 100 mL
volumetric flask.

4) Continue to fill the flask to the white line on the neck using deionized water.

When completing any volumetric glassware, slowly fill it until water reaches the neck of the flask,
or gets closer to the marked volume line. Then, use a disposable transfer pipet or squirt bottle to
transfer more water into the flask, until the bottom of the meniscus reaches the marked line
exactly, without passing it. If too much water is added and the overall volume surpasses the
marked line, the procedure will need to be repeated.

5) Cap the volumetric flask and gently turn it upside down twice to mix the solution. Transfer the
solution to a clean, dry glass beaker labeled “10 ppm U”. This solution will be used to make the
five standards used for instrument calibration.
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1000 ppb solution:

6) Fill the “1000 ppb” 100-mL volumetric flask abouf halfway with deionized water.

7) Using the adjustable pipetter, add 10 mL of the 10 ppm U solution to the volumetric flask.

8) To the same volumetric flask, add 2 mL of 50% HNOQ; solution. Complete the flask up to the
marked line with deionized water, cap and mix. .

9) Transfer the solutionto a series of 20 mL scintillation vials for storage and-use. Label the
scintillation vials with the uranium concentration and date. Note that some of the 1000 ppb
solution will be used to prepare the 50 ppb, 10 ppb, and 5 ppb solutions below. .

100 ppb solution:
10) Fill the “100 ppb” 100-mL volumetric flask about halfway with deionized water.

11) Add_1 mL of the 10 ppm U solution to the volumetric fiask.

12) To the same volumetric flask, add 2 mL of 50% HNO; solution. Complete the flask up to the
marked line with deionized water, cap and mix. Transfer the solution to 20 mL scmtlllatron vials

for storage and use.

50 ppb solution:

13) Fill the "50 ppb” 100-mL volumetric flask about halfway with deionized water.

14) Add 5 mL of the 1000 ppb U solution to the volumetric flask.

15) To the same volumetric flask, add 2 mL of 50% HNQO, solution. Complete the flask up to the
marked line with deionized water, cap and mix. Transfer the solution to 20 mL scintillation vials

for storage and use.

10 ppb solution:
16) Fill the “10 ppb” 100-mL volumetric flask about halfway with deionized'water.

17) Add 1 mL of the 1000 ppb U solution to the volumetric flask.

18) To the same volumetric flask, add 2 mL of 50% HN03 solution. Complete the flask up to the
marked line with deionized water, cap and mix. Transfer the solut|on to 20 mL scintiltation vials

for storage and use.

5 ppb solution:
19) Filt the "5 ppb” 100-mL. volumetric flask about haifway with deionized water,

20) Add 0.5 mL (500 ulL) of the 1000 ppb U solution to the volumetric flask.
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. 21) To the same volumetric flask, add 2 mL of 50% HNO; solution. Complete the flask up to the
marked line with deionized water, cap and mix. Transfer the solution to 20 mL scintillation vials
for storage and use.
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Attachment 3

Preparation of Laser Dye

Updated: 10/27/2015
Contents:

e Preparing and Storing the Laser Dye Solution
e Replacing the Laser Dye Solution

The laser dye cell, which contains the laser dye solution, is located inside the KPA. The laser dye solution
consists of an organic dye dissolved in methanol. This dye solution is necessary for producing the proper
wavelength of light for excitation and measurement of uranium in the sample. Over time, the organic dye
breaks down and must be replaced by emptying and refilling the laser dye cell. It is recommended that
the laser dye solution in the instrument be replaced every 6 to 8 months, but consider changing more
frequently (every 3 months) if the instrument is being used often (daily or weekly).

The Dye Module is shown in the figure below. The laser dye cell is located inside the Dye Module. To
access the module, the KPA cover must be removed, as described below. For additional information,
refer to Section 2.3.3 of the KPA Instrument Operation Manual.

Round black cap
covering the laser
dye cell holder

Black box with “Danger”
sticker is the Dye Module

Preparing and Storing the Laser Dye Solution:

The laser dye solution is prepared by dissolving the dye powder (Stilbene-420, obtained from ChemChek)

in methanol. The dye solution is prepared in a 20 mL scintillation vial (the same ones used for sample

and calibration standard preparation and storage). The dye solution in the instrument breaks down over

time due to exposure to laser light. However, once prepared, the dye solution is more stable in the dark

and in the refrigerator, as long as the methanol does not evaporate. .
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1)

2)

3)

4)

5)

6)

Locate all of the supplies needed:

s Laboratory gloves

e 20 mL scintillation vial

e Laboratory balance

e Methano!

e Stilbene-420 dye (1 g powder in a small vial, should be stored in the cabinet in a box)
e 5-mL adjustable pipette and transfer pipettes

* Weigh-boat or weigh-paper and small scoop. Aluminum foil will also work for both.

Fill the scintillation vial with 20 mL of methanol using the 5-mL adjustable pipette.

Place the weigh paper or small (2-inch x 2-inch) piece of aluminum foil on the analytical balance and
tare/zero the balance.

Measure out precisely 19.1 mq laser dye powder onto the weigh paper/foil using a scoop or small
shred of aluminum foil. Note: this will seem like a small mass of powder.

Transfer the powder into the methanol solution using the weigh paper/foil. Cap and label the vial
(include today’s date in the label), shake, and allow the powder to dissolve completely. It may take an
hour or more for the powder to completely dissolve.

After replacing the dye in the instrument (procedure below), cap the vial tightly and store the
remainder of the solution in the refrigerator. Consider wrapping the vial in aluminum foil to minimize
light exposure.

Replacing the Laser Dye Solution:

1)

2)
3)

4)

5)

Prepare fresh laser dye solution using the procedure above, or check to see if there is any previously-
prepared laser dye solution in the refrigerator.

o [If using previously-prepared and refrigerated dye solution, inspect the bottle to ensure that
there was no spillage or evaporation and that the solution is clear (no precipitation of dye).
Consider preparing fresh solution if the refrigerated solution is more than 1 year old.

Remove the KPA cover (four screws located on the bottom-side edges of the instrument)

Locate the Dye Module and remove the laser dye cell cap. You may need to push down and twist.
Slide the laser dye cell up and out of the module. NOTE the location of the label on the dye cell - the
cell must be placed back in the same orientation. Note also that the dye cell slides in and out of the

module at a slight angle — not straight up-and-down.

Inspect the dye cell for any precipitation in the solution. If a precipitate is present or if ethanol has
evaporated, consider replacing the dye solution more frequently.
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6) Remove the cap on the cell. Using a transfer pipette, remove the solution from the cell and dispose.
Be careful to avoid touching the walls of the cell.

7) Rinse the inside of the cell with methanol using a transfer pipette and dispose of rinse solution.
8) Add fresh laser dye solution using a transfer pipette.

9) Place the cell back into the module. It should slide easily into the holder at a slight angle. Verify that
the cell label is directed toward the arrow and the label on the Dye Module cover.

10) Place the black cap back onto the cell holder, and then reinstall the KPA cover.
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Attachment 4

KPA Equipment Purchase List

Updated: 10/27/2015

= Not yet otdemed HIGHLY RECOMMENDED

500 mL bottle, 1,000 ppm U in 2% nitric acid
~ Five 100-mL bottles, 50 ppb U in 2% nitric acid

~ der Periodically As-Needed):

Type 3P Disposable Acrylic, 4 clear windows
" Borosilicate glass with attached cap (polyethylene liner)
~ 11cmx2icm
500 mL, green lid

' Extended fine tip, large bulb

~ Finntip 250 Universal: 0.5 - 200 uL (10 x 96 rack)
Finntip 1000: 100 - 1000 uL (10 x 96 rack)
Finntip 5 mL: 1 -5 mL (5 x 54 rack)

Type P66 Cell Holder
VWR Labmax, 1-5 mL volume basic dispenser
500 mL amber glass reservoir
10" x 10", 120 V, 1500W, 12.5A, Ceramic top
Aluminum block for scintillation vial heating
Wheaton Vial Rack

Chemchek Instruments
Chemchek Instruments
Inorganic Ventures
PerkinElmer

NSG Precision Cells
VWR Scientific
VWR Scientific
VWR Scientific
VWR Scientific
VWR Scientific
VWR Scientific
VWR Scientific

NSG Precision Cells
VWR Scientific

VWR Scientific

VWR Scientific
Chemchek Instruments
VWR Scientific

9110049
9110008
CGu1-5
Custom Quote

3PMFTA
66022-065
470173-504
16650-024
414004-023
53511-901
14232914
53515-980

40000-062
53502-520
97042-650
P/N 9110008
66022-556

25 mL bottle
1 g powder
500 mL

5x 100 mL

Box of 100
Case of 500
box
Pack of 6
Pack of 250
Case of 960
Case of 960
Case of 270

each
each
each
each
each
Case of 5

$95.00
$60.00

$256.50

$43.00
$284.84
$4.65
$47.88
$39.58
$78.34
$82.40
$96.77

$26.00
$363.29
$33.57
$539.23
$495.00
$107.00
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$190.00
$60.00

$256.50

$172.00
$284.84
$46.50
$47.88
$39.58
$78.34
$82.40
$96.77

$52.00
$363.29
$67.14
$539.23
$495.00
$107.00

Total Cost
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Kinetic Phosphorescence ! evel ¢ 1 Oof ( nium and Lanthanic
1845 Terminal Dr. Suite 101+ Richland WA 99354 + USA + Tel: 509-943-5000 * Fax; 509-946-3368 » Website: www.chemchek.com

Mr. Adrian Venable October 22, 2015

Homestake Mining Co. Phone: 505-287-4456

Hwy 605 Fax:  505-287-9289

Grants NM 87020 E-mail: avenable@barrick.com

Quote # DS15-64P

ITEM QUANTITY _DESCRIPTION US$ PRICE
1 1 P/N 9110008 Heat Block (64 vial capacity) 475.00
2 1 Handling charge $20 per published price list 15 May 2015 required. 20.00.
TOTAL $495.00.
Delivery: 10 days ARO or ASAP
Shipping: UPS Ground Pre Pay and Add or on Customer's courier account.

(Insurance coverage recommended)
Terms: Net 30 per published price list 15 May 2015. Checks or ACH. Credit cards not accepted.

Note: U.S. ECCN #3A999 (f) prohibits export or re-export to E country groups (under embargo or any country that
supports terrorism) without U.S. Export License. U.S.D.0.C. deemed export license may be required if the use of
this technology is by a citizen from country group E.

FOB: Richland, WA 99354
Quote valid: 60 days
Quoted by: Barbara Miller-Collins, President

Page 1 of | Chemchek Instruments, Inc. Quote: DS15-64P
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PerkinElmer*

For the Better QLI Otatlon
PerkinElmer Health Sciences Inc. Phone. 1-800-762-4000
710 Bridgeport Avenue Fax; 203-944-4804

Shelton, CT 06484-4794

To: Adrian Venable QUOTE NO.: 45001997
Homestake Mining Co. ' T QUOTE VALID TO: 12/26/2015
Hwy 605 QUOTE DATE; 10/26/2015
GRANTS NM 87020 PAY. TERMS: Due Upon Receipt

FREIGHT TERMS: FOB Factory - Prepay & Add
ULTIMATE DEST.:. UNITED STATES OF AMERICA

TELEPHONE NO. 505-287-4456

FAX NO. 505-287-9289
YOUR REFERENCE
A [ MATERIALIDESCRIPTION i | OTYEA | UNITERICE
1 SPECIALSTD PEPLUS-251-500 ) 1 290.00 290.00
Material Discount 72.50-
PERKINELMER PURE PLUS
50 UG/L U

MATRIX: 2% HNO3
VOLUME: 500 ML (5 X 100 ML)
+/-5% ACCURACY, 6 MONTH EXPIRATION

' Freight/Handling: 39.00

Total Net Price in USD: 256.50

Please direct orders to LAS.Customs@perkinelmer.com or fax 203-402-1912,

CUSTOM STANDARDS MAY NOT BE CANCELED OR CHANGED ONCE THE ORDER
HAS BEEN PROCESSED

MARGARET CLEARY

SEND PURCHASE ORDERS TO:
PerkinElmer Health Sciences, Inc.
710 Bridgeport Ave.
Shelton, CT 06484-4794
Phone: 1-800-762-4000 . SALES REPRESENTATIVE: MARGARET CLEARY

Fax: 203-944-4904 PREPARED BY:  Natasha Harrison
Email: LAS.Customs@perkinelmer.com . '

ACCEPTANCE OF TIIIS QUOTATION IS LIMITED TO THE ATTACHED TERMS AND CONDITIONS
TERMS SUBJECT TO CREDIT APPROVAL




PerkinElmer Health Sciences, Inc.
Terms and Conditions of Sale

1. PARTIES. “Buyer” as uscd herein means the addressee of this quotation. "PERKINELMER" as used herein means PerkinElmer Health Seiences, Inc.
Buyer and PERKINELMER are individually referred to as a "Party” and callectively referred to as "Parties”,
2. PRECURSOR. Buyecr is réquired to Supply chemically pure compouiids, purified biological material, and/or cell lines (hereinafter "precursor(s)") for
the products to be generated by PERKINELMER pursuant to this quotation, In the event the precursor(s) is(are) destroyed in whole or in part during
manufacture of the products by PERKINELMER, Buyer shall have no claims whatsoever, including, without limitation, claims for damages of any kind, !
against PERKINELMER or any of its cmployecs or representatives as a result of such destruction. At Buyer's clection, PERKINELMER will dispose of -
or return to Buyer, at' Buyer's sole expense, alf unused precursor(s) provided by Buyer when the work under this quotation is completed or otherwise !
terminated. :
3. CONFIDENTIALITY. Without prior approval, each party will keep all information concerning this project niade available to such party by the other ;
party Including the existence of this Agreement, as far as such information is not common knowledge, strictly confidential and will in no event provide the
same lo a third party other than its professional advisors, and then only subject to the same obligation of confidentiality as applics to the parties of this
agreement. Further, without the prior writien permission of a party ("Disclosing Parly™), the other party ("Receiving Party") will not disclose any ;
information pertaining to.any service outlined in this Proposal unless such information (i) is already known to Receiving Party before Disclosing Party's !
entering into this Proposal, (ii) is or becomes publicly available through no fault of Receiving Party, (iii) is reccived from a third party which has the legal,
right to disclose it to Receiving Party (iv) is required by any law, rule, regulation, decision, order, subpocua or other process to be disclosed; or (v) is ,
shown through sufticicnt cvidence to be independently developed by the Receiving Party without reference to the information. If disclosure by subpoena,
order, ctc., is requested, Receiving Party will notify Disclosing Party promptly of such request.
4, COMPLETION DATE. The date for the completion of the products is estimated from the later of the date of receipt by PERKINELMER of (a) the
purchase order, (b) the precursor(s), or (c) all information required to produce the product(s) from the precursor(s). This date is an cstimate and subject to |
change. Whenever possible, PERKINELMER will provide Buyer with advance notice of such a change; however, PERKINELMER shall have the right
to changc the estimated completion date, and Buyer shall have no claims whatsocver, including, without limitation, ¢laims for damages of any Kind,
against PERKINELMER or any of its employccs or representatives as a result of such a change.
5. CANCELLATION. PERKINELMER may encounter unforeseen diflficultics in the preparation and purii cation of products which conform to the
specifications and terms quoted herein. [n such event, PERKINELMER shall have the right to cancel this quotation, and Buyer shall have né claims
whatsoever, including, without limitation, claims for damages of any kind, against PERK! I'NELMER as a result of such a cancellation. Whenever
possible, PERKINELMER will offer o modified quotation.
6. PAYMENT, Buyer shall remit payment to PERKINELMER within thirty (30) calendat days of the date of invoice.
7. PERMITTED USE OF PRODUCT. Buyer shall use the products and #ny deivatives thercof for research purposes. only, and shall not use the products
(or derivative thereof) for any other purposes, including, without limitation, for.in vitro (hagnosuc purposes or in foods, drugs, biologics, medical devices;
or cosmetjcs, for humans or animals. Buyer shall not usc, transfer, scl, or otherwise distribute the products or derivatives thereof to any third party,
whether alonc or in combination with other materials, Buyer also shall comply with any instructions or other limitations fumished by PERKINELMER
relating to use of the products (or derivatives thereof) and not misuse the products (or derivatives thereof) in any manncr.
8. COMPLIANCE. Without limiting the use restrictions of Section 7 above, Buyer covenants to PERKINELMER that Buyer shall test the precursor(s)
and/or the praducts for any risks to health or the environment, comply with all applicable rcgulatory requirements, take appropriate precautions 10 protect |
persons and the environment from such risks; enforce appropriate methods of: rcscarch to minimize such risks, implement safety assessments and ;
procedures relative to the procurcnient, storagg, use ajd disposal of the niaterials mvolved ‘and issue all appropriate warnings and information to users of ; i
the precursors(s) and/or products,
9. NO WARRANTY/LIMITATION OF LIABILITY. PERKINELMER MAKES NO WARRANTIES, WHETHER EXPRESS OR IMPLED, WITH
RESPECT TO THE PRODUCTS ARISING HEREUNDER, INCLUDING, WITHOUT LIMITATION, ANY WARRANTY OF MERCHANTABILITY:
OR FITNESS FOR ANY PARTICULAR PURPOSE, OR THAT SUCH PRODUCTS MAY BE USED WITHOUT INFRINGING THE PATENTOR  :
OTHER INTELLECTUAL PROPERTY RIGHTS OF ANY THIRD PARTIES. PERKINELMER SHALL NOT BE LIABLE TO BUYER, NOR SHALL
PERKINELMER BE RESPONSIBLE FOR INDEMNIFYING BUYER, FOR USE BY BUYER OF THE PRODUCTS GENERATED PURSUANT TO | i
THIS QUOTATION. PERKINELMER SHALL BE UNDER NO LIABILITY WHATSOEVER TO BUYER (WHETHER IN NEGLIGENCE OR ';
OTHERWISE) FOR ANY EXPENSE, LOSS, DAMAGE OR INJURY OF ANY KIND (INCLUDING ANY LOSS OF PROFIT OR OTHER
CONSEQUENTIAL, SPECIAL OR INCIDENTAL DAMAGES) SUSTAINED BY BUYER OR ANY THIRD PARTY ARISING OR INCURRED IN !
CONNECTION WITH THIS QUOTATION, OR DERIVING DIRECTLY OR INDIRECTLY OUT OF THE PROVISION OR USE OF TIIE ;
PRODUCTS ARISING HEREUNDER. IN NO EVENT SHALL PERKINELMER'S LIABILITY FOR ANY CLAIM ARISING IN CONNECTION
WITH THIS QUOTATION OR DERIVING DIRECTLY OR INDIRECTLY OUT OF THE PROVISION OR USE OF THE PRODUCTS ARISING
HEREUNDER EXCEED THE PURCHASE PRICE PAID BY BUYER FOR SUCH PRODUCTS.
10. INDEMNIFICATION., In casc of any actual or alleged third party claimn of infringement against Buyer or PERKINELMER and its affiliates in the
performance of the work described in this quotation, Buyer will indennify and hold harmless PERKINELMER and its affiliates, and their officcrs, '
directors, employees, agents and reimburse such parties for any expenses incurred in connection with such claim. The parties will immediately inform
each other of any of such claims.
11. ACCEPTANCE; MODIFICATION OF TERMS. Buyer's acceptance of this quotatior is cxpressly subject to Buyer's assent to each and all of the
terms and conditions set forih herein, and Buyer's assent to these Terms and Conditions of Sale shall be conclusively presumed from Buyer's submission |
of its purchase order, No addition to or modification of said Terms and Conditions of Sale shall be binding upon PERKINELMER unless specifically
agreed to by an authorized representative of PERKTNELMER in writing. If Buyer's purchase order or other correspondence contains terms or conditions:
contrary to or in addition to th¢ terms and conditions contained herein, acceptance of any order by PERKNELMER shall not be construed as assentto
such contrary of additional terms and congditions or constitute a waiver by PERKINELMER of any of the terms and conditions contained herein. {
PERKINELMER's acceptance of Buyer's purchasc order is expressly conditioncd on Buyer's assent to these Terms and Conditions of Sale, i
12. TNTERPRETA TTON. These Terms and Conditions of Sale shall be governéd by and construed in accordance with the laws of the Commonwealth of
Massachusetts, wlthout rcgard to the conflicts of law prmciplcs thercof.
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Attachment 7

Potential Consulting Contacts for Technical Support

Shannon Ulrich : Michael Hay - Jeff Gillow

630 Plaza Drive, Suite 100 4999 Pear! East Circle, Suite 200 630 Plaza Drive, Suite 100
Highlands Ranch, CO 80129 Boulder, CO 80301 Highlands Ranch, CO 80129
shannon.ulrich@arcadis-us.com michael.hay@arcadis-us.com jeff.gillow@arcadis-us.com
303-471-3465 303-544-0043 x22 303-471-3446

If you run into difficulties while running the instrument, it may be useful to send a copy of the database
and some screen-grab images to ARCADIS personnel to aid in troubleshooting.

The procedures for exporting the database are as follows:

10.1)

10.2)

10.3)

10.4)

10.5)

10.6)

10.7)

Close all open windows within the main KPA Win window by clicking the X’s in the upper right.
Leave the main KPA Win window open.

Insert a USB key into the USB drive.

Click on “Database” - "Open”. This will bring up a window called “Looking for KPA Database
File",

In the list of files on the right-hand side, find the file with the most recent “Date modified” (likely
today’s date).

Right-click on the fite, point to “Send to", locate the USB key in the list, and click on it. This will
create a copy of the database file on the USB key.

Click “Cancel” on the “Looking for KPA Database File” window. Click the “OK” button on the
“NO Database Assigned” window.

Email the database file that was copied to the USB key.

Use the following procedures for collecting screen grabs (an image of what is currently drsplayed on the
monitor) using the following procedures:

10.8) With the KPA Win software displayed on the screen, press the “Print Screen” button in the

10.9)

upper right of the keyboard.

Open Microsoft PowerPoint, and pasté the screen-grab image onto the slide (“Paste” is in the
upper left).

10.10) Add additional PowerPoint slides for screen-grabs by clicking on “New Slide”.

10.11) Save the PowerPoint file to the USB key and email it along with the database file to ARCADIS.

Page 1 of 1
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Kinetic Phosphoréscence Analyzer
Model 11 (KPA-11)

1.0 RECEIVING THE KPA

1.1 Introduction

You have the opportunity to use the latest in electro-optic technology, data analysis,
and patented technology in your analytical work as incorporated within the
CHEMCHEK Kinetic Phosphorescence Analyzer. The KPA-11, a commercial kinetic
phosphorimeter, offers new and unique features that help produce better results.

1.2 Warrantee

CHEMCHEK INSTRUMENTS, INC. warrants this instrument to be free from defects in
materials and workmanship for a period of twelve (12) months from delivery. Should
defects develop within this time, CHEMCHEK will, at its option, either repair or replace
the product without charge. However, the laser plasma cartridge is warranted for
2x107 pulses or one (1) year, whichever comes first. Replacement of the plasma
cartridge is on a prorated basis.

CHEMCHEK INSTRUMENTS will also indemnify our customers against infringement
resulting from our activities or resulting from our product as provided. Specifically,
CHEMCHEK shall retain the options of procuring appropriate rights for its customer in
order to avoid infringement, modifying its product to avoid the infringement, or
requesting the return of the product to CHEMCHEK for full refund of purchase price
and shall have no other liability.

1.3 Liability Disclaimer

Liability to CHEMCHEK INSTRUMENTS, INC. for any defect in this instrument is
limited to the invoice price of the defective instrument. CHEMCHEK INSTRUMENTS,
INC. has no control over the set-up, use, connection to other equipment, or data
generated by means of CHEMCHEK products. Therefore, in no event shall
CHEMCHEK INSTRUMENTS, INC. be liable for any incidental or consequential
damages, losses, or liability which may result from improper use of its products, either
in connection with other equlpment or in the generation, reporting, or application of
data and resuits.

1.4 Receiving The KPA-11

The KPA-11, phosphorescence cells, software, laser dye, analyte complexant, power
and serial cables, and this manual comprise the KPA system. A computer capable of
running Windows 95/98/NT/2000/XP is required. Either Chemchek or the customer
provides the computer and any necessary- perlpherals

. .1.4.1 Unpacking s




.

Unpack the equipment immediately after receiving and check for evidence of damage.
Remove the cover of the KPA and check inside for concealed damage, which may
show up only during actual operation.

The cells are shipped in a Styrofoam box. The laser dye and URAPLEX™ are
packaged inside plastic bags. The laser dye should be stored in a dark, dry location
and the URAPLEX™ requires immediate refrigeration upon arrival.

1.4.2 Damage Notification

The carrier making delivery should be notified immediately of any detected damage,
and is normally liable for damage in shipment. Packing materials, shipping papers,
etc., should be retained in order to establish claims. After notification of the carrier,
please inform CHEMCHEK of the circumstances so that assistance in making damage
claims and in providing replacement equipment, if necessary, may be provided.

1.5'Repair Service

If it becomes necessary for instrument repair, please contact CHEMCHEK
INSTRUMENTS. The repair may be most expeditiously accomplished by returning
either the part or the complete unit for repair or replacement. With first-day delivery
transportation, a repair can be completed within a week. First, obtain a Return
Authorization Number (RA#) and communicate the nature of the fault, either in writing
or telephone, and the model and serial number. Returned instruments must be packed
to withstand normal transit handling and shipped PREPAID via air. The address label
should include the RA# assigned. Returned instruments that are damaged in transit
due to improper packing are repaired at the sender's expense, and the sender is
responsible to make damage claims with the carrier. Instruments not in warranty will
be repaired at the standard rates. In unusual warranty repair cases, such as misuse,
the sender will be notified prior to the repair and given a repair quotation. '

1.6.1 Packaging The KPA For Return

To avoid damage and consequent repair changes, please observe the following:

1. Remove the cells from the sample compartment and retain.
2. Remove and empty the dye cell. Place the cell in its box or another protective
container. ,

3. Either place the KPA in a plastic bag or wrap it in plasfic

4., Package the KPA in a box having at least 5 cm (2 inches) of packlng material
on all sides. Seal the box and ship by air.

NOTE: Ideally, save the original KPA box and packing materials. Manual KPA-11s
are now shipped inside a case to be used for return.



2.0 KPA SPECIFICATIONS AND SET-UP
2.1 Specification For The KPA-11 |

Kinetic Phosphorescence Analyzer, model 11. Computerized Kinetic phosphorimeter.

[Humination Source

Pulsed Laser

Peak Output Power
Average Power

Pulse Length

Pulse Energy

Repetition Rate

Nitrogen Laser Wavelength
Dye Laser Range

Detection System
Interference Filters
Photomultiplier Tubes
Mode Of Operation Of PMTs
Sensitivity Range
Additional Specifications
Power Source

Data Communication Port .
Weight

Standard Accessories Included
Enhancing Reagent

Cuvette
Laser Dye

Additional Accessories Available

PERSONAL COMPUTER (IBM compatible)

nitrogen pumped dye laser
5.0 kW

0.5 mW

3ns

20J

1-20 pps.

337 nm

360-900 nm

10 nm Bandpass
300-650 nm

photon counting

high, low - each 10,000

115/220 VAC, 50-60 Hz
200 W

RS232

14 kg

URAPLEX™ for uranium
EDTA for lanthanide elements
2, Low Fluorescence

19

AUTOMATIC SAMPLE CHANGER: automatic analysis of 42 or 108 samples.
Samples are loaded in sample vials suitable for sample preparation. Sample
and enhancing reagent are automatically mixed before each measurement. Cell
flushing and decontamination are automatic and complete, with a
sample-to-sample decontamination of about 1000.

REMOTE SAMPLE CHAMBER: for analysis in hostile environment, with limited

space availability in the hood.




2.2 Description Of Components

The KPA-11 is a bench-top instrument that rapidly performs single-measurement,
quench corrected analysis by measuring sample phosphorescence as a function of
time.

2.2.1 KPA Components

Figure 2.2.1 shows the various component of the KPA-11. A pulsed dye nitrogen laser
provides the wavelength necessary for the excitation of the photoluminescence of the
sample. The dye laser makes available a range of excitation wavelengths from 360 to
900 nm with high spectral and temporal purity. The laser beam passes through a
reference cell prior to the sample cell. These cells are part of two separate and
identical detection systems. The reference measurement functions as an external
standard in normalizing sample measurements to correct instrumental fluctuations
such as laser brightness and temperature drifts. The sensitivity of the KPA is
optimized with f/1 mirrors and lenses, as well as high performance interference filters.
Photomultipliers working in the photon counting mode are used to detect the sample
and reference luminescence. The KPA-11 counts photons of photoluminescence
between each laser pulse as a function of time with the choice of two to hundreds of
time gates. The time resolution can be varied in order to achieve multi-component
resolution.



Figure 1. Diagram of the Kinetic Phosphorescence Analyzer |
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2.3 INSTRUMENT SET-UP
2.3.1 Location

The KPA-11 was designed to permit module stacking to conserve bench space. A 19 x
21 inch space, preferably near a sink, is adequate for the KPA. Space is also

necessary for a computer (adjacent or remote) and peripherals. A computer terminal -

or a printer, for example, may be placed on top of the KPA-11.

The location should have clean temperature controlled air and not be near a source of
organic fumes, such as stored urine samples.

2.3.2 Connections

The computer is connected to the KPA-11 by means of the serial cable. Connect the
25-pin connector end of the serial cable to the KPA and the 9-pin connector to the
computer serial port. When multiple serial ports are present, select the operating port
for KPA using the KPA software. (See KPAWIn User's Guide)

The KPA-11 automatically operate from either 90-132 or 175-264 VAC within the
range of 47-63 Hertz. No switching is necessary.

2.3.3 Laser Dye Cell

Remove the quartz dye cell (cell with screw cap) from its box and clean carefully,
using good optical technique. Let cell dry.

NOTE: HANDLE THE CELL CAREFULLY TO AVOID BREAKAGE. IT IS AN OPTICAL
ELEMENT OF THE SYSTEM. A REPLACEMENT CELL MAY PRODUCE
HIGHER BACKGROUND, LOWER SENSITIVITY AND REQUIRE DYE
MODULE REALIGNMENT.

Using a Pasteur pipette, fill the dye cell with methanol solution of stilbene-420 (23.9
mg of stilbene-420 in 25 mL methanol) or your other choice of dye solution. Screw on
the cap.

Remove the cover of the KPA. In the left front corner is the dye module, which has a
cover with a laser warning sign and a black cap over the dye cell holder. Always
remove the cap with a turning-twisting motion. The cell should smoothly slide into the
holder at a 5° angle slanted toward the left side of the KPA. DO NOT FORCE! The
cell label must be directed toward the arrow and the label on the dye module cover.

NOTE: BE SURE THE CELL IS IN ITS TRACKS.
Replace the black cap and KPA cover. The dye solution is long lasting because of the

low laser power. Dye replacement should be every 2 to 3 months, when it evaporates,
or when it develops a precipitate from decomposition.

b
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2.3.4 Tunable Dye Module (Optional Equipment)

A grating, which is rotated by means of a micrometer control, is used in place of the
rear mirror in the dye module to permit infinite excitation wavelength tuning throughout
the range of a particular dye. Use of the micrometer setting of 0 nhm is the broadband
mode and yields laser power similar to the peak when wavelength selection is used.
The 0 nm setting is also used when the dye module is being tuned. The beam at the
aperture may be viewed by following the instructions in Section 8.1. If the best beam
is obtained at a setting somewhat different than 0, this difference may be used to
correct nm readings throughout the range of use. See the following pages.

Most dyes produce adequate intensities over about 40 nm. See the dye vendor for
detailed information. Stilbene-420, which is frequently used in the KPA-11, has an
intensity peak near 425 nm. Intensities may be measured as a function of the
excitation wavelength (dye module micrometer setting) by taking repeated
"background” measurements with an appropriate concentration of analyte in the
sample cell. Operation of the dye module is by turning the micrometer to the desired
wavelength, which is indicated on the dial read-out. The read-out is in micrometers,
or, if the decimal point is ignored, nanometers.

The micrometer wavelength setting is locked by means of the ring just above the
digital read-out. Turn the ring counter-clockwise to loosen before changing the
wavelength setting. Turn it clockwise to lock the micrometer setting at a wavelength
selection.

2.3.5 Emission Filters

The light emitted from the substance being determined is filtered through interference
filters, so that the photomultiplier tubes will detect only the wavelength bandpass that
provides the best signal to noise ratio.

The KPA is normally provided with high performance filters having a bandpass of 10
nm, which are in an optics holder at the rear of the sample chamber. The optics holder
is friction mounted; its adjustment screw is in the center of the sample chamber cover.
To remove the optics holder, reach into the sample chamber and grasp the knob,
which is above and between the lenses. The optics holder should snap out at its top.
To replace it, carefully position the bottom of the holder on the pointed guide pins
before snapping it into place. A second optics holder simplifies frequent conversions
of the KPA between analytes.

Emission filters are normally retained in the holder by internal snap rings. Removal of
the rings permits switching filters in the optics holder.

NOTE: FILTERS ARE OPTICAL ELEMENTS; handle and clean them accordingly.

10




2.4 Applications: Methods and KPA Set-Up

Method
Analyte Laser Complexant Buffer Detection
Dye . Limit (ng/L)
Dysprosium BPBD EDTA Acetate 0.2
Europium PBBO EDTA Acetate 0.05
Samarium PBBO EDTA Acetate 2
Terbium BPBD EDTA Acetate 0.01
Thulium BPBD EDTA Acetate 1
Uranium Stilbene-420 URAPLEX™ - 0.01
Spectroscopy

Analyte Wavelength (nm): Signal Timing: Lifetime (us)

Excitation Emission StartGate  Duration (us)
Dysprosium 402 580 4 13 20
Europium 398 620 4 13 350
Samarium 405 589 2 2 8
Terbium 375 550 4 13 1200
Thulium 362 450 2 2 18
Uranium 425 515 4 13 200-300

Analytical Range

Over 1,000,000 for uranium (from 0.01 to 50,000 ppb).

11
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3.0 LASER SPECIFICATIONS AND SAFETY

3.1 Description

The KPA-11 meets all requirements of 21 CFR 1040.10 for a Class | laser product in
that there is no laser radiation accessible by the operator. The laser incorporated
within the KPA-11 is a Class Ili-b, pulsed nitrogen ion laser (337 nm), which pumps a
dye to produce a beam. This beam is totally enclosed and inaccessible except during

service.

3.2 Active Laser Warnings

The laser emits an audible warning, a "clicking” sound, which warns when the laser is
on and pulsing. In addition, a warning light on the front panel of the KPA changes from
green to red whenever the laser is on and pulsing or enabled so it can come on.

3.3 Laser Specifications

Parameter Nitrogen Dye
Maximum Power Output (mW) 2.0 0.5
Peak Output Power (kW) 40 5.0
Pulse Length (ns) 3 3
Pulse Energy (pJ) 120 20
Repetition Rate (pps) 1-20 1-20
Wavelength (nm) 337 400-700
Warranted Lifetime of
Plasma Chamber (pulses) 2x107

(years) 1
Beam Dimensions 3x8 mm
Laser Head Power
Requirements 12VDC @ 2A

12




3.4 Interlocks

The KPA-11 has several interlocks to protect personnel and also the sensitive
photomultiplier tubes (PMTs) from excessive light levels (see Figures 1 and 2). The
KPA interlocks utilize infrared optoreflector sensors. These emit infrared light toward a
protective housing, which reflects it back to a sensor, a part of the device. They not
only interrupt normal operation when a protective housing is not in place, but they are
checked by the internal computer at the beginning of each measurement to ensure
that any detected light is reflected by the housing rather than from an external source.
The interlocks are described below.

a. Primary Door Interlock. The door is interlocked to prevent laser and PMT high
voltage actuation when the door is not latched. The optoreflector sensor is pointed
upward toward the door latch, which is rotated to horizontal in latching. The interlock
is actuated to prevent laser and PMT operation when the KPA door is unlatched.
Actuation is intended during operation, maintenance, and service.

b. Secondary Door Interlock. The door is interlocked to prevent laser and PMT high
voltage operation when the door is open. The optoreflector sensor is mounted on the
front panel and behind the door, where it is actuated by the door opening and closing
during operation, maintenance, and service.

c. Cover Interlock. Maintenance and/or service personnel must be protected from
accidental exposure to laser radiation when protective housings are removed. The
optoreflector sensor is mounted on the inside top of the front panel, where it is
directed at the KPA cover. It prevents activating the laser or PMT high voltage.
Actuation is during maintenance and service, when the protective housing (KPA
cover) is not in place.

d. Other protective housings exposed by removal of the KPA cover are exclusively
over the laser, over the dye or 337 nm modules, and the beam trap, which eliminates
the used laser beam. The O.E.M. laser cover is interlocked with microswitches.
Actuation interrupts power to the laser.

Computer Interlock. The computer controls all instrumental operations, thereby
fulfilling a pseudo laser interlock role. The laser cannot be operated except through
deliberate use of the KPA computer program. Even then, the laser will only operate for
a preset maximum time, usually 50 seconds. The computer interlock is actuated
during normal operation and prevents laser operation except through program
commands.

13
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Figure 3. Interior View of Cover Interlock Sensor
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3.5 Laser Product Labels
In conforming to 21 CFR 1040.10, the KPA has the following labels:

a. Certification and Identification labels. These are combined and located on
the rear panel.

Chemchek Instruments, Inc.

b. Protective Housing Labels. Removal of the KPA cover may permit exposure
to Class lllb laser radiation. Therefore, each side of the cover has the warning
label shown below. A protective housing label can also be found on the laser
cover, dye module cover, and the black beam trap.

CAUTION - CLASS 3B LASER
RADIATION WHEN OPEN AND
INTERLOCKS DEFEATED.
AVOID EXPOSURE TO BEAM




4.0 PRINCIPLE OF OPERA TION
4.1 Theory

Nearly all molecules scatter or emit light after having been struck by a photon.
Fluorescence' involves the absorption of a photon, which electronically excites the
molecule. Return to ground state occurs by relaxation of the intermediate singlet
electronic state with the emission of a photon. The relaxation lifetime typically is of the
order of nanoseconds. Phosphorescence involves a similar process, except the
relaxation incorporates a triplet electronic state. The subsequent return to ground state
with emission of a photon is "forbidden”, so the relaxation lifetimes range from
microseconds to hours: For more detail, the reader should refer to one of many texts on

the subject.

With a pulsed excitation source, phosphorescence emissions may be observed in the
absence of other light so that measurement conditions are optimum. Pulsed lasers (20
pulses/second maximum in the KPA-11) provide the best temporal resolution for this -
purpose. In kinetic phosphorimetry®, the pulse of source light is assigned an occurrence
time of zero. Intensity measurements are taken at fixed intervals in time, called time
gates, following the pulse. Intensity values from these intervals are summed over the
number of pulses used in each measurement. In this way, excellent statistics and
repeatability can be obtained.

The first order kinetic decay of an excited phosphor for example uranyl ions, can bé
represented by the equatlon

4.1) In Ui=inU, - (k+ kq)t " where,
U; = population of excited uranlum ions attimei= tor O,
ko, = rate constant for phosphorescent decay, and

kq = rate constant for all other relaxation processes.

" The number of detected photons at any time, t, is proportional to the number of excited

urany!l ions. As a result, the least squares fitting of the logarithm of detected intensity
versus time-after-pulse yields an intercept proportional to the number of excited uranyl
ions. This intercept is independent of nonradiative effects such as quenching. The decay
lifetime, 1, is defined as the reciprocal of k, + kg, which is the tlme required for the
phosphorescent intensity to decrease by the factor 1/e.

Nonradiative relaxation processes generally involve coIhs;onal interactions and transfer
of energy. These processes must be minimized by stabilizing or otherwise protecting the
molecules of interest. Cryogenic temperatures, conversion to solid state, formation of
micelles, and complexation are effective methods. Complexation of the uranyl ion with
URAPLEXTM“” at room temperature, is utilized for uranium. Lifetimes as long as 340
microseconds (us) are observed under optimum conditions. Lifetimes greater than 100
us are required for best measurements. In practice, the instrumental plus reagent
background must be recorded and subtracted from the measured sample intensities,
because background luminescence may be significant and does not follow first order
decay kinetics.
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® B.A. Bushaw, Progress in Analytical Spectroscopy, Proceedings of the 26th Oak
Ridge Conference on Analytical Chemistry in Energy Technology, Knoxwlle TN,

October 1983,

® URAPLEX™ is a proprietary complexing agent for uranium. URAPLEX™ may be
obtained from: CHEMCHEK INSTRUMENTS, INC., 1845 Terminal Dr., Richland, WA
99354 ,

4.2 Principles of KPA Hardware and Qp_eration

The KPA operates on emission and detection of light in the visible spectrum as a
function of time. In particular the KPA utilizes equation 4.1 in section 4.1. This equation
simply states that after excitation of the sample, the natural logarithm of the light emitted
by the sample will decay linearly with time from its starting value, which is when the
population of excited analyte molecules is at a mathematical maximum. This is at time t =
0, when the exciting light is terminated. The intensity of light emitted from the excited
analyte molecules at any time is directly related to the concentration of the analyte and
the intensity of excitation for that particular sample. Assuming the excitation process is

reproducible, then concentrations can be determined simply by measuring emitted light .
intensity, either steady state during the time of excitation or later, after a delay time. -

Unfortunately, short lived luminescence, varying relaxing processes and excited state
lifetimes, stray excitation light, -and other uncontrollable variables make it extremely
difficult to accurately quantify the analyte of interest by emission intensity.

However, using the decay equation 4.1, the amount of light emitted at = 0 can be

accurately determined by observing the light emitted over a period of time after the

unwanted light sources have decayed. Equation 4.1 describes the rate of decay of a

population of electronically excited analyte molecules. Since intensity, I, of emitted light

is proportional to concentration, we can substitute lntensny for concentratlon in equation

4.1 and obtain: :

(4.2) Inlo =1Ink + (ko +kot.

This equation can be lised for sample analysis if we provide:

a. A means of excitation of the sample.

b. A method of measuririg the emitted light.

¢. A method of correlating Ilght mtensﬂy to t|me

'd A method of relating light mtensﬂy to concentration of the analyte

In the KPA these are accomplished as follows

a. . Excitation of the sample is provided by a pulsed mtrogen dye laser. Laser
wavelength and power are dependent on the laser dye and tuning. Average power
is in the 0.1 - 0.5 mWatt range Pulse duration is 3 ns at a frequency of 20 pulses/
second or less.

b. Light intensity is measured with a photomdltiplier tube, which is' connected to a

photon amplification and discriminating circuit. This combination yields an
electronic signal whose frequency is directly proportional to the intensity of
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detected light.

In the KPA, the electronic signal just described is fed into a counting circuit, which
is read and reset by the microprocessor. Each successive reading of the counter
occurs after a constant interval and forms a time gate. The individual contents of
the counter are stored in consecutive memory locations in the on-board
microcontroller. In ‘other words, this circuitry provides a series of numbers in
memory, which correspond to emitted light displaced in time.. The chosen
increment of time is the duration of the time gates. The number of time gates is
predetermined in the KPA. The result is emitted light intensity as a function of
tlmle For uranium, 128 time gates, each 13 s long, are read for every laser
pulse. A

Since the photomultiplier tubes of the KPA produce statistical signals, the
precision of measurement can be increased by increasing the number of
observations. With the KPA, reasonable results can be obtained with as few as
200 laser pulses. The software is defaulted at 1000 pulses per measurement for
better precision.

Time is measured by clock cycles in a microprocessor circuit to establish the time
gates. Intensity measurements begln with the exciting laser pulse, which defines
time zero, t=0.

The light intensities for each time gate are summed over all laser pulses to form
an intensity sum for each time gate. These values are stored in memory. Their
logarithms become the dependent variable in the subsequent least squares
regression, where time is the independent variable. The KPA, with the aid of a
digital computer, utilizes this method to find the best linear fit of the data and
obtain the slope of the decay line and its intercept, where t = 0.

For uranium, the KPA program utilizes the intensities taken from time gates 5
through 49 in the least squares calculation. By delaying ~60 us until time gate 5,
intensities from most short-lived luminescence sources are eliminated from the
calculations. Forty-five values provide a considerable amount of data for
calculating precise results- without overly long data processing time. In addition, -
intensities over this period are generally well above noise levels except near the
KPA detection limits.

The analyte luminescence is related to the concentration of analyte in the KPA
sample cell by an empirical calibration procedure. During calibration, the emission
intensities from a standard solution of known concentration are measured and
stored. The intercept of the data at t = 0 is calculated according to equation 4.2,
That value is the quantitative parameter used to establish the calibration equation
relating signal to concentration, and to calculate analyte concentrations during
sample measurements.

The method just described is nominally sufficient to determine the concentration
of analyte in samples. The KPA corrects for several other variables in order to
improve accuracy and precision of the results. These are as follows:

1. Instrumental Background. This is a combination of low-level signals

produced by sources other than the analyte, including: photomultiplier tube
dark count (electronic noise), luminescence from the quartz cells and
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optics, impurities in the reagent, and stray ambient light. These sources
become particularly important at the lower detection levels of the KPA.
Since they will contribute signal to all measurements, they are classified as
background. '

The instrumental background is measured during calibration and stored for
subtraction from the intensities obtained in subsequent measurements. The
background is determined with a sample cell filled with BLANK, which is
deionized or distilled water and reagent to simulate a measurement on an
analyte-free sample.

2. Reference System. Optical instruments are sensitive devices that are
affected by various sources of instability. Since such signal deviations
cause variable results, the KPA includes a second photomultiplier and
electronic amplification and discrimination system, which is identical to the
sample system. This is called the REFERENCE channel.

"~ A second, reference cell containing the uranium reference solution (see
page 24) is placed in the laser beam just prior to the sample cell, in front of
its respective optics and detection channel. Detected luminescence is
processed in an identical fashion to the sample measurements except that
there is no background correction. Background is insignificant because a
pinhole aperture is used. The calculated intercept for the reference
measurement is used to normalize the corresponding sample data as
described in the next subsection. The result is a type of external
standardization that eliminatés or reduces the following sources of error,
which are listed below in order of importance and associated mode of

correction: '

Laser power: ' ' Both cells have common laser beam.
Ambient temperature change: Lifetimes are affected, but not the
intercept. :

Electrical line surges, and - :
- high voltage drift: - ©~ Common electrical sources.

Limitations in Detection Electronics. Photomultiplier tubes and electronic circuitry
have an upper limit to their frequency response. Since photomultipliers exposed
to light emit pulses which are not periodic with time, some pulses will be spaced
very close to the previous pulse, others will be further apart. Pulses that occur
before the electronic circuitry has recovered from the previous event will not be
counted. The result is a decrease in detection efficiency at high counting rates
and a nonlinear response. The KPA avoids using data in the nonlinear region by
actively monitoring the detected signal. Intensity values are not used in
calculations when they exceed a preset level set in the Seftings 2> General
Configuration - Performance Limits section of the program.

- During measurements at "high" concentrations, the set group of time gates
(defauited at 45) comprise a time window, which will shift out in time until a lower
intensity within the linear response range of the KPA is reached. The default time
gates 5-49 may shift to, for example, 80-124 at a very high level of analyte. The
extrapolation becomes too long to be accurate, but the result is still
semi-quantitative. Calculation of concentration is terminated when the time
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\év)indow passes beyond the range of available time gates (see also Section 4.3.3,

g. Analytical Range. The linear response range of electronics and photomultiplier
tubes limits the range of concentrations that can be determined with optical
instruments. In the KPA, the range has been substantially extended by usin
apertures to limit signal light. The result is two ranges: - :

Low Range: 0.625 inch aperture. From detection limit to within nonlinear region
of detection system where time gate shifting occurs (see Section
4.3.3, 3). The concentration where gate shifting starts to occur
varies from instrument to instrument. For uranium, a concentration
around 10-15 ng/L. most commonly represents the upper limit of the
linear interval in the low range. Concentrations higher than 20 ug/L
may cause gate shifting and should be analyzed in the HIGH range.

High Range: 0.02 inch aperture. From within low range to nonlinear region of
detection system where time gate shifting occurs in high range (see
also Section 4.3.3, 3). The concentration where gate shifting will
start to occur varies from instrument to instrument. For uranium, a
concentration around 5 mg/L. most commonly represents the upﬁer
limit of the linear interval in the high range. Concentrations higher
than 5 mg/L may cause gate shifting, and should be analyzed after
proper dilution. The 0.02 inch aperture is in place except during a
low range measurement. : :

h. PMT Protection. The photomultiplier tubes are protected from excessive light
levels by turning off the high voltage and closing a shutter. Each light detection
system has a pin hole for transmission of filtered emitted light to the
photomultiplier tubes. Since the high voltage is off except during a measurement,
the small amount of light transmitted when the door is open is not detrimental. On
the sample side, the pinhole is in a movable shutter. This shutter opens for each
low range measurement to make the 0.625 inch aperture available for much
greater sensitivity.

4.3 Calcuiations

The following explanation of KPA calculations is not detailed, and is only intended to aid
you in understanding the various aspects of the data treatment.

4.3.1 Principles

Since for photoluminescence the logarithm of intensity is a linear function of time (see
equation 4.2), each quantitative array of data for the preset number of time gates
(default gates are 5-49) undergoes a linear least squares regression (LSR). The result
yields the slope, which is rate of decay, and the intensity intercept, which is at zero time.
The intercept is a fixed, reproducible quantity for a given concentration of luminophor.
The slope is -1/lifetime, therefore it is characteristic of the luminophor and varies with its
chemical environment and with temperature.

The function of the REFERENCE measurement, which is part of each set of KPA data, is
to provide the means to adjust all sample data to a fixed reference point (the
REFERENCE MARK) for the purpose of removing instrimental deviations, primarily due
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to laser power fluctuations. LSR is applied to the reference intensities. The resulting
intercept, att = 0, is the factor used for normalization of all data.

The first measurement in each range (i.e. the background measurement) yields the
REFERENCE MARK, the intercept to which all other measurements are normalized. The
Reference Ratio for this measurement is defined as 1.00. All subsequent measurements

have their sample data adjusted (normalized) to the reference mark. This is done as
described in the following section, under 2.

4.3.2 Algorithm
Calculations are described in operational order.

1. The instrumental BACKGROUND is measured and stored. LSR is performed over
set time gates of reference data to obtain lifetime and intercept (RI). RI becomes
the REFERENCE MARK, RM.

2. Calibration Standards are measured and the intensities are normalized to the RM.
All subsequent measured intensities are normalized by: -

(4.3) (RM/RI) Is = I,

where |5 is lJuminescence intensity at each time gate, and I represents normalized
intensities.

Stored background is subtracted, gate intensity by gate intensity, from the
normalized standard intensities to obtain net intensities. LSR is performed on
standard net intensities to obtain lifetime (t), correlation coefficient (R?), and
intercept (SI) in counts per unit of concentration.

The calibration equation is produced by LSR of SI;, the intercept values for the
calibration standard(s) and their concentrations. The program offers the choices
of. :

(4.4) Linear fit of the form SI=aC + b
(4.5) Quadratic fit, SI = aC?+ bC + ¢ , and
(4.6) Linear fit with forced zero intercept Sl = aC,

where C is concentration and the constants a, b, and ¢ are determined by the
LSR. ' '

Sample data is reduced by a process identical to the standards. Quantification for
concentration C is by entering the Sl from the sample measurement into the
calibration equation.

4.3.3 Nuances

The following features simplify operation and aid in producing quality analytical results.
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Calibration: Up to seven calibration points may be established in each range of
the KPA. The linear fit with zero intercept should be used when analyses will be
performed near the detection limit of the KPA. At least five calibration
concentrations should be used to describe a quadratic (curved) fit.

Each range (High or Low) is entirely independent of the other range, although
both are handled in identical manner. Low Range is highly linear, while High
Range is also linear, but may be curved near the upper end. When calibrating
both ranges, choose calibration concentrations to provide overlap between the
ranges.

Maximum count rate: The electronics provide linear response with intensity up to
about 40 megaHertz. Measurements are protected from errors by excluding
higher count rates from the calculations.

At higher concentrations where intensities exceed the limit, the first time gate for
LSR is shifted out in time to where the intensities fall within the limits of the
electronics. This is usually referred to as "gate shifting". Gate shifting
automatically increases the delay time and extends the analytical range, while
keeping the data within electronic linearity. The longer time extrapolation reduces
accuracy and is only approximate for delays longer than twice the time window
(the time interval of intensities used in the LSR). No gate shifting should occur in
calibration, When calibrating the KPA, the concentration of the standard
solutions should be well within the linear interval for the particular range
selected. See Section 4.2, f and g. Gate shifting is detected because the time
gates indicated in the top line of the display header are not the usual 5-49.

Net Data Threshold: Since luminescence intensities decrease in time, they may
reach the noise level where they will be detrimental to the measurement by
skewing the LSR fit. Thresholds or minimum intensities have been established for
which sample net intensities must be greater in order to be included in LSR.
Minimum intensities that have been established are:

Low Range: Square root of number of laser pulses
High Range: Third root of number of laser pulses.

The minimum intensity threshold can be software adjusted with the minimum
intensity factor available in Settings > General Configuration > KPA Unit
Settings. When the minimum intensity threshold is exercised, the number of
intensities used in LSR is reduced. This normally only occurs near the detection
limit. The time gates used are indicated in the top line of the display header.

Non-Detectable Concentration: The first five time gates must have net intensities
above the threshold in order to obtain a positive result. Otherwise, the report will
have all zeroes for all calculated values.

Non-Linearities: Occasionally sample data may be curved for any of several
reasons, or the analyte concentration may be near the detection limit with
scattered data points. In such cases, the plot of net data should be inspected. For
this reason, the plot is automatically displayed when R?, the coefficient of linearity,
is less than 0.96.-
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5.0 OPERATION AND OVERVIEW
(See KPAWin User's Guide)
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6.0 DIAGNOSTICS FOR BEST RESULTS

6.1 Parameters For Analysis Diagnostics

A combination of data parameters are available from each measurement, which provide
diagnostic information about the validity of the result, hence, "Analysis Diagnostics." These
are listed below with qualifying statements concerning their interpretation. Remember, the
ideal set of data has a highly linear relationship between the logarithm of intensity and
delay time, with a nearly ideal lifetime. The following refer to uranium as an example.

6.1.1 R?

Values greater than 0.99 are typical. A small value is caused by a nonlinear plot and/or
scattered data, such as near the detection limit. Curvature is caused by other sample
phosphors, dirty cell windows, or suspended particles.

6.1.2 Lifetime

Lifetimes are temperature dependent, decreasing as temperature increases. See Section
2.4 for analyte-specific information,

Uranium lifetimes in samples are usually shorter than 350 ps. For uranium, be aware that
lifetimes less than 100 us occur when acidity exceeds two molar. At lower acidities,
URAPLEX™ typically provides lifetimes over 250 ps. URAPLEX™ improves the resistance
of uranyl phosphorescence to quenching. For best results, lifetime should be >200 ps.
Uranium-specific characteristics follow.

1. If the lifetime is short, <100 us and/or curved, with R? less than 0.96, consider diluting
the sample if the concentration is high enough. Check the lifetime with a standard addition,
especially if a nondetectable result is obtained. The luminescence may be completely
quenched. Otherwise, wet-ash the sample to destroy interfering organics. Eliminate many
reducing elements, halides, and excess acidity by boiling to dryness with nitric acid.

2. If the lifetime is long (>350-600 us)'and the decay plot is curved, particulates and/or
organic phosphors may be present or the cell is dirty. Centrifuging, cell cleaning, and/or
wet-ashing are in order.

3. If the result is near the analytical detection limit with a curved decay plot or short lifetime,
~dilution is barely an option. Take background measurements to verify that the cell is clean,
i.e., blank net count within perhaps 300 counts of zero. If the cell is contaminated or dirty,
clean and then repeat questionable sample measurements. Check lifetimes with standard
additions, e.g. 0.1 mL of uranium standard in the cell. ‘

For lanthanides, lifetimes will be close to the values in Section 2.4, unless a different

complexing medium is present, acidity is too high, or a spectral interference with a
substantially different lifetime is present.
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6.1.3 Uncertainty

The KPA is capable of excellent (1-3%) precision. Replicated results within the
uncertainty are easily obtained. An unusually large uncertainty indicates the
concentration is either near the detection limit or a measurement problem. Either data
is scattered, curved, or the concentration is out of the analytical range.

6.2 CONCENTRATION ISSUES

Occasionally, individual samples or a source of sample are analyzed and inaccurate
or no resuits are obtained. An alternative procedure of preparing the sample for
analysis can solve the problem and give you the analytical results needed.

6.2.1 Problems
Examples are:
Color (inner filter effect). Colored agent absorbs excitation or emission light.

Quenching agent. Substance that causes short or zero lifetimes. ‘Acidity may appear
to quench because the enhancing complex may be dissociated.

Fluorescent agent. Fluorescence from a contaminant may be strong enough to disrupt
the normal decay curve of the analyte This is indicated by curvature and a misplaced
intercept.

Particles. Suspended particles interfere by strongly reflecting the laser beam. The
reflected light will disrupt the normal decay curve of the analyte. This is indicated by
curvature and a misplaced intercept.

Major constituents. Concentrated solutions of dissolved minerals, metals, or other
substances may interfere by some of the above effects or by preventing complexation
of the analyte with the enhancing reagent.

Complexants: A chemical may interfere by complexing the analyte differently than the
chosen reagent. The effect will be noted by a different lifetime. Example: The EUEDTA
complex, pH=~4, has a lifetime near 311 us; the presence of citrate increases both
the lifetime and quantum efficiency of europium.

Static quencher. A substance that holds the analyte out of the photoluminescence
process causes static quenching and low results. An example is a complexant that
maintains uranium as U(IV). Photoluminescent uranium is the UO;"™ ion.

Precipitant. A precipitate with either the analyte or enhancing reagent will interfere by
loss and the particle effect. An example is phosphate when lanthanides are being
determined.

Following are some actions that may be taken to correct faulty determinations. They
are ordered by technical difficulty and labor required.
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6.2.2 Actions

1. Dilution. Dilution is effective when the analyte concentration is well above the
detection limit of the KPA. Substance(s) that detrimentally affect the KPA
measurement may be diluted to where their effect is negligible. Use a dilution as‘large
as practical.

2. Centrifugation. The interference due to the presence of suspended particles can be
eliminated by centrifuging the sample before analysis.

3. Determination by Method of Standard Addition. This method of determination
places a known amount of analyte in the sample matrix. The idea is that the sample
matrix will affect the added analyte similarly to the native sample analyte. This option
of quantitation is available in the program both in Automatic Analysis and in the
Special Analysis menu of the manual analysis version of the KPA program.

4, Evaporation to Dryness. Taking the sample to dryness with an oxidizing acid (e.g.,
nitric acid) has the beneficial effects of eliminating some quenching agents and
fluorescers. Particles/colloids may also be coagulated or eliminated. Substantial
amounts of organic materials as from plants will not be eliminated.

5. Wet-Ashing. Samples of uring, vegetation, and soil or water-bearing decayed
vegetation must be thoroughly wet-ashed to eliminate substances that may either
strongly fluoresce or, in the case of uranium, quench. Follow the procedure for urine
in section 7.0.

8. Chemical Separation. Analysis of bulk materials such as dissolved minerais, soil, or
metal will require chemical separation from trace levels of the analyte. This method
may be desired as an alternative to Actions 1-5 when the analyte concentration is
near the detection Ilimit. Likely separation types are ion exchange, ion
chromatography, and solvent-solvent extraction.

6.3 Analysis, Verification, And High Precision
6.3.1 Dilution And Cell Cleanliness

The usual aliquot for measurement is 1.0 mL combined with 1.5 mL of complexing
reagent. A ten-fold dilution may be easily obtained by adding 0.1 mL of sample to 1.0
mL of D.I. water in the cell. An additional 4% dilution of the 2.5 mL total volume is
incurred.

Always inspect the cell against a light to detect smudges or acid/water droplets on the
cell exterior and particulates on the inside. Water droplets may be touched off, but
acid droplets and smudges must be rinsed off. Particulates in the cell may settle out. If
they do not settle rapidly, it is best to centrifuge the sample before making the
determination.
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6.3.2 Verification

The application of good analytical practices is especially important for determinations
near the detection limit. Periodic sample and instrumental blanks, quality control
standards, and standard additions all have important roles in producing reliable
analytical results.

In kinetic phosphorimetry, the standard addition has a special use. Sometimes
interfering phosphors are present, and their presence must be identified. In other
words, the detected phosphorescence must be verified as being due to analyte. A 0.1
mL or less addition of analyte providing an increase in concentration approximately
equal to that indicated by the result, may be injected directly into the cell. The
resulting recovery is then easily evaluated. A comparison of the lifetimes between the
two measurements is important. If they are markedly different, then the sample resuit
may in part be subject to interference and the sample must be treated. The frequency
of such additions can be reduced at higher levels, where the analyte
phosphorescence overwhelms any signal from interferences.

6.3.3 Precision

Excellent precision of 1-3% RSD is common with the standard techniques described
already. However, by incorporating gravimetric measuring of aliquots, relative
standard deviations better than 1% may be possible at concentrations in midrange
and with lifetimes longer than 200 us. Samples digestions should be very slow to
avoid spattering. Muitiple analyses are necessary, of course, to establish the
precision.

6.3.4 Detection Limit Measurement
Prepare a solution in concentratibn near the KPA detection limit. Analyze it ten or
more times and calculate the standard deviation. This estimates the standard

deviation of the background, that is, the noise level. The detection [imit may be
defined as three times this standard deviation.
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7.0 SAMPLE PREPARATION:
URANIUM ASSAY OF URINE

7.1 Principle

Proper preparation of samples is of utmost importance to the analysis. Raw urine
cannot be analyzed without pretreatment except at levels well above 20 pg/L. A large
dilution, >1000,.is necessary to dilute away the matrix effects. The reasons for this
are; the organic -constituents fluoresce, may complex uranium, and along with
chloride, quench uranyl phosphorescence,

Sample treatment, i.e., wet-ashing, becomes increasingly important as the needed
detection limit is lowered. Residual unsaturated organics in a poorly ashed sample
may raise the detection limit by a factor of ~100. Aliquots of samples from the same
bottle may ash differently.

This procedure is written for urine analyses near the KPA detection limit of about 0.02

Hg/L. The requirements for ashing are less strmgent at hlgher levels. However, good
ashing technique is. still needed for good precision. :

7.2 Reagents
Deionized Water: Preferably over 10 megaohms.

URAPLEX™: A superior uranium complexant that provides longer phosphorescent
lifetime than others for better data, stronger complexmg, and lower background level
of uranium.

7.3 Equipment

Acid Dispenser - Such as 500 mL Repipet; set the dispensed volume to 1.5 mL. Glass
reservoirs should be acid-leached; plastic reservoirs should be immersed in boiling
water.

Liquid Scintillation Vials, 20 mL. For analyses below ~0.2 pg/L, vials must be leached

in either 1 M phosphoric or 4 M nitric acid at sub-boiling temperature for two or more
days to remove leachable uranium. Rinse well with deionized water.

Hot Plate , _
Heating Block, optional - Made from 40 - 45 mm (1.5 inch) thick aluminum with a
number of holes such as 50 holes to accept vials, 20 mm (0.75 inch) deep, 28 mm
(1.1 inch) diameter. Handles for carrying may be placed at each end.

Muffle Furnace.
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7.5 Alternative Ashing Procedure

1. Add weight or volume aliquot of sample (2-10 mL) to vial. NOTE: Samples with
solids must be homogenized (vigorously stirred), because uranium concentrates in
solids.

2. Add 2-3 mL 16 M nitric acid with swirling and 0.5 mL of 30% hydrogen peroxide.

3. Place vials on hot plate at moderate heai and NEAR boiling for several hours.
Hydrogen peroxide may be effectively added after partially cooling the samples.

4, Increase heat to boil dry. Replenish oxidants 1-2 times until the residue is pale
yellow to white. Cool samples somewhat before adding hydrogen peroxide.

5. When the vials are dry, place in muffle furnace at 500-550° C. for at least 1/2 hour.

NOTE: WET-ASHING MUST BE COMPLETE TO AVOID RESIDUAL ORGANICS.
FURNACE TREATMENT WILL NOT COMPENSATE FOR POOR WET-ASHING. '

The presence of carbon black after the furnace step indicates incomplete wet-ashing.
For samples less than 0.2 pg/L, the ashing should be restarted with a fresh aliquot.

6. When cool, dissolve the urine salts in 1/2 to 1 mL of 4 M nitric acid with warming.
Dilute to desired volume with deionized water. Swirt to mix. Final volume may be
determined by weight.

NOTE: For efficiency, steps 2-6 can be accomplished in a heating block.

7. For low level samples, it is beneficial to let solutions set overnight to fet micro-
particulates settle out. Centrifuging is an alternative. -

8. Analyze resulting solut:ons with the KPA. Av0|d plcklng up solids with the sample
aliquot. _

7.5 Alternative Ashing Procedure

Perchloric acid, 0.5 mL, may be used instead of the 30% hydrogen peroxide. Step 4
can be eliminated.

7.6 Uranium Assay Of Water

Most clean water samples can bé analyzed directly. Other water samples may just
require a simple acidification with nitric acid and boil down to dryness. If significant
organic matter such as decayed vegetation is present, a wet-ashing similar to urine
may be required. Because chloride and reducing metals quench strongly, some
waters cannot be analyzed without pretreatment.

OTHER APPLICATIONS - Contact CHEMCHEK INSTRUMENTS, Inc.
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8.0 SERVICE INSTRUCTIONS

8.1 Dye Module Alignment

The tuning of the laser system in the KPA needs to be performed only by trained
personnel. If the analytical sensitivity seems low, first make sure the dye cell is
correctly orientated. If the dye cell has correct orientation, then contact CHEMCHEK
with any questions.

8.2 Replacement of Nitrogen Laser Plasma Cartridge

This procedure should be followed when the laser power degrades to marginally
useful levels or otherwise fails.

EXERCISE CAUTION when removing the KPA cover: Residual high voltage can exist
inside! The bleeder resistor used on the high voltage circuits requires a short period
of time (about one minute) to drain any remaining voltage.

CAUTION: THE LASER PRODUCES INVISIBLE ULTRAVIOLET RADIATION. Make
sure the laser beam will not contact skin, highly reflective surfaces, or especially the
eyes!

This procedure is used when installing a plasma cartridge with black sides.
01.  Turn off the KPA and remove its cover.

02. Remove the 3 round headed laser hold-down screws from the top of the Iaser.
Disconnect the 3 connectors from the back end of the laser. Rotate
counterclockwise and remove the BNC connector for the laser trigger (marked
“TRIG" on the back of the laser). The second connector (marked "INT") is the
interlock; push down on the latch on top of this connector and remove the

- connector. The third connector (marked "12VDC") is for 12 volt power; pull it
from the back of the laser.

03. Remove the laser from the KPA, and place it on a flat surface.

04. Remove the 4 flat head phillips screws from the laser cover sides, and lift the
laser cover away.

05. Turn the laser over, and remove the 4 button head screws which hold the
plasma cartridge to the laser base. Use a 3/32 inch hex wrench to loosen the
button head screws.

06. Turn over the laser carefully while holding the plasma cartridge, so it will not
fall out of the laser. Lift up the front of the cartridge, and rotate it out of the
laser. As the cartridge comes out, remove the cables in the rear of the cartridge
by gently pulling them as the cartridge is removed.

07. Examine the connectors on the ends of the high voltage leads for evidence of
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08.

09.

10.

11.

12.

13.
14.

burning or arcing. If significantly burned, call CHEMCHEK for replacement
connectors.

Unwrap the replacement plasma cartridge, and install the high voltage cable
and trigger cable into the new plasma cartridge. Push both leads in firmly until
they seat in the plasma cartridge (about 35 millimeters into the cartridge). Make
sure that the leads are all the way into the plasma cartridge. Measure and mark
the length of the leads if necessary, to insure complete insertion into the
plasma cartridge. In some cases it may be necessary to apply silicone high
voltage grease to the leads, to help inserting them into the plasma cartridge.
Note that the high voltage cable and the trigger cable cannot be interchanged.
If the leads are interchanged, the plasma cartridge will not fit into the laser

properly.

Remove the protective caps from the lenses on the new plasma cartridge. After
removal of the caps, use caution not to damage the coated optics.

Turn the laser over, taking care not to scratch the optics on the plasma
cartridge. Install the 4 button head screws which secure the plasma cartridge to
the laser base. If the high voltage lead is slightly too long, preventing the holes
in the laser base from lining up with the holes in the plasma cartridge, then do
the following. Rotate the plasma cartridge until one of the button head screws
can be inserted. Install that screw, then rotate the cartridge and install the
remaining screws. It may be necessary to bend the high voltage lead slightly
per the diagram to aid in installation. Center the plasma cartridge in the laser,
then tighten the screws.

Install the cover on the laser, and replace the 4 flat head Phillips laser
cover screws.

Install the laser in the KPA, and secure with the three 6-32 x 2 1/2 inch screws
removed in step 2 above.

Install the 3 connectors on the back of the laser into their proper sockets.

Turn the KPA on, and check for proper operation of the laser.
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Figure 4. Plasma Cartridge Replacement, Laser Top View
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Figure 5.
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9.0 AUTOMATIC SYSTEM

9.1 Components of Automatic System

The components of the Automatic Kinetic Phosphorescence Analyzer System consists
of the KPA, a syringe pump, and a sample changer.

SYRINGE PUMP, Model 402 (Dilutor). The dilutor is equipped with a 5-ml syringe for
aspirating or dispensing solutions, and a valve that controls flow of either
reagent/diluent or sample.

SAMPLE CHANGER, Model 233. At the KPAWIN®© software's direction, the Model
223 selects each sample to be analyzed by the KPA. Selection is by means of xyz
movement of a needle probe. The Model 223 holds four racks, which are positioned
on the polypropylene tray, beginning with rack one at the left.

Samples are held in three Code 24 racks, each holding 14 sample vials (20 ml). The
fourth rack, Code 29, holds 60 culture or test tubes (12 x 75 mm). Vial positions in the
Code 24 rack start with #1 nearest the sample changer in the left row and proceed
through each row of seven for a total of 14 vials per rack.

The 60 tube rack, Code 29, must be placed at the right on the tray. Dilution and
mixing of sample aliquots with enhancing reagent takes place in this rack. The rack
has four rows of 15 tubes each. Each of the first three rows corresponds to one rack
of sample vials with the number one vial being mixed in the tube closest to the sample
changer, the number 14 tube is the last one used. The number 15 position in each
row and row number four are not used.

ALTERNATIVE RACK CONFIGURATION, by request. Alternatively the sample
changer can be configured with a non-standard rack and vial configuration. The
increases the capacity for samples to 108. There are three racks, each capable of
holding 44 sample vials (6.8 ml). The fourth rack holds 108 culture or test tubes (10 x
75 mm). This configuration, however, does reduce the amount of available sample for
repeat analysis.

FLOW CELL, and associated tubing. The flow cell has a sample chamber that is less
than 100 pL in volume. Tubing and cell are chosen to optimize analytical quality:
sample size, speed, detection limit, and low cross-contamination. Cross-
contamination from previous samples is less than 0.1%.

The dilutor and sample changer are controlled along with the KPA by the KPAWIN®
Software. More information about these two modules is in the Gilson manuals, which
are provided separately.

READ THE GILSON MANUALS FOR UNPACKING AND ASSEMBLY
INSTRUCTIONS FOR THE 402 DILUTOR AND THE 223 SAMPLE CHANGER.
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9.2 Electrical Connections and Set-up

For mechanical connections, please refer to the Gilson user guides.

Electrical connections are as follows. The GSIOC cable is a Y-cord with two female,
9-pin connectors and one male 9-pin connector that provides communication between
the sample changer and the dilutor. Standard 25-pin by 9-pin serial cables are used to
provide communications between the KPA and the computer and between the sample
changer and the computer. Additionally, newer computers do not have two serial port
connectors. For these types of computers, a USB Dual Serial Adapter is used.

GSIOC Cable: This is the Y-cable with one 9-pin connection (single end) at one end
and two 9-pin connections (double end) at the other end. Connect the single
connection to the back of the Sample Changer. Connect the one of the double end
connections to the back of the Dilutor.

USB Serial Adapter (Optional for computers with a USB port and less than 2
serial ports): Please refer to the installation guide provided with the product for
proper installation.

9-pin to 25-pin Serial Cable (KPA11A to Computer): Connect the 25-pin
connection to the back of the KPA. Connect the 9-pin connection to top serial port of
the USB serial adapter, or Com Port 1 on the computer.

9-pin to 25-pin Serial Cable (Sample Changer to Computer): Connect the 25-pin
connection to the back of the Sample Changer. Connect the 9-pin connection to
bottom serial port of the USB serial adapter, or Com Port 2 on the computer.

NOTE: The 402 Dilutor has 8 dip switches numbered from bottom to top. In normal

operation, switches 6, 7, and 8 are closed (positioned to the right when viewed from
the back of the pump) and switches 1, 2, 3, 4, and 5 are open (positioned to the left).
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Figure 6: Cable connections

USB Adapter to computer (USB Cable)
25pin to 9 pin Serial Cable

- Gilson GSIOC Cable

Computer

0

Dilutor Sample changer

USB Adapter

KPA11A
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9.3 Tubing Connections

Syringe Pump (Dilutor) = The dilutor draws diluted URAPLEX™ reagent from the
reservoir through the porous metal filter and tubing as described in the dilutor manual.
Solution transfer to the sample changer is through the 4 m length of 1-mm |.D. Teflon
tubing. This length has a volume exceeding 3 mL to minimize the chance that sample
might enter the difutor syringe. The tubing passes reagent and sample solution to the
sample changer probe. It also serves as a reservoir for aspirated solution to the
sample changer probe. The tubing should be arrayed to prevent entanglement with
the changer arm, eg., suspend it from the ceiling or fasten the excess coil down at a
suitable location.

Sample Changer to KPA — The sample changer injection port, is connected to the
stainless steel tubing in the KPA door by means of a short length of 1-mm |.D. Teflon
tubing. This tubing must be kept short for a minimum internal volume. Therefore, the
KPA should be positioned so its door is near the injection port of the sample changer.
Connection between the Teflon and steel tubing is by means of a short length of the
white C-flex tubing.

NOTE: The injection port contains a rubber and Teflon seal. If a leak should occur
during sample injection, first try tightening the nut. CAUTION! Over tightening will
hinder the probe entering the seal and overload the changer motor (it will sound
different so you will know if it is tightened too much).

Sample Cell — The flow cell is placed in the cell holder in the KPA door. Connections
to the 1/16 inch O.D. stainless steel tubes, which pass through the door, are with
elastic C-Flex tubing. The flow cell should be orientated with the writing on the cell
facing the reference cell. The c-flex from the input stainless steel tubing connects to
the cell tube leading to the u-shaped channel in the flow cell (the cell tube furthest
from the door). The outlet cell tube connects to the output stainless steel tubing.

Drain Connections — The output stainless steel tube is connected to the drain tubing
in the rinse station by means of 1-mm |.D. Teflon tubing. A short length of c-flex
tubing connects the Teflon and steel tubing. The first 5/16 inch O.D. drain tubing
connects to the rinse station and extends to a suitable receptacle. The second drain
tubing is connected to an overflow at the side of the sample tray and extended to the
same receptacle. This is in case of spillover.
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Figure 7. Tubing Diagram — Automatic Operation
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9.4 Automatic Operation Overview

Automation accomplishes these steps.

1.

2,

8.
9.

Zeroes the dilutor syringe (it should already be empty).

Draw 3.0 mL of enhancing reagent/diluent (URAPLEX™ for uranium) into dilutor
syringe.

Pick up (aspirate) 1 mL of sample from sample vial.

Dispense aliquot into the correéponding mixing tube.
Dispensé 1 mL of enhancing reagent into the tube.

Aspirate 1.9 mL of mixed solution and inject into KPA flow cell.
Stop-flow for KPA measuremen-t.l

Flush sample solution out and rinse the flow cell.

Flush out the rinse station, emptying the syringe.

Either 42 or 108 samples (depending on choice of rack configuration) can be
automatically analyzed per run. These may be any combination of samples,
standards, blanks, and standard-addition sample pairs. Results are stored, printed,
and accessed through Reports 2 Selection. The same automatic advantages are
available for Calibration measurements. '
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9.5 Automatic Sample Analysis

PLEASE NOTE: The 402Aqilutor must be turned on-prior to the 223 sample changer.
To analyze samples, follow the steps listed.

1.. Proceed to the Analysis input Form (Analyze 2> éar_nple Input).

2, Input all needed sample parameters to correspond with rack loading.

3. Load the racks to correspond to the Analysis Input Form. | |

4. Load the 4™ rack with new mixing tubes to correspond to the Ioadrng of the sample
vial racks.

5. Make sure there is enough enhancing reagent (URAPLEX™ for uranium). It takes
3.0 mL per sample and there should always be enough remaining to partially cover
the porous metal filter. This means more than 200 mi -in a small diameter
reservoir (for 42 samples) or perhaps 500 mL in a larger one (for 108 samples).
Running out of reagent will mean invalid results. In addition, the probe and flow
cell will need to be primed. Use the rinse function (7ools 2 Auto Changer >
Rinse) for priming.

8.. Click Analyze = Analyze All.

7. Results can be reviewed and/or printed out later through Reports - Selection.
See KPAWIN® User's Guide for details.

NOTE: During automatic analysis, the range will switch to:

HIGH - The result is > 120% of the highest Low Range calibration standard.
LOW —The result is < 80% of the lowest High Range calibration standard.

These values may be changed in the KPA Unit Settings tab.
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9.6 Interrupts

Aborting — Sometimes analytical operations are started with an error in‘samp>ling,
identification, loading of sample trays, etc, and you will wish to INTERRUPT the
operation. The stated method in all cases is to press the ESCape key.

Be sure to rinse the flow cell with the rinse function (7ools 2> Auto Changer > Rinse)
before starting to analyze other samples.

.Sample changer — Occasionally in a run, the sample changer may experience

"improper head movement” from encountering an obstruction or get out of step and
complain with a buzz. Quickly reset by keying ESCape. Then either turning it OFF,
then ON again, or use the reset function (Tools 2> Auto Changer > Reseét).
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9.7 Flow Cell and Syringe Pump Care

Flow Cell Care

The flow cell is a critical component of the automatic KPA system. One advantage is
that it is NOT routinely handled, so exterior contamination is seldom a problem. On
the other hand, the cell interior is of concern, because it cannot easily be cleaned.
The following are some useful guidelines.

Stand-By Mode

Never leave significant concentrations of analyté solution in the cell. Actually, the
sample changer does a partial flush after each KPA measurement. However, you
should always flush the cell by one of the following methods.

1. Finish with a blank.

2. Use a post rinse on the final sample.

3. Flush the cell with the rinse function (Tools - Auto Changer > Rinse).

NOTE: These three methods leave the cell and tubing filled with the reagent/diluent.

4, Place the tip of a squirt bottle in the injection port and force several mL of reagent
grade water through the flow cell. Water is preferred because the reagent/diluent
may either decompose or corrode tubes. This is the recommended method if the
instrument will be unused for periods longer than 2 weeks. Otherwise, one of the
first three methods should be adequate.

Solids

The presence of particulate material in the sample aliquots can be a serious matter.
Reason ONE is disruption of the spectrometric analysis. Reason TWO is that some
particles may accumulate within the flow cell where they may be difficult to remove.
The sample changer probe is programmed to not come closer than 3 mm to the vial
bottoms in order to avoid picking up solid material. In order to remove suspended
solids in your samples, you should: ‘

1. Settle them over time,
2. Centrifuge, or
3. Filter

Cleaning

A cell chamber dirty from grease or oil may cause air bubbles to adhere to walls or
cause direct spectral interference. Clean by flushing with 10% nitric acid followed by
water at the cell connections. Particulates may require agitation, forward or back
flushing, hot acids (fill the cell and place in a water bath), and/or ultrasonic treatment.
Any detergent used must not contain lanalin, oils, or insoluable matter.

CAUTION: If the flow cell is handled, it may need its windows cleaned before a low
background can be obtained. ’
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ORIENTATION

Flow cell orientation is important. Position the cell to maximize its length. The side
with the U-shaped channel (there should be writing at the top ex. QS 10.00mm)
should face the reference cell. ‘Do not confuse the inlet and outlet connections. The
inlet connection to the cell delivers solution to the bottom of the sample chamber via a
U-shaped channel and clears the cell from the top of the sample chamber. A cell that
is installed incorrectly will trap bubbles and will display extremely high and variable
backgrounds.

Syringe Pump Care
The Uraplex™ reagent is a concentrated salt solution. Rinse the valve of the syringe
pump with deionized water before prolonged storage of the device to avoid a salt

accumulation that will freeze the valve. An easy way to do this would be to perform
four or five rinses (Tools > Auto Changer - Rinse) with DI water.
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9.8 Conversion to Manual Operation and Analysis

To convert from automatic to manual operation and analysis please do the following.

1. Change the hardware configuration (Settings = General Configuration) by clicking

. on the Hardware Settings tab. Once there change from the automatic setting
(1000 Release for new KPAs using comports 1 and 2) to the manual setting (999
Eprom 3 Man for KPAs using comports 1 and 2) and press "current”.

2. Remove the flow cell with connecting tubes attached and wrap in lens tissue for
storage.

3. Use the low background phosphorescence cuvettes for manual operation of the
KPA as described in the "Operation Manual” for the KPA 11,
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KPAWIn® - Version 1.2.9 Installation Instructions

The following instructions install the KPAWIN® software, the associated Databases, and all Documentation on your
system. The software can be installed on an IBM Compatible Pentium class PC. Users can exercise the Demo Scripts to
familiarize themselves with the software on any PC. A connection to a KPA Unit is NOT required to exercise the Demo
Scripts. A connection to a KPA Unit is only required if a user desires to actually analyze Samples.

KPAWIN®© Software Installation

Insert the CD into any available CD drive. The Installation software will automatically begin.

InstaliShield Wizard %

Preparing to Install...

KPA Setup is prepating the InstallShield Wizard, which will

guide you through the program setup process Please
wait

Checking Operating System Version

Preparing to install. The installation program is verifying that the OS is sufficient, there is enough
disk space, and there are no previous versions installed.

¥ KPA - InstaliShield Wizard ity

Welcome to the InstaliShield Wizard for KPA

The InstaliShield(R) Wizard will install KPA on your computer,
To continue, dick Next,

® 1986-2009 Chemchek Instruments - All Rights Reserved

If everything is OK the installation program will stop at the Welcome Screen. Select Next to

1



continue.

¥ KPA - InstaliShield Wizard

License Agreement
Please read the following license agreement carefully.

KPAWin by Chemchek Instruments License Agreement -
© 1986-2009 Chemchek Instruments - All Rights Reserved
LICENSE AGREEMENT

IMPORTANT-READ CAREFULLY: This Chemchek End-User License

Agreement ("EULA") is a legal agreement between you (either an

individual or a single entity) and Chemchek Instruments for the

SOFTWARE identified above, which includes the User's Guide, any

associated SOFTWARE components, any media, any printed materials

aiher than tha TTssr's Cinids and any "an.line" nr slactennic i
®) 1 accept the terms in the license agreement

| € 1do not accept the terms in the license agreement

InstaliShield

4 KPA - InstaliShield Wizard

Destination Folder
Click Next to install to this folder, or click Change to install to a different folder.

g?ﬁ;:nt;es (B KPAWINY

s
€
¥
$”

| mstetshieid

Accept or change the database location. Normally, there is no reason to change this path or the

program location path.




1% KPA - InstaliShield Wizard

Ready to Install the Program
The wizard is ready to begin installation.

If you want to review or change any of your installation settings, dick Back, Click Cancel to
exit the wizard.

Current Settings: *
Setup Type:
Typical
Destination Folder:
C:¥Program Files (x86) \KPAWIN\

User Information:
Name: Rick Eaton
Company: Chemchek
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The installation program pauses to review the choices. Press Back to change anything or Install
to continue.

¥ KPA - InstaliShield Wizard

lnsta!hg KPA
The program features you selected are being installed.

@ maitydie the InstalShield Wizard installs KPA. This may take seyeral

Status:
Writing system regstry vaues

g e s o)
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The program installs.

After installation is successful, the KPAWIn®© software will start automatically.

A desktop icon is installed on your desktop to launch KPAWIN®.




Located in the KPAWin folder is a Database subfolder. The KPAEmpty database file is a template and should not be
used directly to store the data from the KPAWIn®© software. Make a copy of the KPAEmpty file in the KPAWin\Database
directory and give the copied file a name that is descriptive and follows your laboratory standards (e.g. C:\Programs\
KPAWin\Database\MyLab.mdb). This copy becomes the site-standard template. Any copy made must have .mdb as an
extension or KPAWIn® will not be able to use it. Be sure to leave an unaltered copy of the original KPAEmpty and of your
site standard template file in the directory.

If you use Windows Explorer to copy the database file between different directories, hold the Ctrl Key down as you drag
the KPAEmpty file to the Database directory. This will copy but not move the file to the new directory.

The Configuration Installation section that follows describes how the site-standard copy of KPAEmpty can be modified to
contain all local preferences for configuration settings. For example, DOSKPA can be simulated with KPAWIn®© by using
only four of the eight configuration tabs: General, Hardware, KPA Settings, and Calibration. The Alarms and Warnings
tab is disabled simply by not selecting any alarms items. The other three tabs for Performance Limits, Quality Control
Limits and Maintenance are deselected by pressing the "Do Not Use" radio button at the top of each of the three tabs.
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10.
1.
12,
13.

14,

- Installation Test
Initialize KPAWIN® from the icon on the Desktoo.
Select "Database” and “Open” from the command line.
Select C:\Programs\KPAWin\Database\KPADemo.
Select the “Login Menu" button on the left-end of the button ba}.
Select the user "Supervisor”. '
Enter the Supervisor password of “Supervisor”.
Select “Configuration Tabs" from the button bar (ﬁfth button from the left). The form will open.
Select the Hardware Settings tab. Step through the seven alternative conﬂgurations with the "List Text Box” in
the lower right of the form. The index of the release version is 1000 for a KPA-11A. All other six configurations
have the “Inactive Box" checked. Configurations are preloaded by KPA madel (KPA-11/KPA-10). KPA EPROMs

are (KPA-11 (3), KPA-10 Auto shutter (2}, or KPA-10 Manual shutter (1)). Autochanger (A) models and Manual
(M) models are also specified. Select the appropriate index. Select "Current” and "Apply”.

Index Model- EPROM Auto/Manual

994 KPA-10 1 Auto

995 KPA-10 2 Auto
- 996 KPA-11 3 Auto

997 KPA-10 1 Manual

908 KPA-10 2 Manual

999 KPA-11 3 -Manual :
1000 KPA-11 3 Auto (Release default)

No action Is required for an automatic KPA-11. For all other configurations, mark configuration 1000 aé inactive
and the correct configuration as active by dese[echng the “Inactive Box".

Select the KPA Unit Settmgs tab. No action is requnred fora KPA-11 since index 1000 is the release
configuration, For a KPA-10, deselect index 1000 and select index 999. Select “Current” and "OK"

Select "Analysis Input Form from the button bar (third button from the Ieft) The form should open "Close” the
form. :

Select "Sample Reports” from the button bar (fourth button from the Ieft) The form should open. “Close” the
form. . .

Select "Initialize KPA” from the button bar '(S|xth button from the left). Ali subsystems and functions of the KPA
and autochanger are tested. Communications are established and tested. Mamtenance status is evaluated

_agalnst release standards. (See Configuration Tabs below.)

Responses to any failures observed in this test are discussed below under Possible Start-up Problems.:
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Possible Startup Problems

General KPAWIn®@ Failure

Installatron is successful but one of the following three problems are found durlng testrng
1. “Error loading from file” while attempting to load and execute the KPAWIN®,

2, “An error occurred while loading or registering the file ‘C:\Windows\System\ComctI32.ocx" while attempting to
load and execute the KPAWIn

3. Devices on the button bar or the command line do not respond.

Oleaut32.dll should be loaded and registered when Windows is installed. If the file is missing, obsolete, or unregistered
with the operating system the Object Linking and Embedding functions and devices fail. The Regsvr32.exe and
Oleaut32.dll files, included on the Auxiliary File drskette of the release correct these problems. If your system responds
correctly, disregard the followrng operations.

1. From Explorer select “View” from the comrnand line and “Show all files” from “Options™.

2. Open C:\Winnf\System32 for Windows NT or C: Windows\System for Windows 98/35 and verify that
Oleaut32.dll is present. Verify that its version number is 2.20 or hrgher The verslon Is available from Properties
that can be accessed from the right button of your mouse. .

3.A If necessary, copy the current Oleaut32 from the Auxiliary File diskette to the system folder. Reset the “Options”
selection in the "View" menu to “Hide files of these types"
4, Register the Oleaut32 file with the Regsvr32.exe program that is also included on the Auxiliary File diskette.
a. Putin the Auxiliary File diskette,
b.. Sslect the "Start” button.
c. “Run.
d. [nthe "Open:” space, key in “A: \Regsvr32 Oleaut32.dll". (A space is requlred between Regsvr32 and
Oleaut32.dIl.

e. Selectthe "OK” button. .
f. The system should respond that the ﬂle was registered successfully
g. Then try to start (execute) the KPAWIn® program again. It should load succassfully.

Initialization Failure

Initializafion failure can result from hardware, software, or administrative feilure. Administrative failures are corrected
later during configuration. Disregard failure of Maintenance tests until the hardware and software systems are stable.

Hardware Failure

Installation of the KPAWIn® program in a previously operable system is not likely to create a hardware failure. The
results of the Initialization test specify the component that has failed and if the cause is due to communications. Check for
power and laser indicator lrghts laser cycling, low-range solenoid operation, and autochanger and syringe pump
operation.

Components that can cause the KPA to fail initialization include:

1. Power switch is off,
2. Power cable,

3. Communication cable to computer,




4,
5.
6
7

Interlocks,

Nitrogen laser,
Photomultipliers, and
EPROM.

Components that can cause the autochanger and syringe pump to fall Initialization include:

S o~

Power switch is off,

Power cables,

Communication cable to computer and included modem,

Y-cable between communication cable, autochanger (bottom center) and syringe pump,

DIP switch settings on Model 402 syringe pump (From the rear, #1 @ bottom and #8 switched to the right for 401
emulation mode and #1, #6, and #8 switched to the right for 402 emulation mode),

EPROM.

Components that can cause the computer to cause communication failure include:

oo LON A

In general, if initialization fails, check for the power indicator lights and cabling. Rerun the EPROMs by cycling the power

.Power switch is off,
.Power cable,

Serial COM ports improperly identified and cabled,

Serial COM ports not enabled in BIOS,

Modem with hard-wired serial COM port setting of 1 or 2,
Serial mouse with an automatic system.

switches on the KPA and the autochanger or by repeating the initialization test.

Software Failure

Software failure can result from missing, defective or unregistered system files, errors in KPAWIn® configuration
setlings, or a damaged database. Assignment of serial COM ports in the configuration is easily checked by changing
cables or settings on the tab. Damaged databases can be identified by the successful load of a database that is known to
be good. The computer identifies missing system files when the program attempts to call them.
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Configuration Settings

KPAWIn® has eight Configuration Tabs that can be accessed from the third button on the button bar or from the General
Configuration option under Settings on the command line. Refer to the KPAWIN® Configuration Documentation in the
Documentation folder for descriptions of the labels and dewces that are used on these tabs. These descriptions are also
avallable on line from Help on the command line.

Itis hlghly recommended that you create a site-standard template of the “KPAEmpty” database. Fol!ow the instructions
below to enter the configuration preferences in single or multiple copies of each tab. Name and save the site-standard
template. Working copies of the template should be made, named, and used to conduct laboratory operations. This
strategy eliminates the need to reconfigure the distribution database every time that you need a new lacal copy.See the
Configuration instruction section of this manual for detalils.

Basic KPA operation requires completion of four tabs: General Items, Hardware Settings, KPA Unit Settings, and
Calibration Settings. If basic KPA operation is desired, the “Do Not Use" radio button must be selected on three tabs:
Maintenance, Performance Limits, and Quality Controt Limits. In addition for basic KPA operation, do not select any flags
from the Alarms/Warnings configuration fab.

Advanced KPA operation utilizes the four basic tabs, selection of either the “Use Defaults” or the "Use Site Custom” radio
button on the Maintenance, Performance Limits, and/or the Quality Control Limits confi guratron tabs, and selection of
flags of your choice from the Alarms/Warnings configuration tab.

All configuration tabs are managed by common devices located at the right and at the bottom of each tab, Each
alternative copy of each configuration tab is unique and may qualify specific data in your database. Taken together,
these properties require that existing copies of any one configuration tab can not be deleted but additional copies can be
created. Obsolete copies can be hidden from the Sample input form by selecting Inactive in the box at the bottom of the
form when the index for the copy is listed in the List Text Box.

The buttons on the right of all configuration tabs operate consistently. "Help“ calls on-iine help. "Cancel” terminates a tab
edit session. “Select” provides a drop-down list of the names of all copies of the selected tab. You c¢an cursor to any label
in the list, highlight the selection, and select the entry. “Add” makes an editable copy of the displayed copy of the tab.
After your edit is complete you will be prompted to assign a unique index and label to the copy. “Current” sets the
displayed copy of the tab as the default for Sample Input. It Is essential that your preferences for the General ltems,
Hardware Settings, and Maintenance tabs be marked as “Current” because they cannot be changed on the Sample Input
form. "Apply" places a created, new copy of a tab into memory and returns to the Configuration Tabs form. “OK" places
any newly created copy of a tab into memory and exits the Configuration Tabs form.

General Items

The General ltems tab contains two frames: options for reporting immediately after analysis of a sample, and options for
login and passwords. Display of results in scientific notation is recommended. User IDs are recommended to permit

KPAWIn® to "remember” user preferences that are reloaded when the individual logs back onto the system.

' Hardware Settings

Hardware Settings are critical to the operation of the system. Select the preloaded copy of the tab according to the model
of your KPA, the EPROM version, and the presence or absence of an autochanger. The index of the release version is
1000 for a KPA-11A. All other six configurations have the Inactive Box checked. Configurations are preloaded by KPA
model (KPA-11/KPA-10). KPA EPROMs are (KPA-11 (3}, KPA-10 Auto shutter (2), or KPA-10 Manual shutter (1)).
Autochanger (A) models and Manual (M) models are also specified.

Index Model EPROM Auto/Manual
994 KPA-10 1 Auto

995 KPA-10 2 Auto

996 KPA-11 3 Auto

897 KPA-10 1 Manual
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998 KPA-10 2 Manual
999 KPA-11 3 Manual.
1000 KPA-11 3 Auto (Release default)

KPA Unit Settings

The KPA Unit Settings tab contains the parameters that control the KPA and qualify the raw intensity data that it
generates. Only the Pulses Per Analysis is likely to be changed in the Laser frame. The parameter has the greatest
impact on the signal to noise ratio of any KPA setting. As such, it dominates the detection limit with increasing pulses
providing lower analytical detection limits.

The Detection frame provides three parameters that are used in the interpretation of intensity data. PMT Dead Time (ns)
is used to correct the raw intensity counts in a data channel that was acquired at high photon flux levels. At low photon
acquisition rates, the logarithm of intensity Is directly proportional to the analyte concentration. As the photon flux
increases, the photomultiplier switches on and off to limit saturation of the detector. This behavior Is normal but creates
curvature in the logarithm of intensity versus concentration data at higher concentrations. The photomultiplier
manufacturer recommends the dead time correction factor. KPAWIn® applies the factor to the raw data to create
coincidence-corrected data. A dead time of 10 ns is used for all KPA-11 instruments. The dead time for KPA-10
instruments is photomultiplier specific but typically ranges from 120 to 140 ns.

The Maximum Intensity Factor/Pulse Is used to limit the influence of the coincidence error. During data analysis by
KPAWIn®, low-order time gates are ignored if the intensity per laser pulse exceeds the configuration tab setting. Gate
Shifting is the term that is used to describe this phenomenon. Settings for a KPA-10 are typically from 50 to 60. For a
KPA-11, values from 180 to 220 can be selected based on user preference.

The Minimum Intensity Factor Is used to disregard high-order time gates that contain an insignificant number of intensity
counts accumulated for all laser pulses in the analysis. The minimum acceptable value for this parameter is “1" to
preclude the program from taking logarithms of negative numbers. Gate Dropping is the term this is used to describe this
procedure. .

The Time Gates frame contains default specification. Total Time Gates is standard at 128. Time Gate Width (us)is 13 us
for uranium analysis and shorter for the lanthanides as described in the KPA instrument manual. The Start LSR Gate and
Nurnber of LSR Gates are preferred values that can be overridden by elther Gate Shifting for the Start Gate or Gate
Dropping for the Number of Gates prior to the Least Squares Regression of the intensity and decay time data. The
Minimum Number LSR Gates does not ipjerfere with the data interpretation or reporting. This minimum specifies a user
tolerance that is reported as an alarm or warning with the data.

The Range Selection frame specifies the parameters that are used to allow auto range selection during analysis and to
qualify sample data based on the relevance of calibration standard concentrations to sample concentrations. The Auto
Efficiency Factor is an estimate of the intensity intercept of a sample analyzed in the low range to the intercept of the
same sample analyzed in the high range. The factor is best evaluated in the middle of the crossover between the two
ranges since the number decreases with increasing sample concentration. The factor Is used to evaluate a precount test
of a sample that is analyzed in the high range. If the high-order time gates do not Gate Drop then the sample can be
analyzed in the high range. If the low-order time gate multiplied by the factor does not Gate Shift, then the sample can be
analyzed in the low range. If both ranges are qualified, the range of the most recently analyzed sample is used.

The High Intercept Tolerance and the Low Intercept Tolerance compare concentrations of standards at the extremes of
the calibration to the concentrations of analytical samples. {f the concentration of a sample exceeds the concentration of
the most concentrated standard in the range by the factor of the High Intercept Tolerance, the data results are alarmed.
If the concentration of a high-range sample is less than the least concentrated standard for the high range by the factor of
the Low Intercept Tolerance, the data results are alarmed.

Calibration Settings

The Calibration Settings specifies calibration, units, and intensity vector arithmetic preferences. The default database

units of pg/l can be changed to an alternative user global default for data entry and reporting. The units can subsequently

be changed at the time of sample input on a sample-by-sample basis. Specific gravity, specific acfivity and atomic mass
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specifications on this tab provide a global capability to use per mass units, radiometric units, and molar units. These can
alsoc be changed on a sample-by-sample basis at the time of sample input,

Calibration range can be Auto, High, Low, or Both. If calibrations are performed in the high and low ranges during sample
analysis, the global default selected on this tab can be changed on a sample-by-sample basis at the time of sample input.
Auto uses precounts to qualify analysis in the high and/or low range with the High Intercept Tolerance and Low Intercept
Tolerance used only for reporting flagged alarms. The High, Low, and Both options use these tolerances to “switch” to
another calibrated range if an analysls fails to meet a tolerance. These three manual calibration options also flag alarms
when a tolerance test fails.

Dilution data can be entered as Total Volume or Add Volume. These apply to both dilution at the time of sample
preparation and aliquot dilution at the time of analysis. In both cases, the initial volume is the actual initial volume. For
Total Volume, the final volume is the total volume of the dilution. For Add Volume, the final volume Is the volume that is
added to the initial volume to make the final dilution. .

Four corrections are made to the intensity data by time gate before the data are regressed to provide an intensity
intercept: colncidence correction, data smoothing, reference correction, and background subtraction. Coincidence
correction is a required vector arithmetic operation since it accounts for the non-linearity of the photomultiplier output with
concentration. Any of the other three can be removed from the intensity vector interpretation at the discretion of the
operator. See the KPA operator's manual for a description of these corrections.

Select the form of the calibration for the high and low range based on the order of the equation, allowance for non-zero
intercept, and the minimum number of calibration standards..

The above configuration provides an installation that is equivalent to the DOS software for the KPA. The remaining four
configuration tabs can be included in your configuration to provide control and quality reporting capabilities.
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KPAWin© Demo Analyst/Operator Script

This script familiarizes a new KPAWIn® user possessing Standard privileges with some of the functions and
features of the KPAWIN® software. A KPA unit is not required to complete the actions in this script. The
script provides the necessary steps to exercise most functions required by a standard User (Analyst/Operator)
running the KPAWIN® software. To start the KPAWIN® software use either the Windows Start bution or double
click on the desktop shortcut (if created). KPAWIn® begins to initialize and stops at the Legin Sequence.

Note: KPAWIN® Options that are displayed in “Black” are Available to the user while those that are displayed in
Light Grey, “Grayed Out” are NOT Available.

l. Administration Demonstration

Database Operations

1.
2,

Use the Database Dropdown menu to attach and open the KPADemo Database.

At the Top of the KPAWIn® display, all dropdown menu's are listed. These include File,
Security, Database, Reports, Analyze, Settings, Tools, Window, and Help. Click on
“Database” and then select (highlight) and click the “Open” item.

The "Looking for KPA Database File” menu is displayed. Select (highlight) the KPADemo file
and click the “Open” button. The Demo database contains information to demonstrate the
software features and functions. It is only used for demonstration purposes.

Login Procedures

1.
2.

Click the first Toolbar (Login) button.

There are four UserlDs registered in the Demo Database (Analyst, MXF, Supervisor, & WRM).
No Password is required for the Demo User ID “Analyst”. The default UserID is Analyst. Click
the OK button to complete the Login sequence.

Help Demo

1.

Click the “Help” dropdown menu and then click the “Contents” item. This displays the
KPAWIN®© Help Table of Contents listing all sections with Online Help information available.
Click on any item of interest and browse as completely as desired.

With the Help menu displayed, click on the “Index” Toolbar button to display the list of available
topics sorted alphabetically for perusal. Select one or more items and click the “Display”
button at the bottom of the menu. Close the Help display when finished.

KPAWIN® utilizes "Context Sensitive Help” on all displays. Context sensitive help provides
immediate help with a screen element of interest (menu command, dialog box, ete.). The
program takes you directly to the help information you seek without the need to traverse the
help indexing system. .

To get context sensitive help on a display Label or Input Text item, select the label or text box
in question with the mouse pointer and then press F1 while the box is active. This action
displays the Help information for that item.

To get context sensitive help on a specific Menu Command place the mouse pointer over the
command button {DO NOT click the command button as the command will be executed) and
press F1.
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MainDisplays (Toolbar/Misc. Dropdown Menu’s)

Toolbar Buttons ‘

The KPAWIn© main Toolbar contains several functions used extensively throughout the analysis process.
Prior to Logging onto the'KPAWIN® software, only the Login, Stop/Exit, and Help buttons are available.
Once a user has successiully Logged in, Logout, Stop/Exit, Analyze, Reports, Configuration, Initialization,
Tickler, and Help buttons are on display. When the mouse pointer is placed over a button, text indicating
the function of that button appears for approximately 5 seconds.

Logout Logs the current user out but KPAWIn® continues to run.
Exit Exits KPAWIN® and returns to the operating system.
Analysis Input - Displays the Input Analysis display..

Sample Reports Displays the Sample Selection display.

Calibration Tabs Displays the Calibration Tabs display.

Initialize KPA - Displays and Executes the Initialization process.

Tickler Menu Displays the Maintenance Configuration Tab.

Help Information Displays the Help Contents,

Dropdown Menu's

Several of the items on the Dropdown menus are demonstrated earlier in this script. They are not
addressed again.

File -
Open - Enabled only when the Sample Input screen is on Display,'Retrieves Sample Input
information previously saved template.

SaveAs - Saves the Sample Input information (template data) to a filename of your choice.
Exit - Exits the KPAWIN® software

Database
Open/Repair/Pack are all database functions designed to manipulate the KPAWINn® database.

Archive removes data from the current database and stores It on other media (e.g., another Hard
drive, Tape, CDROM, Floppy disks).

Administration Functlons are discussed later.
Reports :
Selection - Displays the Sample Selection Report form. These functions are demonstrated later
in the script.

Trend - Displays the Trend report.

' Analyze is discuséed in the section on Sample Input.

Settings displays the Configuration Tabs and is discussed in the Configuration section.

Jools
Auto Changer has two submenu items, Reset and Rinse. Use Reset and Rinse only with an
Autochanger

Diagnostics has a Prgbe KPA Unit submenu, It attempts to communicate with the KPA
hardware and KPAWIn® database. If not successful, an Error message is displayed indicating
the probable cause and offering an opportunity to retry the operation. Click the “Ignore” button if
a KPA unit is not connected to your PC.

Calculator invokes the system calculator function.
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Sample Input Display

Click on either the Analyze dropdown menu followed by clicking the Sample Input item or use the
Toolbar button Analysis Input Form (Third toolbar button from the Left). This displays and loads all
Entered and Processed but Unaccepted Samples from the database. The Demo Database has a total
of 36 Processed Samples with at least one example of all 19 Sample types. The Demo script allows the
user o create more Sample Input entries. Note the display is divided into two sections, an upper portion
with Labels and Input Text areas and a lower Grid display portion. Data may be entered in either section.

Loading Sample Data from Database

1.

Click on.the far left Grid Column labeled “Analysis” and highlight Analysis # 1 (SamplelD =
1002, Sample Type =BckGnd.) Note that several labels in the upper portion of the display
have changed color. Red indicates the item is Required to be filled in. Blue indicates an
Optional item. Black indicates the data is taken from a Basis Sample and Grayed Qut
items are Not Available and therefore not applicable to this sample type. Each sample type
requires a unique set of Required, Optional, Basis, and Not Applicable Sample Input items.
The color code guides your input. All Required items must be entered before attempting to
enter or change another Sample. The software displays an Error message describing any
missing information.

Now click Analysis # 9 (SamplelD = 1010, Sample Type = IChkStd) and again notice the
color code changes to a number of fields in the upper portion of the display. The fields
Standard ID and Standard Concentration are now colored Red while Calibration Config and
Concentration Units are Grayed Out.

-Change the “Standard ID” from S-1 to §-2 in either the upper portion of the display or on the

Grid (Data may be entered in either section.)

To collapse any of the fields in the grid section of the form, place your mouse pointer on the
Label Text in the upper portion of the display and double click, Try the Concentration Units
field in the by double clicking on the label "Concentration Units”. The Sample Units field in
the grid completely collapses. To expand the field again double click the Label again and the
Grid Header expands. All collapsed Grid flelds are saved for each user in the operating
systems Register file. Each time the user logs onto KPAWIn®, all saved display preferences
are reinstated. These preferences remain until the user changes them. Each user
customizes these fields to their own preference.

Sample Input Toolbar

Saving / Restoring Sample Eatries

1.

Users enter Sample data into the Sample input form and Save it toa System file before
analyzing the samples. This is very useful if a Laboratory runs the same or similar set of
samples on a reoccurring basis.

Enter the set of Sample data in the Sample Input form and Highlight the samples to be saved
in the database.

Click the “Save As Initial Samples” Toolbar button (the picture of a floppy disk) and the
Save menu is displayed. Key in the name for the selected Sample Input Data and click
“Save” to save selected Samples. Click the “SaveAll” button to save all Samples on the
Input Screen.

Click the “Open” Toolbar Button (the picture of an open file folder) and the “Select Sample

to Load” menu is displayed. Highlight the Sample name and click the #Load” button.
These Samples are loaded into the Grid from the database.
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Adding a New Sample

1.

Click the “Add New Sample” Toolbar button (picture of plus sign "+”). Either the Highlighted
Sample or if nothing is highlighted, the last Sample in the Grid is duplicated. However the
Sample ID is concatenated with a number or the last number in the ID is Incremented. The
same rules apply to the Sample Description.

The user can change any of the displayed data items that are NOT Grayed out.

Users can also add a selected Sample using the “Insert Before” or “Insert After” feature.
Highlight any sample by clicking the number in the Analysis Column to select the sample
and then click the “Right Mouse" button to display the “Input Pop-Up Menu”. Select either
the “Insert Before” or “Insert After” command and the highlighted sample is duplicated and
placed in the desired order.

The “input Pop-Up Menu” contains a considerable number of easy to use commands that
you can exercise as desired. Some of these commands such as Clear, Delete, and Analyze
are also executed by using the buttons on the Input Toolbar.

Several commands such as “Accept”, “Reject”, “Reprocess”, “Calibrate”, “Insert
Before”, “Insert After”, and “Move" are only executed by using the Pop-Up menu.

Calibration Display

1.

Placing the cursor over the first column "Analysis, right click and the Pop-Up menu will
appear. Highlight the the “Calibrate” command and Left click. This will force a calibration
using the processed samples on the Sample Input Form and displays all the calibration data
(both range data is displayed if there is data for both ranges).

Users may elect to disable the automatic calibration process by Checking the “User Cal”

checkbox In either range. When checked, the user provides a name for the calibration and
selects or deselects any specific calibration samples by “Double Clicking” on the specific
sample. The “+"sign disappears when the sample is deselected and reappears if selected
again. , This method allows the user to select specific samples to be used in the calibration.

After selecting the samples ydu desire to be included in the calibration, click the Calibrate
command buiton located on the right of the display to re-calibrate.

Plots are also available for display by clicking the “Plot” command button.
Printing the Callbration details or Plots {s accomplished using the “Print” command button.

The “Stop” Toolbar button exits the Input dispiay and returns to the previous display.
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Displays and Reports

Click on the dropdown Reports, then the Selection item or click on the Sample Reports Toolbar button
fo display the Sample Report Selection form. This display is divided into two sections. The upper
portion contains all the selection options while the lower portion lists the available samples from the
database after the “Retrieve” button is clicked. All user selected items are color-coded Blue and the
KPAWIN® defaults are selected when the form is Initially displayed. The display design allows users a
variety of options in selecting Samples from the database (e.g., selection by Sample ID, Sample Type,
Analyst, Customer, Procedure, or Date Processed, etc.) as well as the type of display used to report
that selection (e.g., Single or Multiple Sample Display reports, Single or Multiple Print reports, etc.)
This script only uses a few of the available selection criterla. However you can employ as many as you
desire.

Selectlng the Fields options that will be displayed in the lower portion of the report MUST be completed
prior to Retrieving the actual Sample from the database.

1. Operator/Analysts cannot change the fields that have been selected by a Supervisor, If you desire
different fields in this display, contact a user with Supervisor privileges.

Selecting Samples from the database is accomplished by using the various selection options on the top
portion of the display. .

1. In the “Sample Type” frame, use the dropdown display to select the “CalStd” sample type. Notice
that the Radio (round) Button in the frame changes from ALL to AND. Now click the Retrieve button
to load the data from the database. All the CalStd type samples meeting the other selection criteria
are extracted from the database and displayed according to your selection order in the lower portion
of the screen. You can try other selection criteria at your discretion.

On Screen Display Options - Single Sample Displays

1. In the “Sample Type” selection frame, click the “All” button and then the “Retrieve” button again.
This displays ALL of the samples in the database.

2. To view one of the Samples, highlight the desired sample by clicking in the First column, in the Demo
Database example the first column is labeled “Sample ID”.

3. Using the scroll bar on the fight of the display, scroll to the Sample ID “1027” and highlight this
sample. Using the KPAWIN® default display options Display Reports and Single Display, click the
“Display Reports” command button. This displays the results of the sample. Click the lower “Stop
Sign” toolbar button or the X in the upper right hand corner of the display when finished viewing the
report. (Note: there are two sets of window buttons in the upper right hand corner of the
display, the lower set is for the Single Sample report you are viewing while the top set
controls the KPAWin program. Clicking the X In the lower set will close the Single Sample
Report while clicking the X in the upper set will close the KPAWIN®© program)

4. Now highlight another sample, then click the “Display” command to view these resdlts This
displays the single sample display for the selected sample. Both the Sample Intensities and Plots
are also available from this display.

5. To view the Sample Plots, click the first button on the Sample Display Toolbar (lower toolbar - picture
of a graph). A frame is displayed depicting the Plot options with the default of “Net Data” (change
the display selection to any option desired); then click the Display Plots button. When through
viewing the Plots, click the “X" In the extreme upper right corner of the Plot display and then the
Cancel command on the Plot frame.

6. To view the Sample Intensities, click the second button on the Sample Display Toolbar (lower

toolbar - picture of a report). A frame is displayed depicting the Intensity options with the default of
“Net Sample Data"” (change the display selection to any option desired); then click the Display
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Intensities button. When through viewing the Intensities, click the “X" in the extreme upper right .
corner of the Intensity display and then the Cancel command on the Intensity frame.

7. Resize the Single Sample display, if required, and click the “Stop” Toolbar button to return to the
Select Sample display when through viewing the report.

On Screen Display Options - Multiple Sample Displays

1. To select Sample for the Multl Display, select all the samples on display by highlighting the first one,
then the last sample while holding down the Shift key. Now click the “Muiti Display" radio (round)
button, {note that all the Multi Display options are now enabled), select the “Sample Analysis”
option, and click the “Display” command. This displays the Multi Sample Analysis report
contalning one line of data for each sample. Use the Scroll Bar at the bottom of the report to view all
the data. When through viewing the report, click the “X" in the extreme upper right comer of the
Multiple Sample Analysis Report (Located approximately Mid Screen on the right edge) to return to
the previous display.

2. Using all the above selection criteria, click another report radio button (e.g., “Quality Control”) and
click the “Display” command to view other muitiple sample displays.

Print Report Options -_Single Sample Reports

1. In the"'Print Report Option” frame, click the “Single Sample” radio button. All the MultiReport
checkboxes are disabled. The Calibration and Configuration selections remain active. The Detalils
option is also available when printing Single Sample reports.

2. Highlighting one sample at a time, select various sample types (e.g., BckGnd, Sample, MtdStd,
SASamp, SampSpk, etc.). Then click the “Print” command button. Although all Single Sample Print
Reports have many items in common, each sample type produces a slightly different report. .

3. Check as many report types as desired to become familiar with the various reports.

Print Report Options - Multiple Sample Reports

1. Inthe “Report Optlons” frame, click the “Print Reports® radio (round) button. This changes the
Monitor Display Options to Print Report Options. Click the MultiReport Option, if not already
selected, and there are four enabled checkbox reports and fwo disabled items. The disabled items
(Calibration and Configuration) are available when one of the MultiReport opfions is selected.

2. Select two or more of the samples on display by highlighting them. Then check one of the report
options, use *Analytical Results” and the two additional checkboxes are available. If checked,
_these additional checkboxes produce additional Calibration or Configuration reports. Detailed
reports are obtained by checking the “Detalls” checkbox to the right of the Calibration and
Configuration report options.

3. Check as many report options as desired to become familiar with the various rep'orts.

This concludes the familiarization script. If additional users wish to exercise this script, the original KPADemo
should be reloaded to remove any changes made while performing the various exercises in the script.
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"KPA Sample Types"

Summary Description

The KPAWIn® software recognizes 19 unique sample types. Collectively they provide the analyst with a system to
accumulate and evaluate interactively all of the luminescence-specific and general-laboratory evaluations associated with
sample analysis and analytical performance. Sample Input is designed o guide the analyst by identifying the minimum
input data set for each unique sample type. Required data fields are labeled in red and on-screen warnings are displayed
when critical information is nol provided. The display and reporting for each Sample Type is designed to minimize
secondary data handling by the analyst. : '

BackGround - "BckGnd"”

“BekGnd” is the designator for the background sample. Raw intensity vectors are corrected for ¢coincidence and
smoothed. The smoothed background intensity vector is used to correct the intensity vectors of most sample types for
background contributions. Only Standard Addition Samples and Standard Addition Spikes, Confidence Tests, and
Quench-Corrected Sample vectors are not corrected for background if the background correction is set to true. Ifit is set
to false then no samples are background corrected. The intensity intercept for the reference that is recorded during the
analysis of the background sample is defined as the “Reference Mark” (Ry). For alf succeeding samples in the analytical
batch of the background, a reference ratio is computed from the intercept intensity of the reference (Ry) and Ry as the
ratio R/ Ry. Unless the option “Reference Corrected Data" is deselected on the Calibration Configuration Tab,
accumulated intensity In the smoothed intensity vector of the sample is corrected for reference drift by division by the
reference ratio.

Calibration Standard - "CalStd "

“CalStd” is the designator for a calibration standard. Data are entered by the analyst and reported by KPAWIn® to
indicate the laboratory control Identifier for specific standards as well as their concentrations and the volumes in ml or
masses in g. Concentrations are based on the laboratory's preference indicated in the Calibration Configuration Tab
which can be amended in the Sample Input grid. The definition of amount on a /volume or /mass basis is consistent with
the selected concentration units.

Continuing Check Blank- "CChkBIk"
“CChkBIK" is a deioniied water or analyte-free laboratory blank and is the designator for the continuing check blank. The

blank is used to verify the calibration subsequent to the initial verification. The acceptable performance of the blank is
specified in the Quality Controt Limits Configuration Tab as a multiple of the instrument detection limit (IDL).

Continuing Check Standard - "CChkStd "
“CChkStd is an analyte standard in deionized water or analyte-free laboratory sample and is the desiénalor for the
continuing check standard. The standard is used to verify the calibration subsequent to the Initlal verification and should

be prepared from a traceable standard independent of the calibration standards. The acceptable performance of the
blank is specified in the Quality Control Limits Configuration Tab as a standard recovery error.

Confidence Tests - "ConfTst"

“ConfTst” is the designator for a confidence test. The test provides the coefficient of variation of a series of analyses on
the same sample under identical analytical conditions. These results demonstrate the stability of the analytical system.

Initial Check Blank - "IChkBIk"

“IChkBIK" is a delonized water or analyle-free Iabbratory blank and Is the designator for the initial check blank. The blank
is used to verify the calibration immediately following the calibration. The acceptable performance of the blank is
specified in the Quality Control Limits Configuration Tab as a multiple of the instrument detection fimit (IDL).

Initial Check Standard - "IChkStd"
“IChkStd is an analyte standard in deionized water or analyte-free laboratory sample and is the designator for the initial
check standard. The standard is used to verify the calibration immediately following the calibration and should be

prepared from a traceable standard independent of the calibration standards. The acceptable performance of the blank is
specified in the Quality Control Limits Configuration Tab as a standard recovery error.
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Instrument Detection Limit - "IDL" ‘

“IDL" is the designator for the instrument detection limit sample that consists of an analyte standard in deionized water or
an analyte-free laboratory blank. The Instrument Detection Limit is an estimate of the minimum sample concentration that
can be detected with a 99% confidence. The calculation is based on a Student’s t-test with all input parameters selected
in the detection limit frame of the Quality Control Limits Configuration Tab. The parameters include number of standards,
detection limit type, maximum duration in weeks, maximum concentration factor, and limit in ug/l.. Detection limit type is a
KPAWIn® term to distinguish between detection limits based on the standard deviation of a series of individual analyses
{Type 1) and the average of a series of standard deviations of a series of analyses made in triplicate (Type 2).

In operation, an IDL is analyzed according to a frequency established by laboratory protocol. KPAWIN® pools all IDL
results and estimates the detection limit for every day of KPA cperation based on the measurements made within the
previous number of weeks specified in the maximum duration specification. This detection limit is reported with the data
recorded for the day of operation and is used to evaluate the performance of IChkBIk and CChkBIk samples. Errors are
reported if the number of standards (or standard deviations for Type 2 daily standards) is insufficient, if the true average
concentration of the standards {makeup concentrations) is greater than'the specified multiple of the detection limit, or if
the value of the detection limit exceeds the user-defined limit. .

Method Detection Limit - "MDL"

“MDL" is the designator for the method detection limit sample consisting of an analyte standard in deionized water or an
analyte-free laboratory blank processed by the procedure employed for samples. The Method Detection Limit is an
estimate of the minimum sample concentration that can be detecled with a 99% confidence. The calculation is based on
a Student's t-test with all input parameters selected in the detection limit frame of the Quality Control Limits Configuration
Tab. The parameters include number of standards, detection limit type, maximum duration in weeks, maximum
concentration factor, and limit in pg/l. Detection limit type is a KPAWIN® term to distinguish between detection limits
based on the standard deviation of a series of individual analyses (Type 1) and the average of a series of standard

" deviations of a series of analyses made in triplicate (Type 2).

In operation, an MDL s analyzed accordlng to a frequency established by laboratory protocol. KPAWIR® pools all MDL
results and estimates the detection limit for every day of KPA operation based on the measurements made within the
previous number of weeks specified in the maximum duration specification. This detectlon limit is reported with the data
recorded for the day of operation and is used to evaluate the performance of the current MtdBlk sample. Errors are
reported if the number of standards (or standard deviations for Type 2 daily standards) is insufficient, if the true average
concentration of the standards (makeup concentrations) is greater than the specified multiple of the detection limit, or if
the value of the detection limit exceeds the user-defined limit.

Sample Duplicate - "SampDup"”

"SampDup" is the designator of a duplicate sample. The sample is prepared for analysls and analyzed precisely
analogous fo the basis sample. Acceptable performance is specified in the Sample Control frame of the Quality Control
Configuration tab as the relative percent deviation (%RPD)

Sample Spike - "SampSpk"

"SampSpk" is the designator of a spiked sample. The sample is prepared for analysis and analyzed precisely analogous
to the basis sample. The volume of the spike addition replaces a portion of the deionized water used to prepare the final
analytical sample. Acceptable performance s specnf ed in the Sample Control frame of the Quality Control Configuration
tab as the spike recovery

Quenched Sample - "QchSamp”

“QchSamp" is the designator of a quenched sample. The sample is an aliquot of the basis sample that was prepared for
analysis and diluted and analyzed precisely analogous to the basis sample. A volume of quenchant, typically 0.1 ml of
methanol, replaces a portion of the deionized water used to prepare the final analytical sample. The methanol provides a
non-spectroscopic, thermal pathway for relaxation of the excited uranium complex and the resulting intensity vector
reports the non-uranium component present in the basis sample. The smoothed intensity vector of the quenched sample
replaces the smoothed background vector in the estimate of the net intensity vector. A user-request for a report of the
basis sample alone provides the standard report with sample intensities corrected for the batch background,
Alternatively, a user-request for a quenched sample report provides a report with sample mtensitles corrected for the

quenched intensities.
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Sample - "Sample"

"Sample” is the designator of a matrix sample. The Sample Id of this unknown can be the Basis Id for other sample types
that are evaluated and reported with this sample by KPAWIn®. The sample types linked with this sample type are
SampDup, SampSpk, QchSamp, SerDil, and MtdSA.

Method Blank - "MtdBIk"

“MtdBIK” is the designator for the method blank that consists of deionized water or analyte-free laboratory matrix that has
been processed by the procedure employed for samples. The acceptable performance of the blank is specified in the
Method Control frame of the Quality Control Limits Configuration Tab. Itis expressed as a multiple of the method
detection limit (MDL), the percentage of the contract reporting detection limit (CRDL), the percentage of the sample
concentration, or the largest of the aforementioned three conditions.

Method Standard Addition - "MtdSA"

“MtdSA” is the designator of analyte-spiked samples quantitating the analyte concentration in the basis sample and the
interferences to that quantitation. Spiked samples are prepared for analysis and analyzed precisely analogous to the
basis sample. The volume of the spike addition replaces a portion of the deionized water used to prepare the final
analytical sample. The parameters that control the interpretation of MtdSA data are contained in the Sample Control
frame of the Quality Control Limits Configuration Tab under the Method of Standard Additions. These parameters are
Number of Spikes, Recovery Emor (%), Slope Error (%), and R? (correlation coefficient). The value for Number of Spikes
can be either one (1) or three (3).

A single MtdSA sample provides quantitation and Recovery Error (%) from the external batch calibration. Triplicate
MtdSA samples with the basis sample provides an internal calibration by a linear least-squares regression of the spike
concentrations versus the increment of the intensity intercept that is attributed to the spike (Intercept of a spiked sample
minus intercept of the basis sample). The negative value of the concentration intercept is the reported concentration of
the analysis. R? is the correlation coefficient of the internal calibration least-squares regression. Recovery Error (%) is
the difference between the analyte concentrations for the basis sample for the internal-MtdSA calibration and the external
calibration divided by the result from the internal calibration when expressed as a percent. Slope Error (%) is the
difference between slopes for the internal-MtdSA calibration and the external calibration divided by the slope from the
internal calibration when expressed as a percent. : ’

Method Standard - "MtdStd"

"MtdStd" is the designator.for the method standard that consist of an analyte standard in deionized water or analyte-free
laboratory sample that has been processed by the procedure employed for samples. The acceptable performance of
the blank is specified in the Method Control frame of the Quality Control Limits Configuration Tab as a standard
recovery error.

Standard Addition Sample - "SASamp”

“*SASamp" is the designator for the sample analyzed by standard addition. Standard addition quantiates the analyte in a
basis sample by internal calibration. The process compares the incremental increase of intercept intensity from this basis
sample to a spiked sample to the incremental analyte concentration of the spiked sample. The quantum efficiency factor
is used to estimate the analyte concentration in the basis sample. Neither the basis sample nor its spike requires a
background or an external batch calibration. .

Standard Addition Spike - "SASpk"

“SASpk" is the designator for the analyte-spiked sample analyzed by standard addition. Standard addition quantiates the
analyte in a basis sample by internal calibration. The process compares the incremental increase of intercept intensity
from this basis sample to a spiked sample to the incremental analyte concentration of the spiked sample. The quanium
efficiency factor is used to estimate the analyte concentration in the basis sample. Neither the basis sample nor its spike
requires a background or an external batch calibration. ' ‘

Serial Ditution - "SerDil"

- "SerDil" is the designator of a serial dilution of a sample. The sample is prepared for analysis and analyzed precisely

anatogous to the basis sample. Additional deionized water prepares the final analytical sample so that a five-fold dilution
of the basis sample is created. Acceptable performance is specified in the Sample Control frame of the Quality Control
Configuration tab as the serial dilution error.
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KPAWin© Demo Supervisor Script

This script familiarizes a new KPAWIN® user possessing Supervisor privileges with the functions and features of the
KPAWINn® software. A KPA unit is not required to complete the actions in this script. The script provides the
necessary steps to exercise most standard functions required by a supervisor maintaining the KPAWIn®© software
configurations. To start the KPAWIn® software use either the Windows Start Taskbar button or double click on the
desktop shortcut (if created). KPAWIN® begins to initialize and stops at the Login Sequence. If additional users wish
to exercise this script, the original KPADemo should be reloaded to remove any changes made while performing the
various exercises in the script. »

Note: KPAWIN® Options that are displayed in “Black” are Available to the user while those that are displayed in
Light Grey, “Grayed Out” are NOT Available.

l. Administration Demonstration

Database Ogeratlon
1. Use the Database Dropdown menu to attach and open the KPADemo Database.

2. Atthe Top of the KPAWIn® display, all dropdown menu’s are listed. These Include File, Security,
Database, Reports, Analyze, Settings, Tools, Window, and Help. Click on “Database’ and then
select (highlight) and click the “Open” item.

3. The "Looking for KPA Database File” menu is displayed. Select (highlight) the KPADemo file and
click the “Open” button. The Demo database contains information to demonstrate the software
features and functions. It is only used for demanstration purposes.

Login Procedures
1. Click the first Toolbar {Login) button.

2. There are four UserlDs registered in the Demo Database (Analyst, MXF, Supervisor, & WRM) -
The Password for the Demo Supervisor Userld is "Supervisor'. Once you add additional Users to
the KPAWIN® database, you can select any Userld. Only those listed with Supervisor pnvileges can
perform the Administration functions within KPAWIn®©. It is recommended you remain Logged inas
“Supervisor".

3. After a site is through exercising the Supervisor Script and adding their supervisors to the KPAWiIn©
Database, change the status of the UserlD "Supervisor” to Inactive.

User Administration '
1. Adding KPAWIin® Users to the database.

2. Click on the “Securlty” dropdown menu item and then click “User Administration”. This displays
the User Administration Menu.

3. Click the “Add"” button. Fill in all fields with fictitious information. Remember this is the Demo
Database and none of the information entered is used. Passwords are NOT required by KPAWIN®.
They are entered only if the site requires their use. -

4. Click the “Apply” button and repeat Steps 3 and 4 to add additional Users. Enter as many new
Users as desired for practice.

5. Click the “Select” button and the User List is displayed with a dropdown list of all users in the
database. Highlight any one of the Users. You can now Edit the displayed information (e.g., make
the User Activellnactive, change the Password, etc.) and then click the OK or Cancel button. A
Supervisor Is the only administrator that can enter or change a User Password. If more stringent
password security is required, conslder using the Microsoft NT operating system. The OK button
exits the User Administration menu and returns to the KPAWIn®© Main display.
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Customer Administration
1. Click the “Database” dropdown menu and then click the “Customer Administration” item. This
displays the Customer Administration Menu.

2. Repeat Steps 3 through 5 from the User Adminlistration section to exercise these entries and add
one or more Customers to the Demo database.

Procedure Administration

1. Click the “Database” dropdown menu and then click the “Procedure Administration” item. This
displays the Procedure Administration Menu.

2. Repeat Steps 3 through 5 from the User Administration section to exercise these entries and add
one or more Procedures to the Demo database.

Laboratory Administration
1. Click the “Database” dropdown menu and then click the “Laboratory Administration” item. This

displays the Laboratory Administration Menu.

2. Repeat Steps 3 through 5 from the User Administration section to exercise these entries and add
your Laboratory to the Demo database.

Units of Measure Administration
1. Click the “Database” dropdown menu and then click the “Units Administration” item. This
displays the Units of Measure Administration Menu.

2. Click the Select button and Browse the Units Database. Most available Units are already entered
into the database. You change the report default Units using the “Apply” button.

Help Demonstration
1. Click the “Help” dropdown menu and then click the “Contents” item. This displays the KPAWIn©

Help Table of Contents listing all sections with Online Help information available. Click on any
item of interest and browse as completely as desired.

2. With the Help menu displayed, click on the *Index” Toolbar button to display the list of available
topics sorted alphabetically for perusal. Select one or more items and click the “Display” button at
the bottom of the menu. Close the Help display when finished.

3. KPAWIN® utilizes "Context Sensitive Halp” on all displays. Context sensitive help provides
immediate help with a screen element of interest (menu command, dialog box, label, or text item,
etc.). The program takes you directly to the help information you seek without the need to traverse
the Help Indexing system.

4. To get context sensitive help on a display Label or Input Text item, select the labe! or text box in
question with the mouse pointer and press F1 while the box is active. This action displays the Help
information for that item.

5. To get context sensitive help on a specific Menu Command place the mouse pointer over the
command button (DO NOT click the command button as the command is executed) and press F1.
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Main Displays (Toolbar/Miscellaneous Dropdown Menu's)

Toolbar Buttons : ’

The KPAWIn® main Toolbar contains several functions used extensively throughout the analysis process.
Prior to Logging onto the KPAWIn®© software, only the Login, Stop/Exit, and Help buttons are available.
Once a user has successfully Logged on, Logout, Stop/Exit, Analyze, Reports, Configuration, Initialization,
Tickler, and Help buttons are on display. When the mouse pointer Is placed over one of the buttons, text
Indicating the function of the button appears for approximately 5 seconds.

Logout Logs the current user out but KPAWIN® continues to run.
Exit Exits KPAWIN® and returns to the operating system.
Analysis Input - Displays the Input Analysis display.

Sample Reports Displays the Sample Selection display.

Configuration Tabs  Displays the Configuration Tabs display.

Initialize KPA - Displays and Executes the Initialization process.

Tickler Menu Displays the Maintenance Configuration Tab.

Help Information Displays the Help Contents. ’

Dropdown Menu’s

Many items on the Dropdown menus are demonstrated earlier in this script and are not addressed again.

Fil

Open - Enabled only when the Sample Input screen is on Display. Retrieves Sample Input
information previously saved.

SaveAs - Saves the Sample Input information to a file of your choice.

Exit - Exits the KPAWIn®© software.

Database
Open/Repalir/Pack are all database functions designed to manipulate the KPAWIN® database.

Archive removes data from the current database and stores it on other media (e.g., another Hard
drive, Tape, CDROM, Floppy disks).

Administration Functions are discussed above,

Reports .
Selection - Displays the Sample Selection Report form. This is demonstrated later in the script. -

Trend - Displays the Trend report.
Analyze is discussed in the section on Sample Input.
Settings displays the Configuration Tabs and is disdussed in that section.

Tools
Auto Changer has two submenu items, Reset and Rinse.

Diagnostics has a Probe KPA Unit submenu. It attempts to communicate with the KPA hardware
and KPAWIn® database. If not successful, an Error message displays indicating the probable cause
and offering an opportunity to retry the operation. Click the “Ignore” button if a KPA unit Is not
connected to your PC.

Calculator invokes the system calculator function.




‘ M. KPAWIin®© Configuration

Click on Settings, then the General Configuration item in the dropdown menu or use the Toolbar button,
Configuration Tabs. This displays the eight Configuration Tabs. The Demo Database uses the KPAWIn®
default configuration settings for each of the eight tabs except for the General ltems Tab. It contains the
“1001 Demo Config” which uses the defaults but also requires the use of Passwords. Only the UserlD of
“Supervisor” actually has a password assigned. All others are blank. The Demo scnpt allows the supervisor
to create one or more configuration sets for each tab.

Command Buttons - All command buttons are enabled for users with Supervisory Privileges, however only
the Help, Cancel, Select, and OK buttons are available for Non-Privileged Users.

Add Button - Enables all entries on the currently displayed Tab and allows privileged users to make
changes to the displayed values and create a new configuration set.

Cancel Button - Cancels the creation of a new configuration and discards any entered values or
changes.

' Apply Button - Applies and saves the newly created values to the KPA Configuration and Database.
Current Button - Applies the currently displayed values to the KPA Configuration.

Select Button - Allows the user to select another previously defined set of configuration parameter
for the Tab on display. _

OK Button - Exits the Conf guration Tabs and returns to the previous display.

General Settings Tab - This tab contains the KPAWIn® general items. Click on the Add button and aII
‘ items on the tab are enabled.

1. In the “Auto Reporting” frame, check “Print Single Sample Reports”,

2. Inthe “Required Login Input” frame, check “Require Passwords” and press function key F1.
(This dlsplays the Context Sensitive Help for this item,} Close the Help display when finished.

3. Click the "“Apply” button and the General ltems menu requesting you to “Enter Configuration
Name" is displayed with a default name of "Confi g" Enter a name of your choice and click the
“OK"” button.

Hardware Settings - Click on the “Hardware Settings” tab to bring it forward. Click on the “Add” button
and all items on this tab are enabled.

1. Uncheck the “Include Auto Changer” checkbox in the “KPA Hardware Sétup" frame. All data
in the Auto Changer Setup frame disappears. )

2. Click the “Apply” button and the Hardware Settings menu requesting you to “Enter

Configuration Name” is displayed with a default name of “Config". Enter a name of your choice
and click the “OK™ button.

Performance Settings - C!ick on the “Performance Settings” tab to bring it forward. Click on the “Add”
button and all items on this tab are enabled.

1. Change the “Calibration Limits"” frame item “Percent Discrepancy” from 10 to 20.
2. Click the “Apply” button and the Performance Settings menu requesting you to “Enter

Configuration Name” is displayed with a default name of “Config”’. Enter a name of your choice
and click the *OK" button.
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KPA Unit Settings - Click on the “KPA Unit Settings” tab to bring it forward. Click on the “Add” button.
All items on this tab are enabled.

1. Change the “Laser frame item “Pulses Per Analysis” from 1000 to 2000.

2. Click the “Apply” button and KPA Unit Settings menu requesting you to "Enter Configuration
Name" is displayed with a default name of “Config". Enter a name of your cholce and click the
“OK" button.

Maintenance Settings - Click on the “Maintenance Settings” tab to bring it forward Click on the “Add”
button and all items on this tab are enabled.

1. Change the item “Dye Change {(months) * from 2 to 4.

2. Click the “Apply” button and Hardware Settings menu requesting you to "Enter Configuration
Name" is displayed with a default name of “Config". Enter a name of your choice and click the
“OK” button.

Calibration Seftings - Click on the “Calibration Settings™ tab to bring it forward. Click on the “Add”
button and all items on this tab are enabled.

1. Change the “Calibration Settings" frame item “Calibration Ranges” from Both to Low.

2. Click the “Apply"” button and Calibration Settings menu requesting you to "Enter Configuration
Name" is displayed with a default name of “Config". Enter a name of your choice and dlick the
“OK” button.

QC Limit Settings - Click on the “Quality Control Settings” tab to bring it forward. Click on the “Add”
button and all items on this tab are enabled.

1. Change the “Method Control” frame item “MDL Multiple” from3to 7.

2. A message display appears informing you the valué you selected is OUTSIDE the Acceptable
Range and provides the acceptable values to choose. All Configuration items have a “Gross
Error Check” and allows only values within a predefined range. Click the “OK” button.

3. Change the value to 5 and then Click the “Apply” button. The Quality Control Settings menu

requesting you to "Enter Cenfiguration Name" is displayed with a default name of “Config”. Enter

a name of your choice and click the “OK" button.

Alarms/Warnings - Click on the “Alarms/Warning” tab to bring it forward. Click on the “Add" button and
all items on this tab are enabled.

1. Select several items and click the Alarms Checkbox and several other items and click the
Warnings Checkbox. The Alarms checked turn RED while the Warnings checked turn
YELLOW.

2. Click the *Apply” button and the HardWare Settings menu requesfing you to “Enter
Configuration Name" are displayed with a default name of “Config”. Enter a name of your choice
and click the *OK" button.

This concludes the Configuration Changes Demo. Click the “OK" button to Exit the configuration tabs and
retumn to.the previous display.
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Sample Input Display

Click on either the Analyze dropdown menu followed by clicking the Sample Input item or use the Toolbar
button Analysis Input Form. This displays and loads all Entered and Processed but Unaccepted
Samples from the database. The Demo Database has a total of 36 Processed Samples with at least one
example of all 19 Sample types. The Demo script allows the user to create more Sample Input entries. Note
that the display is divided into two sections, an upper portion with Labels and Input Text areas and a lower
Grid display portion. Data is entered into either section. .

Loading Sample Data from Database

1,

Click on the far left Grid Column labeled “Analysis™ and highlight Analysis # 1 (SamplelD =
1002, Sample Type =BckGnd.) Note that several labels in the upper portion of the display have
changed color. Red indicates the item is Required to be filled in. Blue indicates an Optional
item. Black indicates the data is taken from a Basis Sample and Grayed Out items are Not
Available and therefore not applicable to this sample type. Each sample type requires a unique
set of Required, Optional, Basis, and Not Applicable Sample Input items. The color code guides
your input. All Required items must be entered before attempting o enter or change another
Sample. The software displays an Error message describing any missing information.

Now click Analysis # 9 (SamplelD = 1010, Sample Type = IChkStd} and again notice the color
code changes to a number of fields in the upper portion of the display. The fields Standard 1D
and Standard Concentration are now colored Red while Calibration Conflg and Concentration
Units are Grayed Out.

Change the “Standard ID” from §-1 to §-2 in either the upper portion of the display or on the
Grid (Data may be entered in either section.)

To collapse any of the fields in the grid section of the form, place your mouse pointer on the
Label Text in the upper portion of the display and double click. Try the Concentration Units field
in the by double clicking on the label "Concentration Units”. The Sample Units field in the grid
completely collapses. To expand the field again double click the Label again and the Grid
Header expands. All collapsed Grid fields are saved for each user in the operating systems
Register file. Each time the user logs onto KPAWIn®, all saved display preferences are
reinstated. These preferences remain until the user changes them. Each user customizes these
fields to their own preference.

Sample Input Toolbar
Saving / Restoring Sample Entries

1.

Users enter Sample data into the Sample input form and Save it to a System file before
analyzing the samples. This is very useful if a Laboratory runs the same or similar sets of
samples on a reoccurring basis.

Enter the set of Sample data in the Sample Input form and nghhght the samples to be saved in,
the database.

Click the “Save As Initial Samples” (the picture of a floppy disk) Toolbar button and the Save
menu is displayed. Key in the name for the selected Sample Input Data and click “Save” to
save selected Samples. Click the “SaveAll” button to save all Samples on the Input Screen.

Click the “Open" Toolbar Button (the picture of an open file folder) and the “Select Sample to

Load” menu is displayed. Highlight the Sample name and click the “Load” button. These
Samples are loaded into the Grid from the database.
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Adding a New Sémgle

1.

Click the “Add New Sample” Taolbar button (picture of plus sign “+"). Either the Highlighted
Sample or if nothing is highlighted, the last Sample in the Grid is duplicated. However the
Sample ID is concatenated with a number or the last number in the ID is incremented. The
same rules apply to the Sample Description.

The user can change any of the displayed data items that are NOT Grayed out.

Users can also add a selected Sample using the “Insert Before” or “Insert After” feature.
Highlight any sample by clicking the number in the Analysis Column to select the sample and
then click the “Right Mouse" button to display the “Input Pop-Up Menu”. Select either the
“Insert Before” or “Insert After” command and the highlighted sample is duplicated and
placed in the desired order. ’ :

The “Input Pop-Up Menu” contains a considerable number of easy to use commands that you
can exercise as desired. Some of these commands such as Ciear, Delete, and Analyze are
also executed by using the buttons on the Input Toalbar.

Several commands such as “Accept”, “Reject”, "‘Reprocess", “Calibrate”, “Insert Before”,
“Insert After”, and “Move"” are only executed by using the Pop-Up menu.

Calibration Display

1.

Placing the cursor over the first column “Analysis, right click and the Pop-Up menu will appear.
Highlight the the “Calibrate” command and Left click. This will force a calibration using the
processed samples on the Sample Input Form and displays all the callbration data (both range
data is displayed if there is data for both ranges). .

Users may elect to disable the automatic calibration process by Checking the “User Gal”

checkbox In either range. When checked, the user provides a name for the calibration and
selects or deselects any specific calibration samples by “Double Clicking” on the specific
sample. The “+"sign disappears when the sample is deselected and reappears if selected
again. This method allows the user to select specific samples to be used in the calibration.

After Aselecting the samples you desire to be included in the calibration, click the Calibrate
command button located on the right of the display to re-calibrate.

Plots are also available for display by clicking the “Plot” command button.
Printing the Calibration details or Plots is accomplished using the “Print” command button.

The “Stop” Toolbar button exits the Input display and returns to the previous display.
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Displays and Reports

Click on the dropdown Reports, then the Selection item or click on the Sample Reports Toolbar button to
display the Sample Report Selection form. This display is divided into two sections. The upper portion
contains all the selection options while the lower portion lists the available samples from the database after
the “Retrieve” button is clicked. All user selected items are color-coded Blue and the KPAWIn® defaults
are selected when the form is initially displayed. The display design allows users a variety of options in
selecting Samples from the database (e.g., selection by Sample ID, Sample Type, Analyst, Customer,
Procedure, or Date Processed, etc.) as well as the type of display used to report that selection (e.g.,
Single or Multiple Sample Display reports, Single or Multlple Print reports, etc.} This script only uses a
few of the available selection criteria. However you can employ as many as you desire.

Selecting the Fields options that wlll be displayed in the lower portion of the report MUST be completed
prior to Retrieving the actual Sample from the database.

1. Selecting the Order of the Displayed Fields is only available to user with Supervisor privileges and only
applicable to the Select Report Sample Display. By default, all Sample fields on this display are in
Alphabetical Order.

2. Using the "Select Fields" function on the Select Report Sample display, Users can customize the
viewable Gird input data fields. The user can toggle between Select Fields and Move Fields by Double-
Clicking the left mouse button on any selected field. While in the Move Fields mode, fields can be
selected by dragging-and-dropping selections to the Top of the list. This list will define the order of the
fields of the display Grid. Once the order of the Fields have been selected, Double Click the right mouse
button again, which will change the display back to the Select Fields mode. Now Highlight all
contiguous fields in the listing with a single click of the left mouse button and dragging the mouse pointer
down to select those flelds to be displayed. You may select only a few fields or all of them depending on
your desires. We recommend that the Sample 1D and Sample Type be selected and placed near the
Top of the List because only the first column in the Select Reports Sample Grid will be used to select
Samples from the Grid to be analyzed and displayed. The user-selected, custom view is also retained in
the system Registry File and is only applicable the this computer. The Selected View will be reloaded
each time that user signs into KPAWin on that computer.

Selecting Samples from the database Is accomplished by using the various selection options on the top
portion of the display.

1. Inthe "Sample Type” frame, use the dropdown display to select the *“CalStd” sample type. Notice that
the Radio (round) Button in the frame changes from ALL toc AND. Now click the Retrieve button to load
the data from the database. All CalStd type samples meeting the other selection criteria are extracted
from the database and displayed according to your selection order in the lower portion of the screen.
You can try other selection criteria at your discretion.

On Screen Display Options - Single Sample Displays

1. Inthe “Sample Typé” selection frame, click the “Al” button and then the “Retrieve” button again. This
displays ALL of the samples in._the database. ,

2. To view one of the Samples, highlight the desired sample by clicking in the First column, in the Demo
Database example the first column is labeled “Sample 1D™.

3. Using the scroll bar on the fight of the display, scroll to the Sample 1D "1027" and highlight this sample.
Using the KPAWIn® default display options Display Reports and Single Display, click the “Display
Reports” command button. This displays the results of the sample. Click the lower “Stop Sign”
toolbar button or the X in the upper right hand corner of the display when finished viewing the report.
(Note: there are two sets of window buttons in the upper right hand corner of the display, the
lower set Is for the Single Sample report you are viewing while the top set controls the KPAWin
program. Clicking the X in the lower set will close the Single Sample Report while clicking the X
in the upper set will close the KPAWIN® program)
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Now highlight another sample, then click the “Display” command to view these results. This displays
the single sample display for the selected sample. Both the Sample Intensities and Plots are also
available from this display.

To view the Sample Plots, click the first button on the Sample Display Toolbar (lower toolbar - picture of
a graph). A frame is displayed depicting the Plot options with the default of “Net Data” (change the
display selection to any option desired); then click the Display Plots button. When through viewing the
Plots, click the “X" in the extreme upper right comer of the Plot display and then the Cancel command
on the Plot frame.

To view the Sample Intensities, click the second button on the Sample Display Tooclbar (lower toolbar -
picture of a report). A frame is displayed depicting the Intensity options with the default of “Net Sample
Data” (change the display selection to any option desired); then click the Display Intensities button.
When through viewing the Intensities, click the “X” in the extreme upper right corner of the Intensity
display and then the Cancel command on the Intensity frame.

Resize the Single Sample display, if required, and click the “Stop” Toolbar button to return to the Select
Sample display when through viewing the report.

On Screen Display Options - Multlgle Sample Dlsplay

1.

3.

3.

To select Sample for the Multi Display, select all the samples on dlsplay by highlighting the first one, then

the last sample while holding down the Shift key. Now click the “Multi Display” radio (round) button,

(note that all the Multi Display options are now enabled), select the “Sample Analysis” option, and click

the “Display” command. This displays the Multi Sample Analysis report containing one line of data for

each sample. Use the Scroll Bar at the bottom of the report to view all the data. When through viewing

the report, click the “X" in the extreme upper right corner of the Multiple Sample Analysis Report

{Located approximately Mid Screen on the right edge) to return to the previous display. ‘

Using all the above selection criteria, click another report radio button (e.g., “Quality Control”) and click
the “Display” command to view other muitiple sample displays. .

Print Report Options - Single Sample Reports -
1.

In the “Print Report Option" frame, click the “Single Sample” radio bution. All the MultiReport
checkboxes are disabled. The Calibration and Configuration selections remain active. The Details
option s also available when printing Single Sample reports.

Highlighting one sample at a time, select various sample types (e.g., BckGﬁd.,SampIe, MidStd,
SASamp, SampSpk, etc.). Then click the “Print” command button. Although all Single Sample Print
Reports have many items In common, each sample type produces a slightly different report.

Check as many report types as desired to become familiar with the various reports.

- Print Report Options - Multiple Sample Regdrts
1.

in the “Report Options” frame, click the “Print Reports” radio (round) button. This changes the
Monitor Display Options to Print Report Options. Click the MultiReport Option, if not already
selected, and there are four enabled checkbox reports and two disabled items. The disabled ltems
(Calibration and Configuration) are available when one of the MultiReport options Is selected.

Select two or more of the samples on display by highlighting them. Then check one of the report
options, use “Analytical Results” and the two additional checkboxes will be available. If checked,
these additional checkboxes produce additional Calibration or Configuration reports. Detailed reports
are obtalned by checking the “Details” checkbox to the right of the Calibration and Configuration report
options,

Check as many repbrt options as desired to become familiar with the various reports.

This concludes the familiarization script for supervisors.
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KPAWin®© Error Codes

E51
E52

E91

. E92

E93
E94
E95

E101
E102
E103
E104
E105
E106
E107
E108

E201
E202
E203
E204
E205
E2086
E207
E208
E209
E210
E211
E212
E213
E214
E215
E216
E217
E218

E401

KPAWIn® Program Errors
KPAWIN® Error: Unexpected .

KPAWIN® Error: Bad Routine Call Parameter

KPAWIN® Error: Incorrect call to Move Samples
KPAWIN® Error: Message Format is Bad

KPAWIN® Error: Undefined Alarm and Warning Message
KPAWIN® Error: Report Record not found

KPAWIN®@ Error: Sample Record does not exist
KPAWIN® Error: Intensity Record does not exist
KPAWIn® Error: Configuration

KPAWIN® Error: ToolBar Menu

KPAWIn® Database Errors
KPAWIn® Database Error
KPAWIn® Database Error: Record NOT Found

User Control Messages
User Escape

User Abort

User Cancef

User Ignore

User Retry

Sample Changer Error Messages (100 Series)

Sample Changer Movement Data is Missing
Sample Changer Error

RackNb: & VialNb: NOT Valid

Sample Changer Error

ERROR - Number of Sample Vials Exceed number of Mix Vials .

Reference Lifetime Too Short
Reference Intensity Is Excessive
Auto Changer Error

Calculations Error Messages (200 Series)

Unable To Calculate Reference Intercept

Unable To Calcutate Sample Intercept

Equals Water Blank

Not enough Samples available for &1& calculation
Basis Sample Loop

Auto Calibration Completed

All Samples must contain same number of Measurements
Spike and Sample have same Integrated Intensities
Initial Analysis Volume is Zero

Sample Must have Standard Concentration Specified
There are NO Valid Calibration Points

Calibratlon Curve Fit Error.

KPA NOT Calibrated

Precounts High For High Range

Confidence Test Aborted

Basis Sample Must Be Assigned before Measurement
Basis Sample Must Be Measured First

There are NO Calibration Points

CurveFit Error Messaqges (400 Series) -

Inverse Bad
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DBRoutines Error Messages {500 Series)

E501 Database File: & FileName & could NOT be Closed
E502 Database File: & FileName & could NOT be Opened”

KPA Error Messages (600 Series)
E601 Check KPA & Msg

E602 Auto Changer Error

E603 Put Sample & Sampleld Msg{SampleData)
E604 Put Sample Into KPA Cancel/Error

E605 Gilson Device Not Responding

E630 KPA Analyze Error

KPAIO Error Messages (700 Series)
E701 KPA Not Responding

E702 This KPA Cannot Use this Command

E703 Sample Intensity KPA Data Read Error

E704 Reference Intensity KPA Data Read Error

E705 Max Nb of Intensities & Data values must be received
E706 Place RANGE selector switch in the & SwitchMsg & position"
E707 This KPA Cannot Use the OUTALL Command

E708 There are no Standards for this sample

E709 Reference Intensity |s Excessive

E710 KPA NOT Ready

E711  Waiting for KPA Data

E712 Waiting for KPA Laser

E713 KPA Checksum Error

E714 KPA Background Measurement Required

MDIControl Error Messages (800 Series)

E801 Cannot find FindString

SelectCalData Error Messages {900 Series)

EQ01 No & Title & Found

ShowResults Error Messages (1000 Series)
E1001 Reference R’ < .99

Utilities Error Messages (1100 Series)
E1101 KPAWiIn® Configuration

E1102 The Value &1& Is NOT WITHIN the Acceptable Range
E1103 Range Must be Between &Value1& and &Value2&

E1104 Resetting to Previous Value

E1105 & DataText & Validation Rule is NOT valid & Validation Rule

MDIForm Error Messages (1200 Series)
E1201 Only ONE instance of + KPAWin + is allowed

General Config Error Messages (1300 Series)

E1301 Invalid Configuration Name provided - Default: & DefaultName & Used

Configuration Error Messages {1400 Series)

E1402 Polling & Format(DeviceNb)

GlisonSerial and KPASerlal Error Messages {1500 Series)

E1501 &Msg& Equipment Connected
E1502 Check &1& Power and Cables




E1801

E1901

E2101

E2201
E2202
E2203
E2204

- E2205

E2206
E2207
E2208
E2209
E2210
E2211
E2212
E2213
E2214
E2215
E2216
E2217
E2218
E2219
E2220
E2221
E2222
E2223
E2224
E2225
E2226
E2227
E2228
E2229
E2230

£2301
E2302
E2303
E2304

E2401
E2402
E2403
E2404
E2405
E2406

E9000
E9001

Login Error Messages (1800 Series)
Invalid Password Try Again ,, Invalid Login Attempt"

MultiReport Error Messages (1900 Serles)
KPAWIN® Error: Report Record not found

ProcedureAdmin Error Messages (2100 Series)
KPAWIn® Error

Samplelnput Error Messages (2200 Series)
Analyze SELECTED Samples?

Add Sample?

Insert After Sample: + SampleldMsg + 7

Insert Before Sample: + SampleldMsg + ?

There are no Samples saved with this name

Delete InitialSample: &(InitlalSampleName)

There are no Samples to Analyze

There are no unprocessed samples

There are no samples

Clear Sample: + SampleldMsg + ?

Delete ALL Samples?

Delete Sample: + SampleldMsg + Delete SELECTED Samples?

Approve Processed Sample: + SampleldMsg + Approve Processed and SELECTED Samples?
Reject Processed Sample: + SampleldMsg + Reject Processed and SELECTED Samples?
Reprocess Processed Sample: + SampleldMsg + Reprocess Processed and SELECTED Samples?
Input data is Invalid

Move SELECTED Samples?

All Samples have NOT been Analyzed & Continue Analysis?

Can not delete a Sample which has & Saved Intensities.

Record is currently locked. Try agaln later. '

Data has been changed by another user.

There are no Samples to Save

Initial Samples cannot be Saved wlthout a Valid Name

There is already a saved sample with this name" & "Replace Current Initial Sample?"

Initial Sample(s) &Msg& have been Saved"

Database Errors: All Samples may NOT have been saved

Batch Identification is NOT the first sample

Samples being used as a Basis can NOT be deleted

There can only be one background Per Bafch

Basis Sample has been deleted

SelectRptSample Error Messages (2300 Series)
You Must SELECT a Sample to Display with the Single Sample Report

You Must SELECT a Display Intensity Option
You Must SELECT a Display Plot Option
You Must SELECT a Display Type when using the MultiReport Option

Admin Error Messages (2400 Series) .
&1& DataBase Information has been Updated

Discarding Changes

Exiting &1& Administration Menu

Updating &1& Administration DataBase

Password Entries Do Not Match - Reenter Confirmation
Please Reenter Confirmation Password :

Serlal I/O Error Messaqes
Serial 1/0: Base Number
Serial 1/0: Received Bad Character
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“"Alarms / Warnings Message List”

Alarm / Warning #1 Background High - High Range

Alarm / Warning #2 Background High - Low Range

Alarm / Warning #3 Calibration Correlation (R Squared) Low - High Range
Alarm / Warning #4 Calibration Correlation (R Squared) Low - Low Range
Alarm / Warning #5 Calibration Standard Discrepancy High - High Range
Alarm / Waming #6 Calibration Standard Discrepancy High - Low Range
Alarm / Warning #7 Maximum Calibration Age Exceeded

Alarm / Warning #8 Sample Correlation (R Squared) Low

Alarm / Warning #9 Sample Lifetime Low

Alarm / Warning #10 Sample Lifetime High

Alarm / Warning #11 Reference Lifetime Low

Alarm / Warning #12 Reference Ratio High

Alarm / Waming #13 Reference Ratio Low

Alarm / Warning #14 Gate Shifting Excessive

Alarm / Warning #15 Gate Dropping Excessive

Alarm / Warning #16 Sample Concentration Out of Calibration Range
Alarm/Warmning #17 Too Few Valid Time Gates For Evaluation

Alarm / Warning #18 Sample Concentration High For Low Range
Alarm / Warning #19 Sample Concentration Low For High Range
Alarm / Warning #20 Dye Output Low ' :

Alarm / Warning #21 Laser Plasma Cartridge Output Low

Alarm / Warning #22 Laser Plasma Cartridge Age Exceeds Service Life

Alarm / Warning #23 Dye Age Exceeds Service Life

Alarm / Waming #24 Reference Age Exceeds Service Life

Alarm / Warning #25 Schedule Preventive Maintenance

Alarm / Warning #26 Too Few Calibration Points - High Range

Alarm / Warning #27 Too Few Calibration Points - Low Range
Alarm/Waming#28 . Initial Calibration Check Blank High - High Range
Alarm / Warning #29 Initial Calibration Check Blank High - Low Range
Alarm / Warning #30 Initial Calibration Check Standard Invalid - High Range
Alarm / Warning #31 Initial Calibration Check Standard Invalid - Low Range

Alarm / Waming #32 Conlinuing Calibration Check Blank High - High Range
Alarm / Warning #33 Continuing Calibration Check Blank High - Low Range
Alarm / Warning #34 Continuing Calibration Check Standard Invalid - High Range
Alarm / Warning #35 Contfinuing Calibration Check Standard Invalid - Low Range
Alarm / Warning #36 Too Few IDL Standards - Type 1 IDL

Alarm / Warning #37 Too Few IDL Averages - Type 2 IDL

Alarm / Warning #38 Average Concentration of IDL’s High

Alarm / Warning #39 IDL Above Maximum Acceptable Value
Alarm/Waming #40 Too Few MDL Standards - Type 1 MDL.

Alarm / Waming #41 Too Few MDL Averages - Type 2 MDL

Alarm / Warning #42 Average Concentration of MDL's High

Alarm / Warning #43 MDL Above Maximum Acceptable Value

Alarm / Waming #44 Relative Percent Deviation High

Alarm / Wamning #45 Sample Spike Recovery High

Alarm / Waming #46 Sample Spike Recovery Low

Alarm/ Warning #47 Serial Dilution Recovery High

Alarm / Waming #48 Serial Dilution Recovery Low

Alarm / Waming #49 Multiple MSA Spike Recovery High

Alarm / Warning #50 Multiple MSA Spike Recovery Low

Alarm / Warning #51 MSA Spike Recovery High

Alarm / Warning #52 MSA Spike Recovery Low

Alarm / Warning #53 Multiple MSA Slope Error High

Alarm / Warning #54 Multiple MSA Calibration Correlation (R Square) Low
Alarm / Warning #55 MDL Muitiple Exceeds Min Sample Result

Alarm / Warning #56 CRDL% Exceeds Min Sample Result

Alarm / Waming #57 Sample % Exceeds Min Sample Result
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Alarm / Warning #58
Alarm / Warning #59
Alarm / Warning #60
Alarm / Warning #61
Alarm / Warning #62
Alarm / Warning #63
Alarm / Waming #64
Alarm / Warning #65
Alarm / Warning #66
Alarm / Waming #67
Alarm / Warning #68
Alarm / Warning #69
Alarm / Warning #70
Alarm / Warning #71
Alarm / Warning #72
Alarm / Waming #73
Alarm / Warning #74
Alarm / Waming #75
Alarm / Waming #76
Alarm / Warning #77
Alarm / Waming #78
Alarm / Warning #79
Alarm / Waming #80
Alarm / Waming #81
Alarm / Warning #82
Alarm / Warning #83
Alarm / Warning #84
Alarm / Waming #85
Alarm / Waming #86
Alarm / Warning #87
Alarm / Warning #88

MDL Multiple, CRDL%, or Sample % Exceeds Min Sample Result
Method Standard Invalid - High Range
Method Standard Invalid - Low Range
Precounts High For High Range

Precounts Low For High Range

Precounts High For Low Range

No Concentration Unit Conversion Available
Units Conversion / Check Specific Gravity
Units Conversion / Check Specific Activity
Units Conversion / Check Atomic Mass .
Invalid Reference Intensities

No Background - High Range

No Background - Low Range

Gate Shifting

Gate Dropping

-Sample Intensity Intercept Below Background

Sample Intensity Intercept Below Quenched Background
No Calibration - High Range

No Calibration - Low Range ‘

No Basis Sample For Sample Duplicate

No Basis Sample For Sample Splke

No Basis Sample For Quenched Background

No Basis Sample For Method of Standard Addition
No Basis Sample For Standard Addition Spike

No Basis Sample For Serial Dilution

Reference Correlation (R Squared) Low

Reference Intensity Low : ,
Reference Intensity High

Maximum of 7 Calibration Standards Exceeded Oldest Ignored — High Range
Maximum of 7 Calibration Standards Exceeded Oldest Ignored — Low Range

Sample Concentration High For High Range
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KPAWIn®© Configuration Selection

The purpose of this file is to simplify the creation and use of KPAWin configuration tabs. The KPAWin program is
delivered with a KPAEmpty.mdb database. This database is an integral part of the program. The copy of the database
that resides with the KPAWiIn executable in the KPAWIN\Exe folder on your computer is the exact form of the database
that is used during execution of the program; KPA databases that are loaded from any other source are checked for
.conformity to this database and converted to the form of this database, if necessary.

During installation, you placed a copy of the KPAEmpty database into the KPAWin/Database folder. When you prepare
a user database, you will make a copy of KPAEmpty and rename it as you require. The user database is run with
KPAWiIN to specify, collect, and report analytical data. The procedure below greatly simplifies the process of creating a
new user database. ' . ‘

The simplification results from a one-time creation of an intermediate database that becomes the user's template. The
template is a copy of the KPAEmpty data base that contains all of the user configuration preferences and is assigned a
local laboratory template name.

The remainder of this utility contains two sections. Both contain all of the configuration fields, by configuration tab. The
first section contains three column: typical setting for a field, a blank space for the user to enter an alternative local
preference, and label of the field. Typical settings are for a KPA-11 with a Gilson mode! 223 auto changer and model
402 syringe pump, and "Site Custom® tabs with full quality control. As your requirements vary from these, make the
appropriate selections. The second section contains a short textual description of each field with.comments on
selection of settings. }

While the program contains eight unique configuration tabs, satisfactory operation of a KPA only requires the use of
- four tabs: General ltems, Hardware Settings, KPA Unit Settings, and Calibration Settings. Collectively, these required
tabs provide the same [evel of operation as the DOSKPA program that preceded KPAWIN. The use of the other four
tabs is optional: Maintenance, Performance Limits, Quality Control Limits, and Alarms/Warnings. The four optional tabs
work together to provide real-time quality control that is either active or passive. If “STOP KPA Processing on Alarms” is
selected on the Alarms/Warnings tab, any selected alarm or warning will halt KPA operation when an action item is
violated. User intervention is required to resume operation. Whether the check box is selected or not, “A” for alarm or
“W' for warning are reported with the action number for each analytical violation at the time sample results are
displayed or printed. These viclations can also be exported with the data at the user’s discretion. Some action items are
. qualitative such as “No Calibration - High Range”. Most are quantitative with user-specified control values taken from
one of the other three optional tabs. For example, “Background High - Low Range” violates a Maintenance tab
specification. :

We recommend that you negotiate Data Quality Objectives with your customers by simply completing the following form
for the optional tabs. The customer-specific tabs that you create are used to run that customer's samples. Analytical
failures are detected at run time if the appropriate Alarm/Warning action items are selected. Corrective action can be
taken immediately and reanalysis can be performed with fresh samples.
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‘ Configuratidn Tabs

Confiquration Tab Buftons

These six buttons are common to all eight configuration tabs.

Help On-line help

Select  Display drop-down listing of all alternative selections of current tab

Add Make copy of existing tab to edit and rename

Current Set current tab as default

Apply  Accept and Continue in configuration tabs

OK Accept and Exit

General Items Tab
Blank -

“Local™

'lnActive

List of Available Configurations

* Make a copy of KPAEmpty.mdb and save as your “Local” Template.
Name each “Local” tab according to your laboratory preference. For
each of the eight configuration tabs, check all configurations except
your "Local” Template as InActive. In the future, when you need a

new KPAWiIn database, use a copy of your “Local” Template. Alternative
versions of each configuration can be created and left Active as your
laboratory requires. InActive tabs remain in the database to qualify the
configuration of historical samples in the database that used these tabs.
Inactive tabs are not available, and cannot be selected during sample
input. Only Active (unchecked) tabs are available during sample input.

Auto Reporting / Miscellaneous Options

Check
Blank
Blank
Blank
Blank
Blank
Check
Check
Check
Blank

Display Single Sample Reports (Check to select.)

Print Single Sample Reports (Check to select)
Display Multiple Sample Reports (Check to select.)
Print Intensity Plots (Check to select.)

Print Calculated Intensities (Check to select.)

Print Measured Intensities (Check to select.)

Display Results in Scientific thation (Check to select.)
Required Login Input (Check to select.)

Regquire User ID's (Check to select.)

Require Passwords (Check to select.)
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Hardware Settings Tab

Blank ___ _  InActive
"Local” ______ List of Available Configurations
KPA Hardware Setup
1 e Serial Port (KPA) (Range: 1 to 99)
9600,N,81___ Serial Port Settings (KPA) (KPA-10 is 4800,N,8,1)
3 __ Eprom Version (KPA-10 /w auto shutter is 2. KPA-10 w/ manual shutter is 1.)
Check Include Auto Changer (Check to select.)
Auto Changer Setup
2 __ Serial Port (AutoChanger) (Range: 1 to 89)
9600,N,8,1_ Serial Port Settings (AutoChanger)

" Syringe Pump

1 Device Number (Syringe Pump) (Range: 0 to 62)
402 Model Number (Syringe Pump) (Alternative is 401)
SP40250 Flow Data Name (Syringe pump 401 is SP40150.)

Sample Changer

0 Device Number (Sample Changer) (Range: 0 to 62)
223 Model Number (Sample Changer) (Alternative is 222)
24242429 Tray Data Name (Sample changer 222 takes five racks.)

Position Offsets

0 X
0 Y
0 z
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KPA Unit Settings Tab

Blank

“Local’
Laser
20
1000
15
200
Detection
10
1
200
Time Gates
127
5
45
15
13
Range Selection
85
120
80

inActive

List of Available Configurations

" Pulses Per Second (Range: 1 to 20)

Pulses Per Analysis (Range 1 to 10,000)
Warm-Up Time (min) (Range: 0 to 1,000)
Warm-Up Pulses (Range: 1 to 9,999)

PMT Dead Time {ns) Range: 0 to 200) (KPA-11 is 10. KPA-11 is ~80 to 130.)
Minimum Intensity Factor (Range: 1 to 100)

Maximum Intensity Factor/Pulse (Range 1 to 255)

Total Time Gates (Range 2 to 127)

Start LSR Gate (KPA-10: use 4 for uranium analysis.)

Number of LSR Gates (Range: 1 to 127) (For urine, use 35.)

Minimum Number LSR Gates (Range: 5 to 127)

Time Gate Width (us) (Range: 1 to 40) (For lanthanides, see KPA manual.)

Auto Efficiency Factor (Range: No rule)

High Intercept Tolerance (%) (Range: 1 to 2,000)

Low Intercept Tolerance (%) (Range: 1 to 100)
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Calibration Settings Tab

Blank
“Local’
Untitled Frame
ng/l
1
25000

Uranium
238.0280
Auto
Total Vol
High-Range |
Quadratic
Blank
3
Low-Range
Linear
Blank

3

Analysis Settings
Select
Select
Select

Blank

i rro- ot T WA

InActive

List of Available Configurations

Concentration Units (Default for database)
Specific Gravity (g/ml) (Range: 0.1 to 10))
Specific Activity (Ba/g) {(Range: 1 to 80,000)
Select Analyte

Atomic Mass (g/mole)

Calibration Ranges

Dilution Method (Alternative is “Add To" for addition volume for dilution.)

Equation Type (Alternative is "Linear”.}
Include Zero Point

Minimum Number of Standards (Range: 1 to 7)

Equation Type (Alternative is "Quadratic”.)
Include Zero Point

Minimum Number of Standards (Range: 1 to 7)

Smooth Analysis Results Data (Check to deselect correction.)
Reference Correct Data (Check to deselect correction.)
Background Correct Data (Check to deselect correction.)

Proceed After Auto Calibration (Check to proceed without review.)
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Malntenance Options
Blank
Select
Blank

1
10
10

3

Low
18
3+

7%

. Maintenance Tab
Blank InActive
“Local” List of Available Configurations

Use Defaults

Use Site Custom

Do Not Use Limits ,

Excitation Test Standard {(ug/l) (Range: 0.1 to 5,000)

Dye Strength (intercept counts/bulse) (Range 1 to 300)
Laser Power (intercept counts/pulse) (Range: 1 to 300)
Number of Confidence Test Repeat Analyses

Confidence Test Analysis Ranée

Laser Plasma Cartridge Change {months) (Range: 12 to 24)

Dye Change (months) (Range: 1 to 6)

Reference Change (days) (Range: 1 to 31)

Scheduled Preventive Maintenance (months) (Range: 6 to 12)

* Enter dates as appropriate. A new reference requires a new Maintenance Tab.
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Performance Limifs Tab

Blank

“Local”

InActive

List of Available Configurations

Performance Limits Options

Blank

Select

Blank

Calibration Limits

25

1500

0.90
20
100

Analysis Limits
0.90
150
325
150
0.20
10

10

Use Defaults
Use Site Custom

Do Not Use Limits

Maximum Background High Range (Range: 1 to 1,000)
Maximum Backgroﬁnd Low Range (Range: 1 to 10,000)
Callbration R Squared (Range: 0.5101.0)
Percent Discrepancy (Range: 1 to 1,000)

Maximum Calibration Duration (days) (Range: 1 to 1,000)

Sample R Squared (Range 0.5 to 1.0)

Minimum Sampie Lifetime (ps) (Range: 1 to 10,000)
Maximum Samble Lifetime (us) (Range: 1 to 10,000)
Minimum Reference Lifetime (us) (Range: No rule)
Reference Ratio (+/-) (Range: -0.5 to 0.5)

Gate Shifting (Range: 1 to 125)

Gate Dropping (Range: 1 to 127)
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Quality Control Limits Tab

Blank
“Local”
QC Limit Options
Blank
Select
Blank
Detection Limits*
7
1

13
5

Blank

Calibration Control *
3/3
10/20

Method Control *
3
Blank
Blank
Blank

25

Sample Control
20
15
10

InActive

List of Available Configurations

Use Defaults

Use Site Custom

Do Not Use Limits

Number of Standards (Range: 0 to 13)

Type (Type 1 uses the standard deviation of individual daily measurements. Type 2
uses the average of daily standard deviations of multiple measurements.)

Maximum Duration (weeks) (Range: 1 to 13)
Maximum Concentration Factor (Range is 1 to 10)
Limit ng/l (Range: 0 to 1)

* Ali specifications for IDL and MDL. CRDL specifies only regulatory limit or customer
reporting detection limit.

Calibration Blank (IDLMultiple) (Range: 1 to 5)
Calibration Control Standard Error (%) (Range: 1 to 100)

* First value is for Initial (immediétefy after calibration) and second
specification is for Continuing (any time after initial).

MDL Muiltiple (Range: 1 to 5)

CRDL Percentage (Ramge: 0 to 100)

Sample Percentage (Range: 1 to 100)

Use Highest of the Above (MDL Multiple, CRDL % or Sample %)
Method Control Standard Error (+/-%) (Range: 1 to 100)

* Select only one of first four check boxes is Method Blanks are used.

Precision % (Relative Percent Difference of two measurements) (Range: 1 to 100)
Spike Recovery (%) (Range: 1 to 100)
Serial Dilution Error (%) (Range: 1 to 100)
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Method of Standard Addition *

3 —___ Number of Spikes (Range: 0 to 3) (<3 spikes don't give Slope Error or R Squared.)
Blank _ Recovery Error (%) (Range: 0 to 100)
Blank ________ Slope Error (%) (Range: 0 to 100)
Blank ___ R Squared (Range: 0to 1)

* Method provides comparison of batch and internal calibration.
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.- Alarms/ Warnings Tab

Blank InActive
“Local” List of Available Configurations
Blank STOP KPA Processing on Alarms

Alarms / Warnings Optional Action Items.

Alarm Warning ,
AW #1
AW #2
AW #3
AW #4
AW #5
AW #6
AW #7
AW #8
AW #9
AW #10
AW #11
AW #12
AW #13
AW #14
AW #15
AW #16
AW#7

. —_ Aw#s
AW #19
AW #20
AW #21
ANV #22
AW #23
AW #24
AN #25
AW #26
AW #27
AW #28
AW #29
AW #30
AW #31
AV #32
ANV #33
ANV #34
ANV #35
AW #36
AW #37
AW #38
AW #39
AN #40
AW #41
ANV #42
AW #43
AW #44
AW #45

' » A #46
AW #47

Background High - High Range

Background High - Low Range

Calibration Correlation (R Squared) Low - High Range
Calibration Correlation (R Squared) Low - Low Range
Calibration Standard Discrepancy High - High Range
Calibration Standard Discrepancy High - Low Range
Maximum Calibration Age Exceeded

Sample Correlation (R Squared) Low

Sample Lifetime Low

Sample Lifetime High

Reference Lifetime Low

Reference Ratio High

Reference Ratio Low

Gate Shifting Excessive

Gate Dropping Excessive

Sample Concentration Out of Calibration Range

Too Few Valid Time Gates For Evaluation

Sample Concentration High For Low Range

Sample Concentration Low For High Range

Dye Output Low

Laser Plasma Cartridge Output Low

Laser Plasma Cartridge Age Exceeds Service Life
Dye Age Exceeds Service Life :
Reference Age Exceeds Service Life

Schedule Preventive Maintenance

Too Few Calibration Points - High Range

Too Few Calibration Points - Low Range

Initial Calibration Check Blank High-- High Range
Initial Calibration Check Blank High - Low Range
Initial Calibration Check Standard Invalid - High Range
Initial Calibration Check Standard Invalid - Low Range
Continuing Calibration Check Blank High - High Range
Continuing Calibration Check Blank High - Low Range
Continuing Calibration Check Standard Invalid - High Range
Continuing Calibration Check Standard Invalid - Low Range
Too Few IDL Standards - Type 1 IDL

Too Few IDL Averages - Type 2 IDL

Average Concentration of IDL's High

IDL. Above Maximum Acceptable Value

Too Few MDL Standards - Type 1 MDL

Too Few MDL Averages - Type 2 MDL

Average Concentration of MDL's High

MDL Above Maximum Acceptable Value

Relative Percent Deviation High

Sample Spike Recovery High

Sample Spike Recovery Low

Serial Dilution Recovery High
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A/ #48
AV #49
AW #50
AW #51
AW #52
AW #53
AW #54
AW #55
AV #56
ANV #57
AW #58
AW #5659
A/W #60
AW #61
AW #62
AW #63
A #64
A/W #65
AW #66
AN #67
ANV #68
AW #69
AW #70
AN #71
AW #72
AW #73
AW #74
AW #75
ANV #76
ANV #77
AW #78
AN #79
AJW #80
AW #81
ANV #82
AW #83
A #84
A #85
AN #86
AW #87

- AIW #88

Serial Dilution Recovery Low

Multiple MSA Spike Recovery High

Multiple MSA Spike Recovery Low

MSA Spike Recovery High

MSA Spike Recovery Low

Muttiple MSA Slope Error High

Multiple MSA Calibration Correlation (R Square) Low
MDL Multiple Exceeds Min Sample Result

CRDL% Exceeds Min Sample Result

Sample % Exceeds Min Sample Result

MDL Multiple, CRDL%, or Sample % Exceeds Min Sample Result
Method Standard Invalid - High Range

Method Standard Invalid - Low Range

Precounts High For High Range

Precounts Low For High Range

Precounts High For Low Range

No Concentration Unit Conversion Available

Units Conversion / Check Specific Gravity

Units Conversion / Check Specific Activity

Units Conversion / Check Atomic Mass

invalid Reference Intensities

No Background - High Range

No Background - Low Range

Gate Shifting

Gate Dropping

Sample Intensity Intercept Below Background
Sample Intensity Intercept Below Quenched Background
No Calibration - High Range

No Calibration - Low Range’

No Basis Sample For Sample Duplicate

No Basis Sample For Sample Spike

No Basis Sample For Quenched Background

No Basis Sample For Method of Standard Addition
No Basis Sample For Standard Addition Spike

No Basis Sample For Serial Dilution -

Reference Correlation (R Squared) Low

Reference Intensity Low :

Reference Intensity High

Maximum of 7 Calibration Standards Exceeded Oldest Ilgnored — High Range
Maximum of 7 Calibration Standards Exceeded Oldest lgnored — Low Range
Sample Concentration High For High Range

44




e

Configuration Tabs General Settings

General Items
The General ltems form contains two frames, an Active/tnactive checkbox, and a Database ID list box. The first frame contains
options for automatic reporting. The second frame contains options for user and supervisor logins. Supervisor login with
password reserves changes of this tab to the supervisor. Otherwise, it is modified by any valid user.

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Select command
button. Select the Configuration ID to display and then clear the check mark.

List of Available Configurations

The List Test Box displays all available configurations for this configuration tab. Any active tab is selected from the list for the
background and retained throughout the batch.

Auto Reporting Options

The Aute Reporting Options frame enables a Supervisor to select the screen displays and reports queued to the printer
immediately after a sample is analyzed.

Display Single Sample Reports

The Display Single Sample Reports checkbox indicates the use of the Single Sample Report mechanisms within KPANn@ to
produce monitor display reports. The system default is True. Click the checkbox to deselect this item.

Print Single Sample Reports
The Print Single Sample Reports checkbox enables automatic printing of Single Sample Reports for each selected sample. The
system defautt is True. Click the checkbox to deselect this item and to suppress the display of single sample reports after each
analysis.

Display Multiple Sample Reports

The Display Multiple Sample Reports checkbox displays the Multiple Sample Reports on screen. The system default is False.
Click the checkbox to select this item and to suppress the printing of single sample reports after each analysis.

Print Intensity Plots

The Print Intensity Plots checkbox enables the automatic printing of sample and reference intensity plots. The system default is
False. Click the checkbox to select this item.
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Print Calculated Intensities

The Print Calculated Intensities checkbox enables automatic printing of net sample and net reference intensities by time gate. 1,
system default is False. Click the checkbox to select this item.

Print Measured Intensities

The Print Measured Intensities checkbox enables automatic printing of sample and reference intensities by time gate for raw data.
The system default is False. Click the checkbox to select this item.

Display Resuits in Scientific Notation

The Display Resulits in Scientific Notation checkbox enables the display and printing of the sample results using Scientific Notation
format. The system default is False. Click the checkbox to select this item.

Required Login Input

The Required Login Input frame contains two check box options to control the login process to the KPAWIN® software. The
software supports both the use of individual Login IDs along with or without associated passwords. Login User IDs is the Default
and password protection is optional. Two classes of users are recognized: Supervisors and Analysts. Supervisors have complete
access to the system. Analysts cannot add configuration tabs but can change the Active/Inactive checkbox for a configuration and
can mark an alternative of any tab as “Current’, The current configuration of any tab is the default of that configuration that is used
at the time of sample input. The “General”, "Hardware”, and "Maintenance” tabs are fixed to the alternative that is selected as
current when the background is analyzed for an analytical batch. All alternatives of the other five configuration tabs that are marked
“Active” by deselecting the Active/Inactive checkbox on their tab are available at the time of sample input and selections can be
changed on a sample-by-sample basis.

Require User ID's
The Require User IDs checkbox requires the use of KPAWIn® system User IDs. When User IDs are selected, the KPAWIN®
settings that are active when an individual logs our will be restored when that individual logs in again. The system default is True.
Click the checkbox to deselect this item and login without User ID.

Require Passwords

The Require Passwords checkbox requires the use of KPAWIN® system Passwords by Supervisors and by Analysts. The system
default is False. Click the checkbox to select this item.
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Configuration Tabs Hardware Settings

Hardware Settings
The Hardware Settings form contains two frames, an Active/Inactive checkbox, and a Database ID list box. The first frame

manages the KPA hardware. The second frame manages optional automatic sampling equipment. Supervisor login with
passwaord reserves changes of this tab to the supervisor. Otherwise, it is modified by any valid user.

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Select command
button. Select the Configuration ID to display and then clear the check mark.

List of Available Configurations

The List Test Box displays all available configurations for this configuration tab. Any active tab is selected from the list for the
background and retained throughout the batch.

KPA Hardware Setup

The KPA Hardware Setup frame specifies the assignment of the KPA Serial Port, Serial Port Settings, KPA Eprom Version, and
includes an Auto Changer selection check box.

Serial Port (KPA)
The Serial Port of the KPA is the computer port for communications with the KPA. The Default setting is 1.

Serlal Port Settings (KPA)
The Serial Port Settings for the KPA Unit consist of baud, bits, parity, and stop bits delimited by commas. The default values for
KPA-11 are 9600 BAUD, 8 Bits, No Parity, and 1 Stop Bit. For a KPA-10, settings of “4800 BAUD, 8 Bits, No Parity, and 1 Stop Bit”
should be selected.

Eprom Verslon

The Eprom Version is a number from 1 to 3 that identifies the Eprom Version of the KPA. Version 3 is for a KPA-11. Version 2 is
for a KPA-10 with automatic shutter control. Version 1 is for a KPA-10 with manual shutter control. The default is 3.

Include Auto Changer

The Include Auto Changer cheokbox selects or deselects the Auto Changer as a component of the hardware configuration. The
default is checked.

Auto Changer Setup

The Auto Changer Setup frame contains two elements and three subframes. The elements are Serial Port and Serial Port Settlngs
for the changer. The subframes are Sample Changer, Syringe Pump, and Position Offsets.

Serial Port (AutoChanger)
The Serial Port AutoChanger is the computer port for communications with the Auto Changer. The Default setting is 2.
Serial Port Settings (AutoChanger)

The Serial Port Seftings AutoChanger for the Auto Changer Unit consist of baud, bits, parity, and stop bits delimited by commas.
The default values for Gilson equipment are 9600 BAUD, 8 Bits, No Parity, and 1 Stop Bit.

Syringe Pump

The Syringe Pump subframes contain three items to specify the Device Number, Model Number, and Flow Data Name and a Poll
Button to acquire the three data items associated with the pump.




Device Number (Syringe Pump)

The Device Number selects the Syringe Pump Device Number. If unknown and Auto Changer is connected, select the Poli Butto,
and an attempt is made by the KPAWIn® software to determine the correct value. The default is 1.

Model Number (Syringe Pump)
The Model Number is the Gilson ditutor number. ' If unknown and an Auto Changer is connected, select the Poll Button and an

attempt is made by the KPAWIn® software to determine the correct value. The default is 402. The model number for syringe
pumps delivered before the year 1999 is the 401.

Flow Data Name
The Flow Data Name selects the appropriate Syringe Pump Flow Data Name. If unknown and Auto Changer is connected, select

the Poll Button and an attempt is made by the KPAWIN®@ software to determine the correct value. The default is SP402500 for
pump model 402. The flow data name for pump model 401 is SP401500.

Syringe Pump Poll

The Poll buiton activates the Syringe Pump and acquires the three data items associated with the pump: Device Number, Model
Number, and Tray Data Name.

Sample Changer

The Sample Changer subframes contain three items to specify the Device Number, Model Number, and Tray Data Name and a
Poll Button to acquire the three data items associated with the changer.

Device Number (Sampie Changer)

The Device Number selects the Sample Changer Device Number. If unknown and Auto Changer is connected, select the Poll
Button and an attempt is made by the KPAWIn® software to determine the correct value. The default is 0.

Model Number (Sample Changer)
The Mode! Number is the Gilson changer humber. If unknown and Auto Changer is connected, select the Poll Button and an

attempt is made by the KPAWIN® software to determine the coirect value. The default is 223. The model number for sample
changers delivered before the year 2000 is the 222. . .

Tray Data Name
The Tray Data Name is a concatenation of the racks in the sample tray as identified by their Gilson identification numbers. For
example, the Tray Data Name of 24242423, the default, indicates the Gilson tray contains, from left fo right, three model 24 racks
and one model 29 rack. If unknown, select the Poll Button and an attempt is made by the KPAWIn® software to determine the
correct value.

Sample Changer Poll

The Poll button activates the Sample Changer and acquires the three data items associated with the umt Device Number, Model
Number, and Tray Data Name.

Position Offsets

The Position Offsets subframe provides offsets for the X, Y, and Z vial coordinates to compensate for differences between Sample

Changer adjustments.
X The X Position Offset in units of 1710 mm from the position with no offset to the centar of vial 1 of rack 1. The Default is 0.
The Y Position Offset in units of 1/10 mm from the position with no offset to the center of vial 1 of rack 1. The Default is 0.
Y4

The Z Position Offset in units of 1/10 mm from the position with no offset to the bottom of the sample container of vial 1 of rack °
The Default is 0.

48




Configuration Tabs KPA Unit Settings

KPA Unit Settings
KPA Unit Settings form contains three frames, an Active/inactive checkbox, and a Database ID list box. The first frame contains
laser options. The second frame contains detection options. And the third frame contains time-gate options. Supervisor login with
password reserves changes of this tab to the supervisor. Otherwise, it is modified by any valid user.

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Select command
button. Select the Configuration ID to display and then clear the check mark.

List of Available Configurations

The List Test Box displays all available configurations for this configuration tab. Any active tab is selected from the list for the
background and retained throughout the batch.

Laser

The Laser frame controls firing of the nitrogen laser and includes: Pulses Per Second Pulses Per Analysis, Warm-Up Time, and
Warm-Up Pulses.

Pulses Per Second
The Pulses Per Second setting specifies the number of pulses fired each second during an analysis. The default is 20.

Pulses Per Analysis ‘
Pulses Per Analysis specifies the total number of laser pulses fired during each analysis. The default is 1000.

Warm-Up Time (min)
The Warm-Up Time specifies the time in minutes that elapse between analyses before the high-voltage transformer of the nitrogen
laser is preformed with a series of laser pulses equal to the Warm-Up Pulses specn’ ication of the KPA Unit Settings configuration
tab. The defaultis 15.

Warm-Up Pulses

The Warm-Up Pulses specifies the number of nitrogen laser pulse cycles preceding an analysis if the Warm-Up Time specified in
the KPA Unit Settings configuration tab is exceeded. The default is 200.

Detection

The Detection frame provides correction and control for photomultiplier operation and includes PMT Dead Time, Minimum
Intensity Factor, and Maximum Intensity Factor/Pulse.

PMT Dead Time (ns)

The PMT Dead Time is a factor correcting a nonlinear refationship between the logarithm of the intensity versus analyte
concentration to a linear relationship. The correction, also known as the coincidence corraction, compensates for saturation of the
counting circuitry resulting from cycling the PMT on and off during periods of high photon flux. The dead time for PMT’s used in
KPA-11 instruments is 10 and is the default. The dead time for PMT's used in KPA-10s is uniquely determined for each PMT and
its photon counting unit. The KPA-10 dead time has a default value of 120 and ranges from 110 to 150. The correction, applied to
all raw intensity data, is (Rawlntensity * Pulses * GateWidth) / (Pulses*GateWidth + RawIntensity*DeadTime).

Minimum Intensity Factor

The Minimum Intensity Factor sets a threshold from the total net intensity for sum of all laser cycles in each time gate of an
analysis. The first time gate in an analysis with a total intensity below the Minimum Intensity Factor and the intensity data in all
succeeding time gates is ignored in the least squares regression of the net intensity data. The default value is 1.
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Maximum Intensity Factor/Pulse

The Maximum Intensity Factor/Pulse sets a maximum raw intensity for each laser pulse to identify data accumulated under
saturation conditions. Time gates with intensities that exceed the Maximum Intensity Factor/Pulse specification are ignored in the
least squares regression of the net intensity data. The default value for KPA-11 instruments is 180 with 200-as a maximum. The
default value for KPA-10 instruments is 55 with a maximum of 60. Values that exceed this limit produce an Alarm or Warning
issued to the operator. The default is 200. .

Time Gates

The Time Gates frame contrals the multi-channel analyzer and the default least-squares analysis and includes Total Time Gates,
Start LSR Gate, Number of LSR Gates, Minimum Number LSR Gates, Time Gate Width, High Intercept Tolerance, and Low
Intercept Tolerance.

Total Time Gates

The Total Time Gates is the number of time gates used to collect intensity data during an analysis. The default and maximum
number is 127.

Start LSR Gate
The Start LSR Gate defines the user-specified low-order time gate for the least square regression of the intensity data. The Start
LSR Gate value shifts to a higher-order time gate if the raw intensity data in the user-specified gate exceeds the Maximum Intensity -
Factor/Pulse specification in the KPA Unit Seftings configuration tab. The default value for uranium is 5 for the KPA-11 instrument

and 4 for the KPA-10 instrument. The default value for lanthanides varies from 2 for samarium and thulium to 4 for dysprosium,
europium, and terbium. See the KPA Operator's Manual or call Chemchek Instruments, Inc. for lanthanide settings.

Number of LSR Gates
The Number of LSR Gates setting specifies the default number of time gates used in the analysis. The default number of time
gates is truncated before the least-squares regression for the first corrected intensity less than the Minimum Intensity Factor of this

configuration tab, The default is 45 for uranium. Bioassay for uranium in urine is improved with a selection of 35 LSR gates. Se¢
the KPA Operator’s Manual or call Chemchek instruments, Inc. for lanthanide settings.

Minimum Number LSR Gates

The ‘Minimum Number LSR Gates specifies the minimum number of time gates that must ooniain valid data to produce an
analysis. The defaultis 15. :

Time Gate Width (us)

The Time Gate Width specifies the width (Length of Time in psec.) of each time gate used in the analysis. The defauitis 13 for
uranium analysis. See the KPA Operator's Manual or call Chemchek Instruments, Inc. for lanthanide settings.
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Range Selection

The Range Selection frame controls the automatic and manual selection of the KPA analytical ranges.

Auto range selection is based on sample precounts in the high range with range selection based on actual performance in the high
range and inferred performance in the low range. Actual performance in the high range during automatic range selection uses the
Minimum Intensity Factor specification in this tab to determine if enough counts can be detected during an analysis to assure that
a successful least-squares regression of the data can be performed (no attempt will be made to take a logarithm of a negaftive
number of counts after background subtraction). High-range precounts are used with the Maximum Intensity per Pulse
specification to determine if the acquisition rate of counts in the fifth time gate would be excessive in the low range. The
user-specified setting for the "Auto Efficiency Factor” in this frame predicts the ratio of counts in the low range to counts in the high
range for a sample. Experience indicates that this factor is about 100 for samples with 1 pg/l of uranium and about 80-85 for
samples with uranium concentrations where detection in both ranges is possible. multi-channel analyzer and the defauit
least-squares analysis and includes Total Time Gates, Start LSR Gate, Number of LSR Gates, Minimum Number LSR Gates,
Time Gate Width, High Intercept Tolerance, and Low Intercept Tolerance. o

Manual range selection is based on evaluation of analytical data after an analysis based on the maximum concentration and
minimum concentration of calibration samples for each KPA range. Analytical results that exceed the maximum concentration of
calibration samples in the range of the analysis multiplied by the “High Intercept Tolerance” are flagged, if requested in the
Alarms/Warnings Tab by the user. If the specification is violated in the low range and a high-range calibration exists, the analysis
will be reattempted in the high range. Analogously, if the analytical result is less than the minimum concentration of the calibration
samples in the high range (the low range is assumed to extend to zero concentration) multiplied by the Low Intercept Tolerance,
the result is flagged and reattempted in the low range if a low-range calibration exists. If the range between the highest low-range
calibration standard and the lowest high-range calibration standard is large and the intercept tolerances are close to 100%, range
switching stops after the analysis in the second range, range errors are reported for both ranges, and the results for the second
altempted analysis ir reported.

Auto Efficiency Factor

The Auto Efficiency Factor estimates what the Counts-Per-Pulse would be in the Low Range using the Precount value obtained
during the Precount operation in the High Range The default is 85.

High Intercept Tolerance (%)

The High Intercept Tolerance (%) is used to extend the limits of the high and low calibration ranges by the percent indicated. The
default is 120,

The High Intensity Tolerance (HIT) is the percentage of the highest concentration standard in either calibration range that can be
used to quantify a sample result in that range. The default is 120 (%). The KPA Settings configuration tab will accept values for the
Low Intensity Tolerance (%) of 1* HIT * 2000.

If the highest concentration standard for a low-range calibration is 10 ppb, an error will be reported and no analysis will be
performed for a samiple with a concentration that is greater than 12 ppb for a HIT of 120%. {f a high-range calibration exists, the
KPA will automatically reattempt the analysis in the high range. See Low Intensity Tolerance (%) in the Configuration - KPA
Settings Help file for qualification of the reanalysis. If the reanalysis is also disqualified, then an error will be reported and no
analysis will result for the existing calibration with the existing LIT and HIT values.

Low Intercept Tolerance (%)

The Low Intercept Tolerance (%) is uéed {o extend the limits of the high and low calibration ranges by the peroent.indicated. The
default is 80.

The Low Intensity Tolerance (LIT) is the percentage of the lowest concentration standard in the high calibration range that can be
used to quantify a sample resuit in that range. The default is 80 (%). The KPA Settings configuration tab will accept values for the
Low Intensity Tolerance (%) of 1* HIT * 100.

If the lowest concentration standard for a high-range calibration is 10 ppb, an error will be reported and no analysis will be
performed for a sample with a concentration that is less than 8 ppb for a LIT of 80%. If a low-range calibration exists, the KPA will
automatically reattempt the analysis in the high range. See High Intensity Tolerance (%) in the Configuration - KPA Settings Help
file for qualification of the reanalysis. If the reanalysis is also disqualified, then an error will be reported and no analysis will result for
the existing calibration with the existing LIT and HIT values.
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Configuration Tabs Calibration Settings
Calibration Settings

The Calibration Settings form contains four frames, an Active/inactive checkbox, and a Database ID list box. The first frame
contains general options. The second frame containg options for a high-range calibration. The third frame contains options for a
low-range calibration. The fourth frame contains analysis seitings. Supervisor login with password reserves changes of this tab to
the supervisor. Otherwise, it is modified by any valid user.

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Select command
button. Select the Configuration ID to display and then clear the check mark.

List of Avallable Configurations

The List Test Box displays all available configurations for this configuration :tab. Any active tab is selected from the list for the
background and retained throughout the batch.

“Untitled”

The first frame includes Concentration Units, Specific Gravnty, Spec:f c Activity, Select Analyte, Atomic Mass, Calibration Ranges,
and Dilution Method

Concentration Units
The Concentration Units selection is the dimensions for input and output values of concentration. All concentration data are
recorded in the KPAWIn® database in units of ug/l. The user is prompted to provide the Specific Gravity for concentrations on a per
mass basis, Specific Activity-for concentrations in radiometric units, and Atomic Mass for concentrations on a molar basis in the
Calibration Settings configuration tab. Default values for these conversions are 1 g/ml for dilute aqueous solutions and 25,000Bq/g
(0.677 uCi/g) for natural uranium. The default for concentration units is ug/l. Select the approprlate Concentration Units from tk
dropdown list provided.

Specific Gravi’ty (g/ml) .

Specific Gravity (g/ml) is a factor used to convert KPAWIN® database concentrations in units of ug/l from input umts to output units
that are expressed on a per mass basis. The default value is 1 g/mi for dilute aqueous squtlons

Specific Activity (Bq/g)

Specific Activity (Bg/g) is a factor used to convert KPAWIN® database concentrations in units of ug/l from input units to output units
that are expressed in radiometric units. The default value is 25,000 Bg/g for natural uranium.

Select Analyte

The Select Analyte setting provides a dropdown list of the KPA analytes. A new selection here also sets a new default Atomic Mass.
The default is Uranium.

Atomic Mass

Atomic Mass (g/mole) is a factor used to convért KPAWIn© database concentrations in units of ug/l from input units to output units
. expressed on a molar basis. The default value is 238.0289 g/mole for natural uranium.

Calibration Ranges

The Calibration Ranges include low {only), high (only), both (high and low) or auto (high and/or low based on precount rates).
Backgrounds are analyzed in the single range requested or in both ranges if both or auto-is requested. Successive calibration
samples are analyzed in the ranges specified in the sample input with analysis with precounts detarmining which range or ranges
are analyzed for samples marked auto. The default is Auto.
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Dilution Methoq

The Dilution Method dropdown includes Add Volume (used when the initial sample volume is added to prepare a final volume) or
Total Volume (used when lab procedure dilutes an initial sample volume to a final total volume) methods to adjust sample volumes
during preparation and before analysis. If Add Volume is selected, a five-fold dilution of 1 mlis expressed as an initial volume of 1 ml
and a final volume of 4 ml. If Total Volume is selected, a five-fold dilution of 1 m| is expressed as an initial volume of 1 ml and a final
volume of 5 ml. The default is Total Volume.

High-Range

The High-Range calibration frame includes Equation Type, the Include Zero Point check box, and the Minimum Number of
Standards.

Low-Range

The Low-Range calibration frame includes Equation Type, the Include Zero Point check box, and the Minimum Number of
Standards.

Equation Type

The Calibration Equation Type dropdown list specifies the form of the calibration equation for the least square regression of the
intensity intercepts versus true concentrations of calibration standards and backgrounds for both the low range and the high range.
The available regressions are linear or quadratic and either force the fit through zero concentration (background) or do not force the
fit through zero. The default is quadratic for the high range and linear for the low range.

Include Zero Point

.

The Include Zero Paint checkbox results in forcing the calibration equation through zero when selected. The default is unselected.

Minimum Number of Standards

The Minimum Number of Standards specifies the minimum number of standards that MUST be analyzed for each specified range.
The default for the high range and for the low range is 3.

Analysis Settings

The Analysis Settings frame includes Smooth Analysis Results Data, Reference Correct Data, and the Proceed After Auto
Calibration checkbox.

Smooth Analysis Results Data

The Smooth Analysis Results Data checkbox selects smoothing of the coincidence (dead time) corrected raw data for samples and
references. Smoothing averages the intensities over five time gates for the central time gate for all data in the least square
regression. E.g. the smoothed sample intensity for time gate 10 is the average of the coincidence-corrected sample intensities for
time gates 8 through 12. Smoothed intensities for the first two time gates in the regression are not corrected but are set equal to
their corresponding coincidence-corrected values. The system default sets this to TRUE. Click the checkbox to deselect this item.

Reference Correct Data
The Reference Correct Data checkbox indicates that smoothed intensities are divided by the reference ratio to create reference
corrected intensities for each time gate in the least square regression. The system default sets this fo TRUE. Click the checkbox to
deselect this item. |f smoothing is deselected, coincidence corrected intensities are used.

Background Correct Data
The Background Correct Data checkbox indicates that smoothed background intensities are subtracted from reference-corrected
intensities to create net for each time gate for evaluation by a least square regression. The system default sets this to TRUE. Click
the checkbox to deselect this item. If reference coirection is deselected, smoothed intensities are used. Hf reference correction and

smoothing are deselected, coincidence corrected background intensities are subtracted from coincidence corrected sample
intensities. If all corrections are deselected, coincidence corrected sample intensities are evaluated by least square regression.

Proceed After Auto Calibration
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The Proceed After Auto Calibration checkbox specifies automatic analysis of samples and standards proceeds without pausing for
user review after the calibration. The system default sets this to FALSE. Click the checkbox to select this item.
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Confiquration Tabs Maintenance Settings

Maintenance
The Maintenance form contains three frames, an Active/lnactive checkbox, and a Database ID list box. The first frame contains
general options. The second frame contains options for excitation and confidence testing and includes Excitation Test Standard,
Dye Strength, and Laser Power. The third frame contains instrument maintenance and service information. It includes Laser
Plasma Cartridge Change, Dye Change, Reference Change, and Scheduled Preventive Maintenance. Supervisor login with
password reserves changes of this tab to the supervisor. Otherwise, it is modified by any valid user.

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Select command
button. Select the Configuration 1D to display and then clear the check mark.

List of Available Configurations

The List Test Box displays all available configurations for this configuration tab. Any active tab is selected from the list for the
background and retained throughout the batch.

Maintenance Options

The Maintenance Options frame provides a choice among three alternative uses of the Maintenance tab: Use Defauilts, Use Site
Custom, or Do Not Use Limits.

Use Defaults

The Use Defaults option button selects the 1000 Release configuration for Maintenance Options. These limits are parameters
supplied by Chemchek Instruments Inc. as defaults for the software.

Use Site Custom
The Use Site Custom option button opens the Maintenance Options configuration tab for user-specified entries and is the default,
Do Not Use Limits '

The Do Not Use Limits option button selects the 999 Nao Limits configuration for the Maintenance Options. This allows a site to
DISABLE the use of all of the KPAWIN® software performance limits.

Excitation Test Standard (ug/l)

The Excitation Test Standard (ug/l)specifies the nominal concentration of a standard that supports Dye Strength and Laser Power in
the Maintenance configuration tab. The intensity intercept for each analysis of the standard after a Dye change is normalized to the
value of the excitation test standard and stored in the database for the trend analysis of Dye Strength. Similarly, each intensity
intercept for each analysis of the standasd with fresh dye is narmalized to the value of the excitation test standard and stored in the
database for the trend analysis of Laser Power. Alarms are activated when either normalized intercept is less than the
specifications for Dye Strength or Laser Power in the Maintenance Options configuration tab. Select a trend line for Dye Strength or -
Laser Power as a function of date. Select from the dropdown Tools on the main menu. The default is 1.

Dye Strength (intercept counts/pulse)

The Dye Strength (intercept counts/pulse) entry specifies the minimum intensity intercept counts per laser pulse for the excitation
test standard. The default is 10.

Laser Power (intercept counts/pulse)

The Laser Power (intercept counts/pulse) entry specifies the minimum intensity intercept counts per laser pulse for the excitation test
standard. The default is 10.
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Number of Confidence Test Repeat Analyses

The Number of Confidence Test Repeat Analyses is the number of replicate analyses performed on a confidence test samy.
to estimate the system reproducibility. The defaultis 3.

Confidence Test Analysls Range

The Confidence Test Analysis Range is the range used to analyze confidence test samples. The default is Low.

Laser Plasma Cartridge Change (months)
The Laser Plasma Cartridge Change (months) is the number of months from the installation of a new laser plasma cartridge. Last

Occurrence is the date of the last cartridge change in the mm/dd/yyyy format. The Last Occurrence date defines the beginning of the
Laser Power trend analysis. The default is 18.

Dye Change (months)
The Dye Change (months) is the number of months from the replenishment of the excitation dye in the dye laser. Last Occurrence

is the date the excitation dye was replaced in the dye laser in the mm/dd/yyyy format The Last Ocourrence date defines the
beginning of the Dye Strength trend analysis. The default is 3.

Reference Change (days)

The Reference Changs (days) is the number of days from the replenishment of the standard in the reference cuvette. Last
Occurrence is the date the standard was changed in the reference cuvette. The default is 7.

Scheduled Preventive Maintenance (months)

‘The Scheduled Preventive Maintenance (months) is the number of months from the last preventive maintenance service of the
KPA. The defaultis 12.
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Configuration Tabs Performance Settings

Performance Limits
The Performance Limits form contains three frames, an Active/Inactive checkbox, and a Database ID list box. The frames provide
control over KPA-specific data quafity metrics. The first frame contains general options. The second frame contains options for
Calibration Limits. The third frame contains options for Analysis Limits. Supervisor login with password reserves changes of this
tab to the supervisor. Otherwise, it is modified by any valid user.

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Sefect command
button. Select the Configuration ID to display and then clear the check mark.

List of Available Configurations

The List Test Box displays all available configurations for this configuration tab. Any active tab is selected from the list for the
background and retained throughout the batch.

Performance Limits Options

The Performance Limits Option frame provides a choice among three alternative uses of the Performance Limits tab: Use
Defaults, Use Site Custom, or Do Not Use Limits.

Use Defaults

The Use Defaults option button selects the 1000 Release configuration for Performance Limits. These limits are parameters
supplied by Chemchek Instruments Inc. as defaults for the software.

Use Site Custom
The Use Site Custom option buiton opens the Performance Limits Option configuration tab for user-specified entries.

Do Not.Use Limits

The Do Not Use Limits option button selects the 999 No Limits configuration for Performance Limits. This allows a site to DISABLE
the use of all the KPAWIn® software performance limits.
Calibration Limits

The Calibration Limits frame contains five metrics that relate to Maximum Background High Range, Maximum Background Low
Range, Calibration R Squared, Percent Discrepancy of Calibration Points, and Maximum Calibration Duration.

Maximum Background High Range

The Maximum Background High Range is the upper intensity limit of the Background used in the HIGH Range. If this limit is
exceeded, an Alarm is issued to the operator and the calibration halted until the situation is corrected. The default value is 25.

Maximum Background Low Range

The Maximum Background Low Range is a control that alarms when the intensity intercept for the Background exceeds the:
specification in the low Range. The default value is 1500,

Calibration R Squared

The Calibration R Squared is a control that alarms when the correlation coefficient of the least-squares regression of intensity
intercepts of calibration standards is less than the specification. The default value is 0.90.

Percent Discrepancy

The Percent Discrepancy is a control that alarms when the difference between the intensity intercept of a calibration standard and
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the value calculated from the calibration equation exceeds the specifi catlon The defaull value is 10,
Maximum Calibration Duration (days)

The Maximum Calibration Duration is a control that alarms when the difference between the analysis time/date for a sample and
the time/date for the calibration exceed the specification. The default value is 100 days.

Analysis Limits
The Analysis Limits frame contains seven analysis metrics that relate to minimum Sample R Squared, Minimum Sample Lifetime,
Maximum Sample Lifetime, Minimum Reference Lifetime, Maximum Reference Ratio Deviation, Maximum Gate Shifting, and
Maximum Gate Dropping.

Sample R Squared

The Sample R Squared is a control that alarms when the correlation coefficient of the least-squares regression of the corrected
sample intensities is less than the specification. The default value is 0.90.

Minimum Sample Lifetime (us)

The Minimum Sample Lifetime is a control that alarms when the lifetime of a sample is less than the specification. The default
value is 150.

Maximum Sample Lifetime (us)

The Maximum Sample Lifetime is a contro! that alarms when the lifetime of a sample exceeds the specification. The default value
is 350.

Minimum Reference Lifetime (us)

The Minimum Reference Lifetime is a control thal alarms when the lifetime of the reference is less than the specnr Ication. The
default value is 150. :

Reference Ratio (+/-)

The Reference Ratio is the reference intensity intercept at the time the sample is analyzed divided by the reference intensity
intercept at the time the background sample was analyzed. Sample intensities corrected for coincidence and smoothed (if
smoothing is selected in the Calibration Settings configuration tab) are divided by the Reference Ratio (if reference correction is
selected in the Calibration Settings configuration tab) to provide reference corrected sample intensities. To preclude division by
2ero, the default ratio is 0.2.

Gate Shifting

The Gate Shifting setting is the maximum difference between the Start LSR Gate specification in the KPA Unit Settings
configuration tab and the actual start gate of the least-squares regression of the corrected sample intensities. Gate Shifting from
the configuration specification occurs when the raw sample intensity of any time gate exceeds the Maximum Intensity Factor/Pulse
specification in the KPA Unit Settings configuration tab. The default is 20 gates.

Gate . Dropping
The Gate Dropping setting is the méximum difference between the Number of LSR Gates specification in the KPA Unit Settings
configuration tab and the actual number of gates in the least-squares regression of the corrected sample intensities. Gate

Dropping truncates the intensity vector at the first ime gate within the specification for the number of gates with a corrected
intensity less than the Minimum Intensity Factor specified in the KPA Unit Settings configuration tab. The default is 5 gates.
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Configuration Tabs Quality Contro! Limits Settings

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Select command
button. Select the Configuration [D to display and then clear the check mark.

List of Available Configurations

The List Test Box displays all available configurations for this configuration tab. Any active tab is selected from the list for the
background and retained throughout the batch,

Quality Control Limits
The Quality Control Limits contains five frames, an Active/Inactive checkbox, and a Database ID list box. The first frame contains
quality control options. The second frame contains detection limit options. The third frame contains calibration control options. The
fourth frame contains method control options. And the fifth frame contains sample interference control options. Supervisor login
with password reserves changes of this tab to the supervisor. Otherwise, it is modified by any valid user.

QC Limit Options

The QC Limits Options frame provides a choice among three alternative uses of the QC Limits tab: Use Defaults, Use Site Custom,
or Do Not Use Limits.

Use Defaults

The Use Defaults option button selects the 1000 Release configuration for QC Limit Options. These limits are parameters supplied
by Chemchek Inc. as defaults for the software.

Use Site Custom
The Use Site Custom option button opens the QC Limit Options configuration tab for user-specified entries.
Do Not Use Limits

The Do Not Use Limits option button selects the 999 No Limits for the QC Limits Options. This allows a site to DISABLE the use of
all the KPAWIn® software Quality Control Checks.

Detection Limits

The Detection Limits frame specifies parameters for the IDL, MDL, and CRDL. The DL and MDL parameters include Number of
Standards, Type of Statistic, Maximum Duration, Maximum Concentration Factor, and Limit. The CRDL list only pertains to Limit.

IDL/MDL / CRDL

The IDL & MDL & CRDL entries list specifications for the alternative detection limits, the number of standards required to estimate
a limit, the type of calculation used to estimate the limit, the maximum age of the data used in the estimation, the proximity of the
average true concentrations of detection standards to the estimated detection limit, and the maximum value of the estimated
detection limit.

Number of Standards

The Number of Standards specifies the number of Type 1 measuréments or Type 2 daily detection limits required for the estimation
of a detection limit. The default for IDL and for MDL is 7.
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Type

The Type detection limit is a KPAWIn® term specifying the data collection and analysis protocol used to estimate a detection lin
A Type 1 detection limit is the sample standard deviation of the most recently measured concentrations of a detection limit standard.
Each measurement consists of a single observation. The total number of measurements in the estimate must be equal to the
specified number of standards and the observations must be made within the number of weeks specified in the maximum duration.
A Type 2 detection limit is the average of a series of sample standard deviations. Each sample standard deviation is estimated from
a series of analyses of a single detection standard on a single day. Different standards with different true analyte concentrations
can be used on different days. The total number of standard deviations must be equal to the specified number of standards and the
observations must be made within the number of weeks specified in the maximum duration. The default for IDL and for MDL is 1.

Maximum Duration

The Maximum Duration is the maximum period in weeks that the detection limit data is collected. The default for IDL and for MDL
is 13. '

Maximum Concentration Factor

The Maximum Concentration Factor is the maximum observed average concentration of the detection limit standard(s) expressed
as a multiple of the detection limit. The default for IDL and for MDL is 5.

Limit ug/l
The Limit ug/l is the maximum acceptable value of a detection limit. The default for IDL and for MDL is 0.1 and for CRDL is 1.
Calibration Control

The Calibration Control frame specifies parameters for Initial and Continuing Calibration Control. Parameters include Blank and
Standard Error for bath the Initial and Continuing Calibration Contral.

Initial / Continuing

The Initial & Continuing entries list altérnalive control limits for analyte in a check blank and recovery of analyte from a check
standard. Initial limits confirm the performance of check samples immediately after calibration. Continuing limits confirm the
performance of check samples throughout and at the end of an analytical batch.

Blank (*IDL)

The Blank (*IDL) is the maximum acceptable concentration of a calibration check blank expressed as a multiple of the IDL. Unique
values are entered for the initial calibration check blank analyzed immediately after calibration or the continuing calibration check
blank analyzed subsequently. The default for Initial and for Continuing is. 3.

Calibration Control Standard Error (%)

The Standard Error is the maximum acceptable percentage difference between the true concentration of the calibration control
standard and its detected concentration. The erroris the absolute difference between the true concentration and the detected
concentration as a percentage of the true concentration. Unique recovery limits are entered for the initial calibration control
standard analyzed immediately after calibration or the continuing control standard analyzed subsequently. The defaults are 10 for
Initial and 20 for Continuing.

Method Control
The Method Control frame includes four alternative options for specifying the maximum concentration of the Method Blank Control
and the Standard Error of the Method Standard. Alternatives for the maximum acceptable Method Blank Control are MDL Multiple,
CRDL Percentage, Sample Percentage, or Use Highest of the Above (previcus three values).

MDL Multiple

The MDL Multiple is the maximum acceptable concentration of a method blank if the MDL Multiple or Use Highest of the Above
checkboxes are checked. The default is 3.
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CRDL Percentage

The CRDL Percentage is the maximum acceptable concentration of a method blank if the CRDL Percentage or Use Highest of the
Above checkboxes is checked. The defaultis 5.

Sample Percentage

The Sample Percentage is the maximum acceptable concentration of a method blank if the Sample Percentage or Use Highest of
the Above checkboxes is checked. The default is 5.

Use Highest of the Above

The Use Highest of the Above specifies the concentration of the method blank cannot exceed the largest of three values: the MDL
Muitiple, the CROL Percentage, or the Sample Percentage. CRDL is the acronym for contract reporting detection limit. The default
is unselected.

Method Control Standard Error (+/-%)

The Methed Control Standard Error +/- % is the maximum acceptable percentage difference between the true concentration of the
Laboratory Control Standard and its detected concentration. The error is the absolute difference between the true concentration
and the detested concentration as a percentage of the true concentration. The default is 25.

Sample Control

The Sample Control frame provides parameters to evaluate interference to analyte detection in samples. Control parameters
include Relative Percent Deviation (RPD), Spike Recovery, Serial Dilution Error and four values for the Method of Standard
Additions with a valid external calibration. The Method of Standard Additions values are Number of Spikes, Recovery Error, Slope
Error and R Squared.

Precision (%)

Precision is the Relative Percent Difference of a sample and a sample duplicate. The specification is the maximum acceptable
relative percent deviation of a sample and its duplicate. The deviation is the absolute difference of the observations as a percentage
of their average. The default is 20.

Splke Recovery (%)

The Spike Recovery is the maximum acceptable percent recovery of a known spike from a sample. The recovery is the difference
between true concentrafion of the spike in the sample and its incremental increase in concentration from the sample as a
percentage of the true concentration. The default is 15.

Serlal Dilution Error (%)

The Serial Dilution Error is the maximum acceptable percentage difference between observations of a sample and a dilution of the
sample corrected to their original concentrations. The error is the absolute difference between the serial dilution result and the
undiluted sample as a percentage of the serial dilution result. The default is 10.

Method of Standard Addition

The Method of Standard Addition entries list the number of sample spikes for comparison of the external batch calibration with the
internal spike calibration and the performance criteria for a protocol with multiple sample spikes.

Number of Spikes

The Number of Spikes specifies the number of unique spikes in a series of Method of Standard Addition samples, The Method of
Standard Additions uses the external batch calibration to estimate sample interference with the recovery of a known spike. Analysis
of the sample and three step-wise spike increases in analyte concentration also return estimates for the comparison of the external
and internal calibration slopes and the curvature of the internal calibration. The default is 1.

Recovery Error (%)

The MSA Recovery Error is the maximum acceptable percentage error in the recovery of a known spike(s) from a sample by the
Method of Standard Additions. The error is the absolute difference between the true analyte concentration of the spike and the
incremental increase in the concentration of the spiked sample as a percentage of the true concentration. The default is 25.
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Slope Error {%) ‘

The MSA Slope Error is the maximum acceptable percentage difference between the slope of the external calibration and the slo,
from the Method of Standard Additions for analyte recovery from the analysis of an unspiked sample and three spikes of the sample
with step-wise increases of the analyte. The error is the absolute difference of the slopes of the external and internal calibrations as
a percentage of the slope of the external calibration. The default is 20.

R Squared

The MSA R Squared is the correlation coefficient of the internal Method of Standard Additions calibration. The default is 0.96.
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Configuration Tabs Alarms & Warnings Settings

AIarmsIWarnings
The Alarms/Wamings form contains a listing of off-standard conditions with Alarm or Warning check boxes, a Stop Processing on
Alarm check box, an Active/Inactive checkbox, and a Database Id list box. Supervisor login with password reserves changes of this
tab to the supervisor. Otherwise, it is modified by any valid user. Defauilt selections are deselect.

InActive

The Inactive checkbox indicates the displayed configuration is NOT currently active. Activate by clicking the Select command
button. Select the Configuration 1D to display and then clear the check mark.

List of Available Configurations

The List Test Box displays all available configurations for this configuration tab. Any active tab is selected from the list for the
background and retained throughout the batch.

STOP KPA Processing on Alarms

The Check Alarms will STOP KPA Processing checkbox indicates that analysis is interrupted if a selected alarm tolerance is
exceeded. User response is required to resume normal analysis. .

QC Alarms/Warnings
This display lists the KPA and KPAWIn® failure modes that alarm or warn of off-standard analytical conditions. Failure modes of

‘concern and responses are selected by the site supervisor. The tolerancs level of alarms is set to specnf cauons in the
configuration tabs. The Alarms / Warnings Messages are listed next. -
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Alarms / Warnings Message List

Alarm / Warning #1

Alarm / Warning #2

Alarm / Waming #3

Alarm / Warning #4

Alarm / Warning #5

Alarm / Warning #6

Alarm / Warning #7

Alarm / Warning #8

Alarm / Warning #9

Alarm / Warning #10
Alarm / Wamning #11
Alarm / Warning #12
Alarm / Warning #13
Alarm / Warning #14
Alarm / Warning #15
Alarm / Warning #16
Alarm / Warning #17
Alarm / Warning #18
Alarm / Warning #19
Alarm / Warning #20
Alarm / Warning #21
Alarm / Warning #22
Alarm / Warning #23
Alarm / Warning #24
Alarm / Warning #25
Alarm / Warning #26
Alarm / Warning #27
Alarm / Warning #28
Alarm / Warning #29
Alarm / Warning #30
Alarm / Warning #31
Alarm / Warning #32
Alarm / Warning #33
Alarm / Warning #34
Alarm / Warning #35
Alarm / Warning #36
Alarm / Warning #37
Alarm / Warning #38
Alarm / Warning #39
Alarm / Warning #40
Alarm / Warning #41
Alarm / Warning #42
Alarm / Warning #43
Alarm / Warning #44
Alarm / Warning #45
Alarm / Warning #46
Alarm / Warning #47
Alarm / Warning #48
Alarm / Warning #49
Alarm / Warning #50
Alarm / Warning #51
Alarm / Warning #52
Alarm / Warning #53
Alarm / Warning #54
Alarm / Waming #55
Alarm / Warning #56

Background High - High Range

Background High - Low Range

Calibration Correlation (R Squared) Low - High Range
Calibration Correlation (R Squared) Low - Low Range
Calibration Standard Discrepancy High - High Range
Calibration Standard Discrepancy High - Low Range
Maximum Calibration Age Exceeded

Sample Correlation (R Squared) Low

Sample Lifetime Low i

Sample Lifetime High

Reference Lifetime Low

Reference Ratio High

Reference Ratio Low

Gate Shifting Excessive

Gate Dropping Excessive

Sample Concentration Out of Calibration Range

Too Few Valid Time Gates For Evaluation

Sample Concentration High For Low Range

Sample Concentration Low For High Range

Dye Output Low

Laser Plasma Cartridge Output Low

Laser Piasma Cartridge Age Exceeds Service Life

'Dye Age Exceeds Service Life

Reference Age Exceeds Service Life
Schedule Preventive Maintenance
Too Few Calibration Points - High Range
Too Few Calibration Points - Low Range
Initial Calibration Check Blank High - High Range
Initial Calibration Check Blank High - Low Range
Initia] Calibration Check Standard invalid - High Range
Initial Calibration Check Standard Invalid - Low Range
Continuing Calibration Check Blank High - High Range
Continuing Calibration Check Blank High - Low Range
Continuing Calibration Check Standard Invalid - High Range
Continuing Calibration Check Standard Invalid - Low Range
Too Few IDL Standards - Type 1 1DL
Too Few IDL Averages - Type 2 IDL
Average Concentration of IDL's High
IDL Above Maximum Acceptable Value
Too Few MDL Standards - Type 1 MDL
Too Few MDL Averages - Type 2 MDL
Average Concentration of MDL's High
MDL Above Maximum Acceptable Value
Relative Percent Deviation High
Sample Spike Recovery High
Sample Spike Recovery Low
Serial Dilution Recovery High
Serial Dilution Recovery Low
Multiple MSA Spike Recovery High
Multiple MSA Spike Recovery Low
MSA Spike Recovery High
MSA Spike Recovery Low
Multiple MSA Slope Error High
Multiple MSA Calibration Correlation (R Square) Low
MDL Multiple Exceeds Min Sample Resuilt
CRDLY% Exceeds Min Sample Result
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Alarm / Warning #57
Alarm / Warning #58
Alarm / Warning #59
Alarm / Warning #60
Alarm / Warning #561
Alarm / Warning #62
Alarm / Warning #63
Alarm / Warning #64
Alarm / Warning #65
Alarm / Warning #66
Alarm / Warning #67
Alarm / Warning #68
Alarm / Warning #69
Alarm / Warning #70
Alarm / Warning #71
Alarm / Warning #72
Alarm / Warning #73

‘Alarm / Warning #74

Alarm / Warning #75
Alarm / Warning #76
Alarm / Warning #77
Alarm / Warning #78
Alarm / Warning #79
Alarm / Warning #80
Alarm / Warning #81
Alarm / Warning #82
Alarm / Warning #83
Alarm / Warning #84
Alarm / Warning #85
Alarm / Warning #86
Alarm / Warning #87
Alarm / Warning #88

Sample % Exceeds Min Sample Result

MDL Muttiple, CRDL%, or Sample % Exceeds Min Sample Result
Method Standard Invalid - High Range

Method Standard Invalid - Low Range

Precounts High For High Range

Precounts Low For High Range

Precounts High For Low Range

No Concentration Unit Conversion Available

Units Conversion / Check Specific Gravity

Units Conversion / Check Specific Activity

Units Conversion / Check Atomic Mass

Invalid Reference Intensities

No Background - High Range

No Background - Low Range

Gate Shifting

Gate Dropping

Sample Intensity Intercept Below Background

Sample Intensity Intercept Below Quenched Background
No Calibration - High Range

No Calibration - Low Range

No Basis Sample For Sample Duplicate

No Basis Sample For Sample Spike

No Basis Sample For Quenched Background

No Basis Sample For Method of Standard Addition

No Basis Sample For Standard Addition Spike

No Basis Sample For Serial Dilution

Reference Correlation (R Squared) Low

Reference [ntensity Low

Reference Intensity High

Maximum of 7 Calibration Standards Exceeded Oldest Ignored — High Range
Maximum of 7 Calibration Standards Exceeded Oldest Ignored — Low Range
Sample Concentration High For High Range
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KPAWIn© General Display Documentation

"Kinetic Phosphorescence Analyzer System”

“Contacts”

The "Contacts" button displays the Chemchek contacts, street address, email address, phone number and fax number.
"OK"

The "OK" button exits the "About KPAWIn" display and returns to the previous display.
"Technical Info" .

The "Technical Info" button displays the KPAWIN® hardware and software requirements to run the KPAWIn® software
package.
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"Customer Administration Menu"

Summary Description
The Customer Administration form has a number of text areas that contain customer information: name, address, contact
person, telephone numbers, and if applicable, e-mail address. It also contains a checkbox indicating if the above fisted
customer is Active or Inactive. Setting or clearing the checkbox changes the Active/lnactive Status. If the Select button is

depressed, a list of current customers from the KPAWIn@ Database is displayed. The user then selects one of these
customers and the database information populates the customer text areas with the database entries.

"Customer Dropdown List"

The "Customer” drop-down list displays all Customers currently stored in the KPAWIN® Database. It is displayed when the
Select button is depressed.

"Inactive Customer™

The "Inactive" checkbox identifies a Customer that is not currently Active.

“Add"”

The "Add" button opens a new Customer Administration form and positions the cursor in the first entry of the form,
"Apply"

The "Apply" button updates the KPAWIn® Database and returns to the Customer Administration display.
"Cancel"

The "Cancel” button restores the Customer List form and the KPAWIn® Database to the original values, exits the current
display and returns to the previous display.

"Clear Entries"
The "Clear" button clears all existing data from the Customer Administration screen and returns to the current display.
IUOKII

The "OK" button updates any record in the Customer Administration form and the KPAWIn® Database, exits the current
display and returns to the previous display.

"Select”

The "Selest’ button queries the KPAWIN® Database and displays a drop-down list of all active Customers in the Database.
The user then selects a Customer entry to edit.

"Customer List”
The "Customer List" frame manages customer accounts. Accounts are created, edited, marked as active or inactive, and
entered into the KPAWIN® database. Each account contains the following locator information: name, address, FAX
number, e-mail address, customer contact, and customer telephone number.

"Customer ID”
The “Customer Id” identifies the Customer or Project that submitted the sample. The laboratory can identify calibration and
control samples. This fielkd must be completed for all samples. All active Customer [ds are viewed in the Customer Id drop-
down list of the Sample Input form. .

"Customer Contact"

Position of Customer's contact person(s).
Page 67




"Customer's Telephone Number”
Telephone number of Customer’s contact person(s).
"Customer's Fax Number"
Customer's Fax number. Delimit fields according to modem standards for direct dial capab_ility.
"Customer’s Email Address”
Customer's e-mail address.
"Customer's Name"
Customer’s name.
"Customer’s Address"
Customer's street address.
"Customer’s City”
Customer’s city.
“Customer’s State"
Customer's state.

"Customer's Zip Code"

Customer’s ZIP code.
"Customer's Country”

Country where the Customer is located. |
"Customer’s First Name”

First name of Customer’s contact person(s).
"Customer’s Last Name" '

Last name of Customer’s contact person(s).
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"Calibration Report"

Summary Description

The "Calibration Report” displays the results of the calibration. The report includes the results and evaluation of the
calibration by range for the background and standards.

"User Cal"
The *User Cal’ checkbox disables the automatic calibration and permits the user to either exclude or include each of the

calibration points. When this item is selected, the Calibration Id text item is also enabled and the user may enter a unique
name for the calibration.

"Calibrate"

The “Calibrate” button forces a recalibration of the KPA with the User's selection of equations, configurations, and
calibration standards. When completed, the new results are updated on the same Calibration form.

"Plot"
The “Plot” button displays calibration curves for intensity intercepts versus calibration standard concentrations for all
calibrated ranges. The button toggles between Piot to display the curves and Grid to display the data and results.

"OK"
The "OK" command button exits the calibration display and returns to the previous display.

"Print”
The “Print” button queues both calibration grid information, if it is on display, as well as the plots, if they are on display, to
the system-selected printer.

"Save As”

The “Save As" command is only displayed when the plots are being displayed. It saves the calibration plots to a user-
selected file for display or printing at a later time.

"Calibration Details™
“Calibration Details" identifies the Laboratory, Customer, Analyst, Procedure, and Calibration Configuration Ids.
"High Range Details"

*High Range Details” identifies the high-range Calibration Id, Minimum Number of Standards used in the Calibration,
Alarms that were selected and exceeded, the Calibration R 2, and Calibration Variance.

"de Range Detalls"

"Low Range Details” identifies the low-range Calibration Id, Minimum Number of Standards used in the Calibration, Alarms
that were selected and exceeded, the Calibration R 2, and Calibration Variance.

"Calibration Grid Information"

The Calibration grid displays the Calibration Range, a Use Flag, the Sample Ids, Sample Types, Standard Concentrations,
Standard Ids, Intercepts, Uncertainties, Percent Discrepancies, Descriptions, Date/Times, Time Gates, Reference Ratios,
Lifetimes, Calibration R 2 Intensities, and the Integrated Intensities. Use flags include “+", "-* and * *. KPAWIn®@
automatically assigns a "+ flag to qualified calibration points that are included in the default calibration or a *-* flag for
invalid points. Selection of the User Cal checkbox permits the user to select by toggling between “+" for included and * * for
notincluded. Toggling the flag is accomplished by Double-Left Clicking with the mouse on the standard flag “+" or * *.
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“Lab ID" ' .

The "Lab Id” indicates the identity of the performing laboratory. Complete information for the laboratory is contained in the
Laboratory Database accessed from the menu bar.

"Customer ID”

The “Customer Id” indicates a specific source of samples to be quantitated by the calibration. Complete information for
the customer is contained in the Customer Database accessed from the menu bar. The Lab Id can be used as default.

"Analyst”

The “Analyst” establishes the identity of the Iaboratory'employee performing the calibration. Complete information for the
analyst is contained in the User Administration Database under Security accessed from the menu bar.

"Procedure ID”

The "Procedure 1d” indicates the formal laboratory method(s) that were used 1o analyze the background and calibration
standards. Complete information for the procedure is contained in the Procedure Database accessed from the menu bar.

"Cal Config ID"

The “Calibration Configuration Id” identifies the Calibration Settings Configuration tab used to collect the calibration data.

"High Calibration ID"

The “Calibration Id” identifies a unique high-range calibration for a specific background analysis and specific calibration
standard analyses by a linear or quadratic equation by least-squares regression that forces the fit through zero
concentration for zero net intensity or does not force the fit through zero. If the User Cal checkbox is checked, the user
may delete standards and change the order and intercept of the calibration equation.

"jMin Nb Stds"

The “Minimum Number of Standards” specifies the smallest number of calibration standards requu'ed for a given hlgh-
range calibration.

"Alarms"
“Alarms” lists the user-specified performance measures in the Alarm/Warning Configuration tab violated by the high- range

calibration. Alarms are listed with an “A” prefix. Warnings are listed with a "W" prefix. The specific off-standard condltlon is
indicated by a unique two-digit number.

"High R Squared"

"R Squared" is the correlation coefficient of the least-squares regression of the background and calibration standards for
the high-range calibration. -

"Variance"
The “Variance” is estimated from the differences between the true concentrations of the background and calibration

standards for the hlgh-range calibration and the concentrations estimated for their analytical intercept intensities from the
calibration equation.

"Cal Eq Type"

The “Calibration Equation Type" for the high-calibration range is either linear for a first order relation of intercept intensity
fo concentration or quadratic for a second order relationship between intercept intensities and cancentrations.

llcal qul

The "Calibration Equation” is the high-range calibration equation with concentration as the independent variable and
intercept intensity as the dependent variable.
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"Low Calibration ID"
The “Calibration Id” identifies a unique low-range calibration for a specific background analysis and specific calibration
standard analyses by a linear or quadratic equation by least-squares regression that forces the fit through zero
concentration for zero net intensity or does not force the fit through zero. If the User Cat checkbox is checked, the user
may delete standards and change the order and intercept of the calibration equation.

"Min Nb Stds"

The "Minimum Number of Standards” specifies the smallest number of calibration standards required for a given low-
range calibration.

"Alarms"
"Alarms’ lists the user-specified performance measures in the Alarm/Warning Configuration tab violated by the low-
range calibration. Alarms are listed with an “A” prefix. Warnings are listed with a "W’ prefix. The specific off-standard
condition is indicated by a unique two-digit number.

"Low R Squared”

"R Squared" is the correlation coefficient of the least-squares regression of the background and calibration standards for
the low-range calibration.

"Variance"”
The “Variance" is estimated from the differences between the true concentrations of the background and calibration
standards for the low-range calibration and the concentrations estimated for their analytical intercept intensities from the
calibration equation.

"Cal Eq Type"”

The “Calibration Equation Type” for the low-calibration range is either linear for a first order relation of intercept intensity
to concentration or quadratic for a second order relationship between intercept intensities and concentrations.

llcal Eq"

The “Calibration Equation” is the low-range calibration equation with concentration as the independent variable and
intercept intensity as the dependent variable.
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"KPA Confidence Testing”

Summary Description

The "Confidence Test" report displays the coefficient of variation for a series of analyses on the same sample that are
run in uninterrupted order without changing cuvettes or any KPA parameter. This parameter measures the stability of
the analytical system. The coefficient of variation in the standard deviation of the intercepts of the intensity data that
have been corrected for coincidence and been smoothed. No prior background analysis is required. The coefficient of
variation is the ratio of the standard deviation of the replicate measurements divided by their true (makeup)
caoncentrations. Instrument inputs to the test are the Number of Confidence Test Repeat Analyses in the Maintenance
Configuration Tab and the Number of Pulses in the KPA Unit Settings Configuration Tab.

"Exit"
| The “Exit’ command button closes the Confidence Test display and returns to the previous display.
"Help” |
The “Help’ command button displays the KPAWIn® Help contents screen.

"Sample ID"”

The "Sample Id" displays the Sample Id of the Confidence Test.
“Standard ID"

The “Standard Id” displays the laboratory identification of the standérd that is used to conduct the Confidence Test:
"Coefficlent of Variation" |

The “Coefficient of Variation” displays the dimensionless quotient of the standard deviation of the replicate intensity
intercepts divided by their true (makeup) concentration. : :

"Description”
The “Description” is the name of the Confidence Sample.
"Standard Concentration"
The “Standard Concentration” displays the true {(makeup) concentration of the Confidence Test sample.

“Confidence Test Grid”

The “Confidence Test Grid” displays the Sample Range, Analysis Run Numbers, Integrated Intensities, Sample
Intercepts, R Squares, Life Times, Life Time Errors, and Variances for each analysis run in the Confidence Test.
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"KPA Confidence Test Report"

Summary Description

The "Confidence Test" report displays the coefficient of variation of a series of analyses on the same sample under
identical analytical conditions. These results demonstrate the stability of the analytical system.

llAbortll

The *Abort” command button terminates the Confidence Test. It does not interrupt a KPA analysis in progress but stops
(Abort) when the current analysis on the KPA Unit is completed.

"OK"
The "OK" command button accepis a completed Confidence Test, exits the display and returns to the previous display.
"ReRun™
The “ReRun" command button repeats the specified Confidence Test.
"Coefficient of Variation"

The “Coefficient of Variation® displays the results of the Confidence Test. A series of confidence tests that produce
monotonic decreasing results may indicate that a “cold” instrument or activated optics has not stabilized. Fluctuating
results may indicate an excitation or emission detection problem exists.
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"KPA Win Main Display"

Summary Description

The KPAWIN© Main automatically displays after a successful login. From this screen, the user selects various KFAWIN©
functions using either the Too! Bar or the drop-down menus. The major portion of this display is reserved as the display area
for all subsequent KPAWIN® displays.

"KPAMain Toolbar"
Login Menu - This button displays the Login form to log into the KPAWIn® software.
Logout Menu - This button logs the current user from the KPAWIn® software.
Exit KPAWin - This button closes the KPAWIN® software Analyze Menu.
Input Form - This button displays the Sample Input form.

Sample Reports - This buiton displays the Select Sample Report form, allowing a user to select not only which Samples to
report but also the type of report to display or print.

Configuration Tabs - This button displays the Configuration Tab form to select an existing configuration. or create a new
configuration.

Initialize KPA - This button displays and executes the Power-On-Confidence tests (POC) and processes and reports the
results of these tests on the initialization form.

Tickler Menu - This button displays the Tickler Menu to provide a view of the maintenance dates from the Maintenance
Configuration Tab.

Help Menu - This displays the Help information about the KPAWIN® software.

Page 74




"KPAMain Drop-down / Popup Menu ltems"

"Analyze"

The "Analyze" menu displays a drop-down list: Sample Input, Analyze, Analyze All, Calibrate, and four dispositions for
analyzed samples. Of these, only Sample Input can be accessed until a Sample Input form is displayed. The Sample Input
form is used to input sample data, select samples to measure, and dispose of results according to Accept, Reject, or
Reprocess. Sample dispositions are available from the Analyze drop-down list and a popup menu on the Sample {nput form.
These functions are available in a drop-down menu and cannot be accessed through the Sample Status window of the
Sample Input form. '

"Sample Input"

The "Sample Input" item of the Analyze drop-down list displays the Sample Input form that contains the data for sample )
specification and analysis. The form consists of four portions: the Sample Input button bar, a pop-up command list, the detail
of the current sample, and the input for all samples in the analytical batch. The button bar includes Open Initial Sample, Save
As Initial Sample, Add New Sample, Cut, Copy, Paste, Clear Selection, Delete Selection, Cancel input, Exit Input, and Help
Input. The pop-up menu list is called with the right mouse button and contains all the items in the Analyze and Edit menu
drop-down lists. The current sample detail contains the information for the currently highlighted sample. Data fields can be
completed from the user’s keyboard or from option lists. The analytical batch input contains all the sample information for the
current analytical batch. Data fields are collapsed or restored by drag-and-drop mouse movements to create a customized
view of the form stored as a preference of a specific user. The custom view is restored each time the user logs onto
KPAWIR®. : :

"Analyze"

The "Analyze" item of the Analyze drop-down list initiates the analysis of samples selected in the first column of the Sample
Input form if they are marked "Entered" or "Reprocess". This ltem is active when the Sample Input form is Active.

“"Analyze All"

The "Analyze All* item of the Analyze drop-down list initiates the analysis of all samples in the Sample Input form if they are
marked "Entered" or "Reprocess". This Item is active when the Sample Input form is Active.

"Calibrate"

The “Calibrate” item of the Analyze drop-down list displays the input information to the calibration process and the results of
the calibration. The input consists of the header information and the results from the analysis of the background and
standards for a calibration. .

"Database”

The "Database" menu displays a drop-down list: Open, Repair, Pack, Archive, Customer Administration, Procedure
Administration, Units Administration, and Laboratory Administration. Open, Repair, Pack, and Archive are utilities of
Microsoft ACCESS that are used to manage the KPAWIN® database. The four administration databases document the
spegcifications that are referenced in the KPAWIN® database and qualify the data.

"openll

The "Open" item of the Database drop-down list opens a database that is different from the default. Examples include a
Demo database, an alternative operational database, or an Archive database to look at past history. i

"Repair"

The "Repair" item on the Database drop-down list attempts a repair of a corrupted database. If this fails, the recourse is to
restore from a backup.

"Units Administration”

The "Units Administration” item on the Database drop-down list displays the Units Administration form. The form is used to
add, change, or inactivate a unit's entry. The KPAWIn® database stores units in ug/ for concentrations and | for volumes.
Beyond the unit conversions embedded in KPAWIn®, alternative units must be regisfered with the Units Administration
database. After registration, user preferred units can be specified in the Calibration Setlings configuration tab for a sample
batch and refined in the Sample Input form for an individual sample. Inputted and reported units are converted between
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those of the database and those preferred by the user.
"Laboratory Administration”

The "Laboratory Administration” item on the Database drop-down list displays the Laboratory Administration form The form
adds, changes, or inactivates a laboratory entry.

"Pack"

The "Pack" item on the Database drop-down list reduces the size of the database (i.e. Removes unused space). This
normally would be done after an Archive and Delete.

*Archive"

The “Archive" item on the Database drop-down list archives the database data between the selected dates. The KPAWIN®
database should be backed up before an Archive is done. The Archive copies the sample data and associated records for
the selected dates to another or a new database and then deletes the Archived Sample data from the current database. A
Pack will be done automatically at this time. When data is Archived, Customers, Procedures, and Configuration Entries are
not deleted unless they are marked inactive and are not being used by any records remaining in the database after the
archive.

"Customer Administration"

The "Customer Administration” item on the Database drop-down list displays the Customer Administration form. The form
adds, changes, or inactivates a customer entry.

"Procedure Administration"

The "Procedure Administration" item on the Database drop-down list displays the Procedure Administration form. The form
adds, changes, or inactivates a procedure entry.

"Probe KPA Unit"

The "Probe KPA Unit" on the Tools drop-down list executes the KPA Power-On-Confidence (POC) Initialization tests. These
tests are also accessed with real-time status reports from Initialization on the button bar.

llEditll
The "Edit" menu supports the Sample Input form and provides seven sample-edit options and three data field edit options.
The sample options are Add, Insert After, Insert Before, Move Selected, Clear, Delete, and Delete All. The data field edit
options are Copy, Cut, and Paste.

"cut"
The "Cut" option on the Edit drop-down list is active when the Sample Input form Is active and data is being entered via the
data text boxes. It deletes the selected data field and copies it to the clipboard.

llcopy"
The "Copy" option on the Edit drop-down list is active when the Sample Input form is active. If a text box is active, the
selected data field is copied to the clipboard. If grid columns are selected and the grid is active, the Selected Grid column in
the first selected row is copied to a KPAWIN® array.

"Delete”
The "Delete” option on the Edit drop-down list is active when the Sample Input form is active. it deletes the sefected Sample
Input records. Analyzed samples are marked as rejected. Samples to be analyzed are removed from the database.

"Delete All"

The "Delete All" option on the Edit drop-down list is active when the Sample lnput form is active. This is the same as Delete,
axcept that all records in the current Sample Input are removed, -
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"Paste"

The "Paste" option on the Edit drop-down list is active when the Sample Input form is active. If a text box is active, the
selected data field is replaced with the clipboard contents. If grid columns are selected and the grid is active, columns from
the first selected row are replaced with the KPAWINn® array contents. The columns replaced are the ones from which the
data was copied.

IIAddll

The "Add" option on the Edit drop-down list is active when the Sample Input form is active. The Add command inserts a
copy of the currently selected sample record to the end of the Grid.

"Insert After”

The "Insert After” option on the Edit drop-down list is active when the Sample Input form is active. This is the same as the
Add command except that the new sample record is placed after the selected record.

"Insert Before"

The “Insert Before" option on the Edit drop-down list is active when the Sample Input form is active. This is the same as the
Add command except that the new sample record is placed before the selected record.

"Move Selected"”
The "Move Selected" option on the Edit drop-down list is active when the Samble Input form is active. The selected sample
records are moved to a new location in the Grid. The user is prompted for the new row number where the selected rows are
to begin.

"Clear"

The "Clear" option on the Edit drop-down list is active when the Sample Input form is active. The command resets all data
fields for a sample to the default values for the sample type. :

"File"
The "File" menu manages the Sample Input form and provides an exit from KPAWIN® and printing of KPAWIn® reports or
figures. Alternative Sample Input forms can be called or saved.

Ilopenll
The "Open" option on the File drop-down list is active when the Sample Input form is active. This opens the Initial Sample
dialog box and allows the user to load previously saved sample input data.

“Save As"
The "Save As" option on the File drop-down list is active when the Sample Input form is active. This opens the Initial Sample
dialog box and allows the user to save sample-input data for later loading by the Open command.

llExitll
The “Exit" option on the File drop-down list closes the KPAWIN® program.

llHelp'l ’
The "Help menu” displays a drop-down list: Contents, Search, Technical Conta_cts, and About KPAWIN.

"Contents"

The "Contents" option on the Help drop-down list displays the list of topics available in the KPAWIn® Help file.
"Technical Contacts”

The "Technical Contacts” option on the Help drop-down list displays the alternative methods that users can use to contact
Chemchek Instruments, Inc¢.
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"About KPAWin"
The "About KPAWin" option on the Help drop-dowh list displays the About KPAWIN® form. The form provides copyright
information and further information on Contacts and Technical Information. Contacts is the same as the *Technical Contacts"
option with a return to the About KPAWIn® form. Technical Information lists the hardware requirements for KPAWIN® with a
return to the About KPAWIn® form through the Contacts screen.

"Reportsll
“Reports” provides the Selection iter that displays the Select Sample Report form.

“Selection”

“Selection” displays the Select Sample Report form allowing a user to select the samples to report and the type of report to
display or print. . : . .

"frend"
“Trend" displays the Trend Report form that graphs the performance of the Laser Plasma Cartridge and Dye Laser.
“"Security" _ |
“Security” displays the three Security functions of Login, Logout, and User Administration.
"Login" |
“Login" allows a user or a supervisor to Log Into the KPAWIN® software.
"Logout”
“Logout” allows a user or supervisor to Log Off the éurrerﬁ KPAWIN® session,
"User Administration”

“User Administration” displays the User Administration form that allows supervisors to Add, Inactivate, or Change user
entries. :

"Settings"

The “Settings” menu item displays the General Configuration selection. Once selected, all the Configuration Tabs are -
available to the user.

"Analyze"

The "Analyze" item on the pop-up menu initiates the analysis of samples selected in the first column of the Sample Input
form if marked "Entered" or "Reprocess". This item is active when the Sampie Input form is Active.

"Analyze All”

The "Analyze All" item on the pop-up menu initiates the analysis of all samples in the Sample Input form if marked "Entered"
or "Reprocess”. This ltem is active when the Sample Input form is Active.

"Calibrate"

The “Calibrate” menu item on the pop-up menu initiates the interpretation of the calibration standards and attempts to
calibrate both the High and Low ranges. It produces and displays the calibration report when completed.

"Accept”

“Accept”, from the pop-up menu, enables the user to mark the measured sample as OK,
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"Reject”

“Reject”, from the pop-up menu, enables the user to mark the measured sample as discarded. The sample is not selected
when sample data are retrieved for reports.

"Reprocess”

“Reprocess’, from the pop-up menu, enables the user to mark a sample for reanalysis. The previous measured data is
deleted at this time.

llAddlI

The "Add" option on the pop-up menu is active when the Sample Input form is active. The Add command inserts a copy of
the currently selected sample record to the end of the grid.

"Insert Before”

The "Insert Before" option on the pop-up menu is active when the Sample Input form is active. This is the same as the Add
command except that the new sample record is placed before the selected record.

"Insert After”

The "Insert After” option on the pop-up menu is active when the Sample Input form is active. This is the same as the Add
command except that the new sample record is placed after the selected record.

"Move Selected"
The "Move Selected” option on the pop-up menu is active when the Sample Input form is active. The selected sample
records are moved to a new location in the grid. The user is prompted for the new row number where the selected rows are
to begin.

"Clear Sample"

The "Clear” option on the pop-up menu is active when the Sample Input form is active. The command resets all data fields
for a sample to the default values for the sample type.

"Delete”

The "Delete” option on the pop-up menu is active when the Sample Input form is active. [t deletes the selected Sample Input
records. Analyzed samples are marked as rejected. Samples to be analyzed are removed from the database.

"Delete All"

The "Delete All" option on the pop-up menu is active when the Sample Input form is active. This is the same as Delete,
except that all records in the current Sample Input are removed.

"Tools"

The “Tools” menu item displays the available items of AutoChanger (Reset or Rinse), Diagnostics {Probing KPA Unit), and
Calculator functions.

"Calculator"

This item invokes the system Calculator from within the KPAWIN® software and makes it available to the users.
"Window"

The "Window” menu displays the four Window items available: Tile Horizontal, Tile Vertical, Cascade, and Close All.
"Tile Horizontal” |

The “Tile Horizontal® option on the Window menu tiles the open KPAWIN® display windows horizontally.
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"Tile Vertical"

The “Tile Vertical" option on the Window menu tiles the open KPAWIN® display windows vertically.
"Cascade™

The “Cascade” option on the Window menu cascades the open windows within the KPAWIN® display area.
"Close Al

The °Close All” option on the Window menu closes all open windows within the KPAWIR® display area except Sample
Input.
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"Laboratory Administration Menu"

Summary Description
The Laboratory Administration form has a number of text areas that contain laboratory information: name, address, contact
person, telephone numbers, and if applicable, email address. It also contains a checkbox indicating if the above listed
laboratory is Active or Inactive. Setting or clearing the checkbox changes the Active/lnactive Status. If the select button is
pushed, a list of current Laboratories from the KPAWIn® Database is displayed. The user then selects one of these
Laboratories and the database information populates the laboratory text areas with the database entries.

“Laboratory Dropdown List"

This "Laboratory” drop-down list displays all Laboratories currently stored in the KPAWIn® Database. It displays when the
Select button is depressed.

"Inactive Laboratory "

The “Inactive" checkbox identifies a laboratory that is not currently Active.
“Add " ‘ -

The "Add" button opens a new Laboratory Administration form and positions the cursor in the first entry of the form.
"Apply"

The "Apply" button updates the KPAWIn® Database and returns to the Laboratory Administration display.
“Cancel"

The "Cancel” button restores the Laboratory Administration form and the KPAWiIn® Database to the original values, exits
the current display and returns to the previous display.

"Clear Entries"
The "Clear" button clears all existing data from the Laboratory Administration screen and returns to the current display.
"OK"

The "OK" button updates any record in the Laboratory Admlnlstratlon form and the KPAWIn®© Database, exits the current
display and returns to the previous display.

"Select"

The "Select” button queries the KPAWIN® Database and displays a drop-down list of all active Laboratories in the
Database. The user then selects a laboratory entry to edit.

“Laboratory Administration List"

The “Laboratory Administration” list manages information about the servicing laboratory or laboratories. Laboratory
accounts are created, edited, marked as active or inactive, and entered into the KPAWIN® database. Each account
contains the following descriptors: |d, name, address, Fax number, e-mail address, laboratory contact, and contact
telephone number.

"Laboratory Contact Person Information”

The “Laboratory Contact Person Information” identifies the laboratory's contact person(s) and how to communicate with
them.

"Laboratory ID"

The "Laboratory Id" identifies the laboratory that performs the sample analysis. This field must be completed for all
samples.
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"Laboratory Fax"

The “Laboratory’s Fax Number” identifies the telephone number that the laboratory uses to send and receive facsimiles.

Fields can be delimited according to modem standards for direct dial capability.
"Laboratory Email Address"

The 'Labofatory Email Address” is the internet account of the laboratory.
“Laboratory'Name"

The “Laboratory Name” is the registered name of the laboratory.
"Laboratory Address”

The “Laboratory Address” is normally the street address that is used to accept freight.
"Laboratory City"

The "Laboratory City” is the city where the laboratory is Ioéated.
“Laboratory State”

The “Laboratory State” is the state where the laboratory is located.
“Laboratory Zip Code"

The “Zip Code" is the Zip code Mere the laboratory is located.
"Laboratory Contact First Name"

The “Laboratory Contact First Name” is the first name of the [aboratory contact.
"Laboratory Contact Last Name"

The "Laboratory Contact Last Name" is the last name of the laboratory contact.
"Laboratory Contact Telephone Number"

The "Laboratory Contact Telephone Numbef’ identifies the telephone number of the Laboratory’s contact person(s).
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"KPAWIn® Login Screen"

Summary Description

The Login form is displayed whenever anyone attempts to login to the KPAWIN® software. It solicits the User Id and
Password during the login sequence for all users attempting to gain access to the KPAWIn® system. Customer sites have
the option of using either or both of these security measures. If no User Id or Passwords are entered into the system by a
system supervisor, anyone can start the KPAWIn® software and browse the contents of the KPA database to view
previously analyzed samples and analyze new samples.

The screen contains two text entries, the User Id and the Password. When a user requires the use of the KPAWIN®
software, the system supervisor must create an entry {using User Administration) by entering a new User Id and optionally,
a password for the new user. Each time this or any user attempts to gain access to the system, they are required to enter
these data during the login sequence. The use of passwords is optional.

The form requires one of two possible entries. All user information is stored in the KPAWIN®© database. If user sites elect
to use this security option, supervisors enter a User Id and Password for each new user to the system.

The selection box contains all current active User Ids. Anyone attempting to access the software can list these valid users
and select the appropriate entry. If the customer site elects to also use passwords, every user is required to enter the
correct password for the user name specified.

"User Dropdown List"

The "User" drop-down list contains all current, valid User Ids. To logon, a user must select his/her User id. During a
successful login, KPAWIn® restores system defaulls to those selected by the specific user during hisfher last session.

"Cancel"”

IIOK"

The “"Cancel" button terminates the login sequence, exits the display and returns to the main Idle display.

The "OK" button initiates a verification of the Login entries. If the entries are valid, the login is accepted, default values for
KPAWIN® are set to those specified by the user during the user's last KPAWiIn© session, the login display is exited and
the main KPAWIn® display is opened. If the entries are invalid, the user is advised and the login display is retained.

"Passwords”

The “Password” is a site-selected option that is entered at Login. Users are required to enter the correct, user-specific
password during each login sequence.
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"Procedure Administration"

| Summary Description

The “Procedure Administration” form has a number of text areas that contain procedure information, Procedure Id, Title,
| Revision, and Protocol, It also has a checkbox to indicate if the above listed procedure is Active or Inactive. Setting or
| clearing the checkbaox changes the Active/lnactive Status. In addition, if the select button is pushed, a list of current

procedures from the KPAWin® Database is displayed. The user then selects one of these procedures and the database
information populates the text areas with the database entries.

"Procedure List”

The “Procedure List” drop-down list displays all Procedures currenuy entered in the KPAWIN® Database. It displays
whenever the Select button is depressed.

"Add"
The "Add" button opens a new Procedure form and positions the cursor at the first entry of the form.
"Apply"
The "Apply" button updates the KPAWIn©® Database and returns to the Procedure' Administration display.
’ "Cancel" '
|
|
|

The "Cancel” button restores the Procedure Administration form and the KPAWin® Database to the original values, exits
the current display and returns to the previous display.

"Clear Entries” _ .

i The "Clear” button clears all existing data from the Procedure Administration form and retumns to the current display.

IIOKII
The "OK" button updates any record in the Procedure Administration form and the KPAWin® Database, exits the current
display and returns to the previous display.
‘ "Select"

The "Select” button queries the KPAWIn® Database and displays a drop-down list of all active Procedures in the
Database. The user then selects one Procedure to edit.

"Procedure ID"
The "Procedure Id” uniquely identifies the referenced laboratory procedure for the preparation and/or analysis of samples.
"Procedure Revislon”

The “Procedure Revision” uniquely identifies the referenced laboratory procedure revision for the preparation and/or
analysis of samples.

"Procedure Title"

The "Procedure Title” uniquely identifies the referenced laboratory procedure title for the preparation and/or analysis of
samples.

“Procedure Protocol”
The "Procedure Protocol” uniquely identifies the referenced laboratory procedure protocol for the preparation and/or

analysis of samples. . ‘
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"Sample Input Form"

Summary Description

The “Sample input” form accepts sample information required to analyze and evaluate sample results. The form contains a
Taolbar, an input area (Text and Drop-down Text areas), and a Display Grid at the bottom of the form. Sample Input data
in the input area is mirrored in the display grid sample identified by an asterigk (*) in the first column, the Sample Analysis
Number. Data is entered into either location and is automatically duplicated in the other area. Drop-down lists in the input
area provide convenient data entry with assurance that formats are consistent and data-handling errors are reduced. The
user customizes the Display Grid to include or hide specific fields in the display. This current user preference is maintained
by KPAWIN® and refoaded whenever the user logs onto the system.

"Preferred Range List”

The “Range Drop-down List" is a drop-down box containing four selections: Auto, Both, Low, and High. The selected range
is the first range attempted for an analysis. The selection overrides any alternative preferred range specified in the current
Calibration Configuration Tab. The Auto option selects the optimal range based on sample precounts in the high range
and defaults to the range for the last analysis if both ranges are qualified. Precounts in the high range are scaled to
anticipate counts in the low range by the Auto Efficiency Factor in the KPA Unit Settings Configuration Tab. The Both
option results in an analysis in the most recently used range. This is followed by an analysis in the other range if the first
analysis fails the high-intensity tolerance or the low-intensity tolerance specified in the KPA Unit Settings Configuration
Tab. ‘Selection of either the High or Low option limits analysis to the requested range with results qualified by the high-
intensity tolerance or the low-intensity tolerance. intensity tolerance factors for both the high and low ranges are specified
in the KPA Unit Settings Configuration Tab.

"Concentration Units List”

The “Units” drop-down list provides options for sample units. Selection of units on a per mass basis requires the
specification of the Specific Gravity. Selection of radiometric units requires the specification of the Specific Activity.
Selection of units in molarity requires the specification of the atomic mass of the analyte. When Specific Gravity or Specific
Activity are required at the time of sample input, the appropriate label(s) will be rendered in red. Selection of concentration
units on a per volume basis require the use of amounts in ml units. Selection of concentration units on a per mass basis
require the use of amounts in g units.

"Alarms/Warnings Drop-down List"
The “Alarms/Warnings” drop-down list provides all alternative active configurations of Alarms and Warnings.
"Calibration Configuration Drop-down List"
The “Calibration” drop-down list provides all alternative active configurations of Calibration.
"KPA Unit Settings Drop-down List"
The “KPA Unit Settings” drop-down list provides all alternative active configurations of KPA Unit Settings.
"Performance Limits Drop-down List"
The “Performance Limits” drop-down list provides all alternative active configurations of Performance Limits.
"QC Limits Drop-down List"
The “QC Limits” drop-down list provides all alternative active configurations of QC Limits.
"Sample Status Drop-down List"
The “Sample Status” drop-down list includes Entered, Processed, Accepted, Rejected and Reanalyze. The Entered option
is automatically listed when Sample Input data is entered and before the sample is analyzed. Processed Ig also entered
automatically at the completion of sample analysis. Accepted marks a processed sample as acceptable to the user.
Rejected marks a processed sample as unacceptable to the user. Reanalyze marks a processed sample as requiring
reanalysis. Samples identified as Entered or Reanalyze can be analyzed. Samples identified as Processed or Accepted

can be retrieved for sample reporting. Rejected samples are retained in the database but cannot be retrieved by
KPAWIN®.
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"Sample Type Drop-down List"
The "Sample Type” drop-down list contains the 19 unique sample types that are analyzed, interpreted, and reported by
KPAWIN®. The Help menu is consulted for details on individual Sample Types. Selection of a specific sample type from
the drop-down list causes data-field labels to reset to Red for required, Blue for optional, Grey for defaults that cannot be
edited, and Black for not appropriate for the sample type. Select the Sample Type for the sample from the drop-down hst
It is automatically completed if a sample selection is highlighted on the grid.

"Procedure ID Drop-down List"

The “Procedure Id" drop-down list contains all active Iaboratory procedures. Select the Procedure Id for the sample from
the drop-down list. It is automatically completed if a sample selection is highlighted on the grid.

"Customer ID Drop-down List"

The “Customer Id” drop-down list contains all active laboratory customers. Select the Customer Id for the sample from the
drop-down list. It is automatically completed if a sample selection is highlighted on the grid.

"Basis ID Drop-down List"
The "Basis Id" drop-down list includes all of the samples that can be related to quality control samples that they qualify.
Select the Basis Id for the sample from the drop-down list. It is automatically completed if a sample selection is highlighted
on the grid.

"PreRinse Option”
The “Pre-Rinse Option” checkbox, if selected, rinses the flow cell before the sample is charged to the cell. The Pre-Rinse
event is only available with the Gilson sample changer. It is automatically completed if a sample selection is highlighted on
the grid, .

"PostRinse Option”
The “Post-Rinse Option” checkbox, if selected, rinses the flow cell after the sample is charged to the cell and analyzed.
The Post-Rinse event is only available with the Gilson sample changer. It is automatically completed if a sample selection
is highlighted on the grid.

"Sample Input Grid"
The “Sample Input Grid” is located at the bottom of the Sample Input form. The display grid contains all information for

each sample and is customized by the user by selecting or hiding specific fields. The current configuration of the display
grid is saved by User Id and is reinstalled whenever that particular user Logs onto the KPAWIN®© software,

*Sample Input Toolbar”

Open Initial Sample - This toolbar button displays a dialog box contéining previously saved Initial samples and allows the
user to load one of them.

Save As Initial Sample - This toolbar button saves samples from the Sample Input data. These [nitial samples can then be
reloaded as Sample Input Data.

Add New Sample - This toolbar button adds a new Sample Input to the grid.

Clear Selecﬁon - This toolbar button clears all entries from the selected samples or cont_iguoué multiple samples.
Delete Selection - This toolbar button deletes the selected sample or contiguous multiple samples.

Analyze Selection - This toolbar button analyzes the selected sample or contiguous multiple samples.

Exit - This toolbar button exits the Sample Input screen.

Help - This toolbar button displays the Help information.
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“Sample Analysis Number"

The “Sample Analysis Number” is a KPA index that sequences samples in an analytical batch. It is automatically
incremented as samples are entered into the grid. An asterisk (*) in the field indicates the sample is the current sample
and is the target for all changes and requested actions.

“Initial Preparation (Prediluted) Volume"

The "Initial Preparation (Prediluted) Volume® for a sample is the amount of authentic sample that is taken for sample
preparation. Spikes that are to be subjéected to sample preparation should be added to this volume and prior to its dilution
to the Final Preparation volume. Units of ml or g are required consistent with the basis of the concentration units as per
volume or per mass. Il is automatically completed if a sample selection is highlighted on the grid.

"Final Preparation (Diluted) Volume"

The “Final Preparation (Diluted) Volume” for a sample is the final, total amount of sample at the end of sample preparation.
Units of ml or g are required consistent with the basis of the concentration units as per volume or per mass. ltis
automatically completed if a sample selection‘is highlighted on the grid.

"Initial Analysis (Sample) Volume"

The “Initial Analysis (Sample) Volume” for a sample is the prediluted amount of prepared sample that is taken for dilution
to the analytical sample. Units of ml or g are required consistent with the basis of the concentration unlts as per volume or
per mass. It is automatically completed if a sample selsction is highlighted on the grid.

"Final Analysis Volume"”

The “Final Analysis Volume” for a sample is the amount of diluted, prepared sample that is taken for sample analysis.
Spikes that are added after sample preparation should be added before this final dilution. Units of ml or g are required
consistent with the basis of the concentration units as per volume or per mass. It is automatically completed if a sample
selection is highlighted on the grid. The numerical amount should be identical to the final analysis amount for calibration
samples, check samples, and basis samples.

“Standard D"

The “Standard Id" for a sample uniquely relates the standard to its source through the laboratory’s standards control
program. {t is automatically completed if a sample selection is highlighted on the grid.

"Standard Concentration”

The “Standard Concentration” units of a sample must be consistent with those specified by the user in the Sample Input
for the standard. It is automatically completed if a sample selection is highlighted on the grid.

"Standard Volume"”

The “Standard Volume” specifies the amount of a standard added to a sample. Amount units can be ml or g but must be
consistent with the volume or mass basis specified by the user in the Sample Input for the standard. For example,
concentrations in molarity require "Standard Volume" units in ml. Concentrations in pCifg require “Standard Volume" units
in grams. It is automatically completed if a sample selection is highlighted on the grid.

"Specific Gravity"

The “Specific Gravity” of a sample is only required for preferred units on a mass basis. it is automatically completed if a
sample selection is highlighted on the grid.

"Sample ID" ’

The “Sample Id” for a sample is user-defined and establishes administrative laboratory control of the sample. it is
automatically completed if a sample selection is highlighted on the grid.

"Specific Activity"”

The “Specific Acfivity” of a sample is only required for preferred units in radiometric units. It is automatically completed if a
sample selection is highlighted on the grid.
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*Atomic Mass"”

The “Atomic Mass” for the analyte in a sample is only required for preferred units specified in molarity. It is automatically
completed if a sample selection is highlighted on the grid.

"Rack Number"

The "Rack Number” for a sample is only reqwred with the Gilson sample changer. it is automatically completed if a sample
selectlon is highlighted on the grid.

"Vial Position”

The *Vial Position” for a sample is only required with the Gilson Sample changer. It is automatically completed if a sample
selection is highlighted on the grid.

"Sample Description"

The "Sample Description” of a sample is a brief label that identifies the purpose or source of the sample. It is automatically
completed if a sample selection is highlighted on the grid.

Page 88




"Select Archive Data"

Summary Description

The "Archive" function appends the seiected poition of the KPAWIn® Database to the Archive file of KPAWIn®.
"Archive" ' |

The “Archive” button appends the selected portion of the KPAWIN® Database to the Archive file of KPAWIN®.
"Cancel"

The "Cancel" button restores the KPAWIn Archive.form and the KPAWIN® Database to the original values, exits the
current display and returns to the previous display.

"Between"

The “Between” option allows the user to Archive selected data from the KPAWIN® Database that fall within the two dates
(Beginning date and Ending date) provided.

"During the Previous”

The “During the Previous” option allows the user to Archive selected data from the KPAWIR® Database that fall within the
Previous number of days selected by the user.

. "A'lll

The "All” option allows the user to Archive ALL data from the KPAWIn® Database,
"Select Spin Wheel"

The “Select’ spin wheel allows the user to Select the number of days to collect data to archive.
"Beginning Date" }

The “Beginning Date” field accepts the Beginning date for the Archive Command to collect data from the KPAWIN®
Database. . '

"Ending Date"
The "Ending Date" field accepts the Ending date for the Archive Command to coliect data from the KPAWIn® Database.
"Number of Days"

The “Number of Days” text area accepis the number of days to collect data from the KPAWIn© Database to Archive.

Page 89



"KPA Sample Types"

Summary Description

The KPAWIN® software recognizes 19 unique sample types. Collectively they provide the analyst with a system to
accumulate and evaluate interactively all of the luminescence-specific and general-faboratory evaluations associated with
sample analysis and anaiytical performance. Sample Input is designed to guide the analyst by identifying the minimum
input data set for each umque sample type. Required data fields are labeled in red and on-screen warmngs are displayed
when critical information is not provided. The dlsplay and reporting for each Sample Type is designed to minimize
secondary data handling by the analyst.

BackGround - "BckGnd"

“BekGnd” is the designator for the background sample. Raw intensity vectors are corrected for coincidence and smoothed.
The smoothed background intensity vector is used to correct the intensity vectors of most sample types for background
contributions. Only Standard Addition Samples and Standard Addition Spikes, Confidence Tests, and Quench-Corrected
Sample vectors are not corrected for background. The intensity intercept for the reference that is recorded during the
analysis of the background sample is defined as the “Reference Mark” (Ry). For all succeeding samples in the analytical
batch of the background, a reference ratio is computed from the intercept intensity of the reference (R)). and Ry as the ratio
R/ Ry. Unless the option “Reference Corrected Data” is deselected on the Calibration Configuration Tab, accumulated
intensity in the smoothed intensity vector of the sample will be corrected for reference drift by division by the reference
ratio.

Calibration Standard - *CalStd "

“CalStd" is the designator for a calibration standard. Data are entered by the analyst and reported by KPAWIn® to
indicate the laboratory control identifier for specific standards as well as their concentrations and the volumes in ml or
masses in g. Concentrations are based on the laboratory's preference indicated in the Calibration Configuration Tab

. which can be amended in the Sample Input grid. The definition of amount.on a /volume or /mass basis is consistent with

the selected concentration units.

Continuing Check Blank- "CChkBIk"

“CChKBIK® is a deionized water or analyte-free laboratory blank and is the designator for the continuing check blank. The
blank is used to verify the calibration subsequent to the initial verification. The acceptable performance of the blank is
specified in the Quality Control Limits Configuration Tab as a multiple of the instrument detection limit (IDL).

Continuing Check Standard - "CChkStd "

“CChkStd is an analyte standard in deionized water or analyte-free laboratory sample and is the designator for the
continuing check standard. The standard is used to verify the calibration subsequent to the initial verification and should
be prepared from a traceable standard that is independent of the calibration standards. The acceptabie performance of
the blank is specified in the Quality Control Limits Configuration Tab as a standard recovery error.

Conf dence Tests - "ConfTst"

“ConfTst” is the designator for a confidence test. The test provides the coefficient of variation of a series of analyses on *
the same sample under identical analytical conditions. These results demonstrate the stability of the analytical system.

" Initial Check Blank - “IChkBIk"

"IChkBIK" ig a deionized water or analyte-free laboratory blank and is the designatbr for the initial check blank. The blank
is used to verify the calibration immediately following the calibration. The acceptable performance of the blank is specified
in the Quality Controf Limits Configuration Tab as a multiple of the instrument detection limit (IDL).

Inltial Check Standard - "IChkStd"

“IChkStd is an analyte standard in deionized water or analyte-free laboratory sample and is the designator for the initial
check standard. The standard is used to verify the calibration immediately following the calibration and should be prepared
from a traceable standard that is independent of the calibration standards. The acceptable performance of the blank is
specified in the Quality Control Limits Configuration Tab as a standard recovery error.
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10.

11.

12.

Instrument Detection Limit - "IDL"

“IDL" is the designator for the instrument detection limit sample that consists of an analyte standard in deionized water or
an analyte-free laboratory blank. The Instrument Detection Limit is an estimate of the minimum sample concentration that
can be detected with a 99% confidence. The calculation is based on a Student's t-test with all input parameters selected in
the detection limit frame of the Quality Control Limits Configuration Tab. The parameters include number of standards,
detection limit type, maximum duration in weeks, maximum concentration factor, and limit in pg/l. Detection limit type is a
KPAWIn@ term to distinguish between detection limits based on the standard deviation of a series of individual analyses
(Type 1) and the average of a series of standard deviation of a series of analyses made in triplicate (Type 2).

In operation, an IDL is analyzed according to a frequency establlshed by laboratory protocol. KPAWIN® pools all IDL
results and estimates the detection limit for every day of KPA operation based on the measurements that were made
within the previous number of weeks specified in the maximum duration specification. This detection limit is reported with
the data recorded for the day of operation and is used to evaluate the performance of IChkBlk and CChkBik samples.
Errors are reported if the number of standards (or standard deviations for Type 2 daily standards) is insufficient, if the true
average concentration of the standards (makeup concentrations) is greater than the specnf ied multiple of the detection
limit, or if the value of the detection limit exceeds the user-defined limit.

Method Detection Limit - "MDL"

“MDL" is the designator for the method detection limit sample consisting of an analyte standard in deionized water or an
analyte-free laboratory blank processed by the procedure employed for samples. The Method Detection Limit is an'
estimate of the minimum sample concentration that can be detected with a 99% confidence. The calculation is based on a
Student's t-test with all input parameters selected in the detection limit frame of the Quality Control Limits Configuration
Tab. The parameters include number of standards, detection limit type, maximum duration in weeks, maximum
concentration factor, and limit in ug/l. Oetection limit type is a KPAWIN® term to distinguish between detection limits
based on the standard deviation of a serigs of individual analyses (Type 1) and the average of a series of standard

~ deviations of a series of analyses made in triplicate (Type 2).

In operation, an MDL is analyzed according to a frequency established by laboratory protocol. KPAWIN® pools all MDL
results and estimates the detection limit for every day of KPA operation based on the measurements that have been made
within the previous number of weeks specified in the maximum duration specification. This detection limit is reported with
the data recorded for the day of operation and is used {0 evaluate the performance of the current MtdBlk sample. Errors
are reported if the number of standards (or standard deviations for Type 2 daily standards) is insufficient, if the true
average concentration of the standards (makeup concentrations) is greater than the specified multiple of the detection
limit, or if the value of the detection limit exceeds the user-defined limit.

Sample Duplicate - "SampDup”

"SampDup" is the designator of a duplicate sample. The sample is prepared for analysis and analyzed precisely
analogous to the basis sample. Acceptable performance is specified in the Sample Control frame of the Quality Control
Configuration tab as the relative percent deviation (%RPD).

Sample Spike - “SampSpk"

"SampSpk" is the designator of a spiked sample. The sample is prepared for analysis and analyzed precisely analogous
to the basis sample. The volume of the spike addition replaces a portion of the deionized water used to prepare the final -
analytical sample. Acceptable performance is specified in the Sample Control frame of the Quality Control Configuration
{ab as the spike recovery.

Quenched Sample - "QchSamp"

"QchSamp" is the designator of a quenched sample. The sample is an aliquot of the basis sample that was prepared for
analysis and diluted and analyzed precisely analogous to the basis sample. A volume of quenchant, typically 0.1 mi of
methanaol, replaces a portion of the deionized water used to prepare the final analytical sample. The methanol provides a
non-spectroscopic, thermal pathway for relaxation of the excited uranium complex and the resulting intensity vector
reports the non-uranium component present in the basis sample. The smoothed intensity vector of the quenched sample
replaces the smoothed background vector in the estimate of the net intensity vector. A user-request for a report of the
basis sample alone provides the standard report with sample intensities corrected for the batch background. Alternatively,
a user-request for a quenched sample report provides a report with sample intensities corrected for the quenched
intensities.
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14.

15.

16.

17.

18.

19.

Sample - "Sample”

“Sample" is the designator of a matrix sample. The Sample Id of this unknown can be the Basis Id for other sample types
that are evaluated and reported with this sample by KPAWIn®, The sample types that can be so linked with this sample
type are SampDup, SampSpk, QchSamp, Serbil, and MtdSA.

Method Blank ~ "MtdBIk"

‘MtdBIk” is the designator for the method btank that consists of deionized water or analyte-free laboratory matrix that has
been processed by the procedure employed for samples. The acceptable perforrnance of the blank is specified in the
Method Control frame of the Quality Control Limits Configuration Tab. It is expressed as a multiple of the method
detection limit (MDL), the percentage of the contract reporting detection limit (CRDL), the percentage of the sample
concentration, or the largest of the aforementioned three conditions.

Method Standard Addition - "MtdSA"

"MtdSA" is the designator of analyte-spiked samples quantitating the analyte concentration in the basis sample and the
interferences fo that quantitation. Spiked samples are prepared for analysis and analyzed precisely analogous to the basis
sample. The volume of the spike addition replaces a portion of the deionized water used to prepare the final analytical
sample. The parameters that contrgl the interpretation of MtdSA data are contained in the Sample Control frame of the
Quality Control Limits Configuration Tab under the Method of Standard Additions. These parameters are Number of
Spikes, Recovery Error (%), Slope Error (%), and R? (correlation coefficient). The value for Number of Spikes can be
either one (1) or three (3).

A single MidSA sample provides quantitation and Recovery Error (%) from the external batch calibration. Triplicate
MtdSA samples with the basis sample.provides an internal calibration by a linear least-squares regression of the spike
concentrations versus the increment of the intensity intercept that is attributed to the spike (Intercept of a spiked sample
minus intercept of the basis sample). The negative value of the concentration intercept is the reported concentration of the
analysis. R? is the correlation coefficient of the internal calibration least-squares regression. Recovery Error (%) is the
difference between the analyte concentrations for the basis sample for the internal-MtdSA calibration and the external
calibration divided by the result from the internal calibration when expressed as a percent. Slope Error (%) is the
difference hetween slopes for the internal-MtdSA calibration and the external callbratlon divided by the slope from the
internal calibration when expressed asa percen(

Method Standard ~ "MtdStd"

"MtdStd" is the designator for the method standard that consist of an analyté standard in deionized water or analyte-free
laboratory sample that has been processed by the procedure employed for samples. The acceptable performance of the
standard is specified in the Method Control frame of the Quality Control Limits Configuration Tab as a standard recovery
error.

Standard Addition Sample - "SASamp”

“SASamp" is the designator for the sample analyzed by standard addition. Standard addition quantiates the analyte in a
basis sample by internal calibration. The process compares the incremental increase of intercept intensity from this basis
sample to a spiked sample to the incrementa! analyte concentration of the spiked sample. The quantum efficiency factor is
used to estimate the analyte concentration in the basis sample, Neither the basis sample nor lts spike requires a
background or an external batch calibration.

Standard Addition Spike - “SASpk"

“SASpk® is the designator for the analyte-spiked sample analyzed by standard addition. Standard addition quantiates the
analyte in a basis sample by internal calibration. The process compares the incremental increase of intercept intensity
from this basis sample to a spiked sample to the incremental analyte concentration of the spiked sample. The quantum
effi c(ency factor is used to estimate the analyte concentration in the ba5|s sample Neither the basis sample nor its spike
requires a background or an external batch calibration.

Serial Dilution - "SerDil"

"SerDil" is the designator of a serial dilution of a sample. The sample is prepared for analysis and analyzed precisely
analogous to the basis sample. Additional deionized water prepares the final analytical sample so that a five-fold dilution
of the basis sample is created. Acceptable performance is specified in the Sample Control frame of the Quality Control
Configuration {ab as the serial dilution error.
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"Select Export Fields"

Summary Description
The Select Export Fields Menu displays the Sample fields available for Export to a file. The use of the selection buttons is
explained at the top of the form.

“Data Delimiter”

The "Data Delimiter" dropdown list allows the user to select the delimiter used when exporting the sample data to the file
selected by the user.

“Export Format”

The "Export Format" dropdown list displays the Export format(s) available. Currently, KPAWIn® only supports a “TXT* file
format. Additional formats may be available with future releases of the software.

“Heading Information”

The "Heading Information" checkbox allows the user to select whether Heading lnformatlon is included with the Sampfe
Information exported to the user hamed file,

“Sample Intensitles - Sample”
The "Sample Intensities Sample" checkbox allows the user to select the Sample Intensities to be Exported.
“Sample Intensities — Reference”
The "Sample Intensities Reference" checkbox allows the user to select the Sample Reference Intensities to be Exported.
llApply!I
The "Apply” command button applies the selected fields, updating the database to reflect these selections. This button
MUST be used to apply the selections. The selected fields are used to export the sample information the next time the
Export button is used.

“Cancel”

" The "Cancel” command button cancels the Export Fields selection process and returns to the Select Report Sample
screen without affecting any changes. - .

“Export Data”

The "Export Data" command button exports the selected fields to the file selected by the user and returns to the Select
Report Sample screen. )

“Include All”

The "Include All" button selects All available report fields from the Available Repon Fields listbox and moves them tothe’
Included Report Fields listbox.

“Add Fleld(s)”

The "Add Field(s)" button moves all selected (highlighted) report fields from the Available Report Fields listbox to the
Included Report Fields listbox.

“Rem Field(s)"

The "Rer'n Field(s)" button moves all selected (highlighted) report fields from the Included Report Fields listbox to the
Available Report Fields listbox.
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“Remove All"

The "Remove All" button selects All available report fields from the Included Report Fields listbox and moves them to the
Available Report Fields listbox.

“Rename”
The "Rename" button allows the user to Rename the selected field to a name of their choice.
“Heading Information”

The "Heading Information” frame allows the user to select whether Heading Information is included with the Sample
Information exported to the user named file.

“Intensity Selection”
The "Intensity Selection" frame contains the six intensity optidns available for Export.
“intensities Data” A

The "Sample Intensities" frame allows the user to select the intensities to be Exported. Select either the Sample or the
Reference or Both.

“Avallable Report Fields”
The "Available Report Fields" listbox displays all available fields that can be selected. The selected fields, after the
caleulations are performed, contain sample information to Export to a file selected by the user. These fields are selected
(moved to the "Included Report Fields" listbox) and then rearranged into any sequence that the user desires. When a field
is selected, it is deleted from the Available Fields list and inserted into the Included Fields box. Individuat fields are
highlighted and moved with the "Add Field(s)" command or removed using the "Rem Field(s)" command or by Double
Clicking on the field.

“Included Report Fields”
The "Included Repoxrt Fields" listbox displays all selected fields. The selected fields, after the calculations are performed,
contain sample information to Export to a file selected by the user. These fields are selected (moved to the "Inciuded
Report Fields" listbox) and then rearranged into any sequence that the user desires. When a field is removed, it is deleted

from the Included Fields list and inserted into the Available Fields box. Individual fields are highlighted and included with
the "Add Field(s)' command or removed using the "Rem Field(s)" command or by Double Clicking on the field.

“Do Not Include Intensities”

The "Do Not Include Intensities” option removes the possibility of exporting any Intensity data regardless of other Intensity
settings.

“Measured Intensities”
The "Measured Intensities” Option causes the selected Measured or Raw intensities to be exported to the named file.
“Coincidence Corrected”

The "Coincidence Corrected" Option causes the selected Coincidence Corrected or Deadtimé intensities to be exported to
the named file. ’ : )

“Smoothed”
The "Smoothed" Option causes the selected Smoothed intensities to be exported to the named file.
“Referenced Corrected”

The "Referenced Corrected” Option causes the selected Referenced Corrected intensities to be exported to the named
file.

Page 94




‘ “Net Sample”

The "Net Sample" Option causes the selected Net Sample or final result intensities to be exported to the named file,
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Select Report Fields

Summary Description

The Select Report Fields Menu displays the fields available to be displayed in the grid in the lower portion of the form.
The use of the selection buttons is explained on the form.

llApply”
The "Apply" command button applies the selected fields, updating the database to reflect these selections. This button

MUST be used to apply the selections. The selected fields are used fo display the sample information the next time that
the Retrieve button is used.

“Cancel”

The "Cancel" command button cancels the Report Fields selection process and retumns to the Select Report Sample
screen without affecting any changes.

ﬂEx't”
The "Exit" button returns the user to the Select Report Sample screen.
“Include AR”

The "Include All" button selects All available report fields from the Available Report Fields listbox and moves them to the
Included Report Fields listbox.

“Add Field(s)”

The "Add Field(s)" button moves all selected (highlighted) report fields from the Available Report Fields lislbox to the
Included Report Fields listbox.

“Rem Field(s)”

The "Rem Field(s)" button moves all selected (highlighted) report fields from the Included Report Fields listbox to the
Available Report Fields listbox.

“Remove All"

The "Remove All” button selects All available report fields from the included Report Fields listbox and moves them to the
Available Report Fields listbox.

“Available Report Flelds”

The "Available Report Fields" listbox displays all available fields that can be selected. These fields display the retrieved
sample information from the KPAWIn® database in the Grid on the Select Report Sample form. These fields are selected
(moved to the "Included Report Fields" listbox) and then rearranged into any sequence the user desires. When a field is
selected, it is deleted from the Available Fields list and inserted into the Included Fields box. Individual fields are
highlighted and included with the "Add Field(s)" command or removed using the "Rem Field(s)" command or by Double
Clicking on the field.

“Included Report Fields”

The "Included Report Fields” listbox displays all selected fields. These fields display the retrieved sample information from
the KPAWIN® database in the Grid on the Select Report Sample form. These fields are selected {(moved to the "Included
Report Fields" listbox) and then rearranged into any sequence the user desires. When a field is removed, it is deleted
from the Included Fields list and inserted into the Available Fields box. Individual fields are highlighted and included with
the "Add Field(s)" command or removed using the "Rem Field(s)" command or by Double Ciicking on the field.
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"Select Report Sample(s)”

Summary Description
The “Select Report Sample” form allows a KPAWIn® user to select a variety of displays and print options. Repoit
selections are based inclusively or exclusively on dates, sample types, customers, procedures, KPA analysts, sort order of
the displays, and the type of data to be disptayed and/or printed. The display grid is customized to include or hide

particular fields and the order the fields appear in the display. This current updated display grid is saved by User ID and
reloaded whenever that user Logs onto the KPAWIN® software.

"Sort Order List"

The "Sort Order” specifies the alphabetical order the fields are viewed and listed in the Select Fields tabulation. The user
specifies either Ascending or Descending order. The default is Ascending order.

"Customer Drop-down List"

The "Customer” drop-down lists all unique customers associated with samples in the KPAWIn®© database.
"Analyst Drop-down List"

The “Analyst” drop-do% lists all unique analysts associated with samples in the KPAWIN® databa;se.
"Procedure Drop-down List"

The "Procedure” drbp-down lists all unigue procedures associated with samples in the KPAWIn® database.
"Sample Type Drop-down List"

The “Sample Type” drop-down lists all unique sample types associated with samples in the KPAWIN® database.
"Calibration Details"

The "Calibration Details" checkbox on the MultiReport Option prints the Calibration Details for the selected samples.
“Configuration Detalls" -

The "Configuration Details” checkbox on the MultiReport Option prints all Configuration Details for the Selected samples.
“"Multiple Sample Repbrt“ |

The “Muitiple Sample Report® checkbox selects multiple sample displays or print files.
"Sample Identification”

The "Sample Identification” checkbox on the MultiReport Option prints the Sample Input Details for the selected samples.
"Sample Preparation”

The "Sample Preparation" checkbox on the MultiReport (_)ptioﬁ prints the Sample Input Details for the selected samples.
"Analytical Results"

The "Analytical Results" checkbox on the MulfiReport option prints the Sample Results Details for the selected samples.
"Quality Contfol"

The "Quality Control" checkbox on the MultiReport option prints the QC information for the selected samples.
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"Calibration"

The "Calibration” checkbox on the MultiReport option prints the Calibration Information for the selected samples. It also
displays and enables the Calibration Details checkbox.

"Configuration”

The "Configuration” checkbox on the MultiReport option prints all Configuration Ids for the selected samples. It also
displays and enables the Configuration Details checkbox.

"Retrieve"
The "Retrieve" button displays a list of the selected samples stored in the KPAWIN® database. Users must first make their
option choices, then click Retrieve to acquire the selected samples from the KPAWIn© Database prior to either displaying
results on the monitor or printing reports.

"Display / Print"
The "Display" button serves two functions. If the Display Reports radio button on the Report Options frame is selected, and
after the selected samples are retrieved from the database, the Display button produces the various selected display

options on the computer monitor. However, if the Print Reports radio button is selected on the Report Options frame, this
command button changes to read "Print" and clicking it causes the selected samples to be routed to the system printer.

"Report Options”

This frame provides the option of selecting a radio button to Display Reports or Print Reports. The default is Display
Reports.

"Customer"

The "Customer” frame provides the option of selecting All, And, Or logic to select samples by customer. As an alternative,
a customer can be selected from the drop-down list.

"Analyst"

The “Analyst” frame provides the option of selecting All, And, Or logic to select samples by analyst. As an alternative, an
* analyst can be selected from the drop-down list.

"Procedure"

The “Procedure” frame provides the option of selecting All, And, Or logic to select samples by procedure. As an
alternative, a procedure can be selected from a drop-down list.

"Sample Type"

The “Sample Type" frame provides the option of selecting All, And, Or logic to select samples by sample type. As an
alternative, a sample type can be selected from a drop-down list.

"Sample ID"
The “Sample Id" frame provides the option of selecting All, And, Or logic to select samples by a specific sample Id. The
use of wildcards is supported to locate and display all samples that meet the entered criteria. The following characters can
be used:
“?* - Will match any single character
"** - Will match zero or more characters
“# - Wil match any singte digit (0-9)

"Date"
The "Date" frame provides the option of selecting All Samples, just those analyzed during the past n-days, or just those
analyzed between two bounding dates.
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"Select Fields"
The Select Fields command button displays a menu allowing users to select from the various fields available to be
displayed in the grid in the lower portion of the form. The use of the selection buttons is explained on the form. See Select
Report Fields for additional information on selecting fields,

"Between"”
The "Between” option permits the user to specify the sample dates to display.

"Monitor Display Options"
The "Monitor Display Options" frame provides the user with the two options for displaying sample results. The format
option permits the selection of either a Single Display format (only one Sample Report per display or printed page) or a

Muiti Display format {many Sample Reports per display or printed page). The default is the Single Display format. The
display option permits the selection of data for categories of the Muiti Display format by function.

"Multi Display"

The “Multi Display” radio button enables the selection of display types for both the multiple sample displays or printed
reports.

"During the Previous"

The “During the Previous” option is the number of days prior to the current date that contain the retrieved sample results.
"Print Reports™ -

The “Print Reports” option selects printed reports for the selected samples.
"ALL"

The “All" option enables an all-inclusive retrieval of sample data for all customers, all analysts, all procedures, all sample
types, and all dates.

llANDll

The “And” option enables an exclusive retrieval of sample data that meet the selection criterion of the specific category
and the selection criteria of all other categories.

IloRu

The "Or” option enables the retrieval of samples that meet the selection criterion of the specific category or the selection
criteria of any other categories.

"Single Display”

The “Single Display” format generates a single Sample Report per display or printéd page. The default for Monitor Display
Options is Single Display.

"Display Reports”

The “Display Reports” optioh generates sample reports displayed on the system monitor.
"Sample ID" .

The "Sample Id* Multi Disblay option displays only the data items pertaining to the Sample Id for the selected samples.
"Sample Prep"

The “Sample Prep” Multi Display option displays only the data items pertaining to the Sample Preparations for the selected
samples.
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“"Sample Analysis" ‘

The "Sample Analysis” Multi Display option displays only the data items pertaining to the Sample Analysis (Results) for the
selected samples.

»Standard Add”

The “Standard Add” Multi Display option displays only the data items pertaining to the Sample Standard Additions for the
selected samples.

"Quality Control”

The “Quality Control” Multi Display option displays only the data items pertaining to the Quality Control functions for the
selected samples.

"Display All Data"

The “Display All Data” Multi Display option displays all data items pertaining to the selected samples.
"Calibration"

The “Calibration” Multi Display option displays all data items pertaining to the Calibration.
"Spin Day Button"

The "Spin Day” device increments or decrements the numbers of days in the Previous Days selection text box.
“Starting Date"

The "Starting Day” box defines the beginning of the period for sample results retrieved by period.

"Ending Date™

The “"Ending Day" box defines the end of the period for sample results retrieved by period.
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"Single Sample Report”

Summary Description
The basic form contains four main groups displaying the various significant sample data. The four data groups are Sample
Details, Analysis Details, Samp!e Results, and Final Results. Each group frame contains the significant data items within
that section. Each group frame is described in detail in its own section. A toolbar is provided to control the functions of the
display. . .

"Analysis Detalls Section" .
The “Analysis Details” section on the Single Sample Display reports the data elements required to interpret the analytical
data. These data elements include Total Dilution Factor, Calibration Configuration Id, Calibration Data Id, Sample Amount,
Standard Amount, and Calibration Alarms. Data elements not required for a specific sample type are not reported with that
sample type. '

"FInal Results Section”
The “Final Results” section on the Single Sample Display reports the interpreted results for the analysis. The number of
these data elements varies by data type. For example, a customer sample would include the Final Result (Analytical
Concentration corrected for dilution) and Relative Pescent Deviation for a duplicate or Spike Recovery for a spiked sample.

"Results Section"
The “Results” section on the Single Sample Display reports the results of the sample analysis. These data elements
include Range, LSR Time Gates, Reference Ratio, Analysis Concentration, Lifetime, LSR Correlatlon Coefficient, Intensity
Intercept Integrated LSR intensities, and Sample Analysis Alarms.

"Sample Details Section "
The “Sample Details” section on the Single Sample Display reports the characteristics that identify the sample. These data

elements include Sample Id, Sample Type, Basis Id, Description, Date/Time of analysis, Customer Id, Procedure Id, and
Analyst.

"Display Intensity Options” ‘
The “Display intensity Options” on the toolbar enables the user to access the numerical sample intensity vector data.
"Plot Options™
The "Plot Options” on the toolbar enables the user to access the graphical sample intensity vector data. l
"Sample Details - Sample ID"
The “Sample Id” is a unique identification assigned by the anélyst when the sample data was entered on the Sample Input
form. 1t is the primary reference to the sample data and remains with the specific sample as long as the information is in
the KPAWIN® database.
"Sample Details - Customer ID"

The "Customer Id" identifies the customer or project submitting the sample or the laboratory preparing a blank or standard.
The Customer Id is entered during sample datza input.

"Sample Details - Sample Type"

The "Sample Type" identifies the purpose of the analysis and the logic used to evaluate and report the data. Sample Type
is specified during sample data input.

“*Sample Detalils - Procedure ID"
The "Procedure Id" identifies the documented laboratory protocol(s) used to prepare and analyze the samplé. The
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Procedure Id is entered during sample data input.

"Sample Details - Basis ID"
The "Basis Id" is the Sample Id of the sample that the current sample is related to when results are calculated from more

than one analysis. For example, the Basis Id for a spiked sample is the Sample Id for the unspiked sample. The Basis Id is
assigned during sample data input. '

"Sample Detalils - Analyst ID"

The "Analyst” is the KPA user performing the analysis of the sample. The Analyst's name or Id is entered during sample
data input.

"Sample Details - Sample Description"
The "Description” is a unique descriptive label for a sample. The Description is entered during Sample data input.
"Sample Details - Date/Time"

The "Date/Time" is the time stamp of the analyzed sample on display. KPAWIn® assigns the Date/Time at the beginning
of the analysis. :

"Analysis Details - Sample Amount”

The "Sample Amount” is the Initial Analytical Volume of a sample analyzed by Standard Additions and quantified by
internat calibration.

"Analysis Details - Total Dilution Factor”
The "Total Dilution Factor" is the product of the preparation dilution factor and the analysis dilution factor. The product of
the Total Dilution Factor and the KPA analytical result is the final result, which is the concentration of the analyte in the
authentic sample. .

“"Analysis Detalls - Standard ID”

The "Standard Id" is the control code assigned by the laboratory uniquely identifying the source and make-up protocol of
the standard. The Standard Id is assigned during sample data input.

"Analysis Detalls - Standard Concentration”

A "Standard Concentration” is the make-up concentration of the analyte documented by a purchased or prepared standard
according to a documented protocol.

“Analysis Detalls - Standard Amount”

The "Standard Amount” is the volume of standard spiked into a Standard Additions sample prior to dilution to the Final
Analytical Volume.

"Analysis Detalls - Calibration Configuration 1D"

The "Calibration Configuration Id" is the unique statement of the configuration of KPAWIn® pemanently stored in the
KPAWIn® database. KPAWIn® assigns the Calibration Configuration Id when a background is measured.

"Analysis Detalls - Calibration Data ID"

The "Calibration Data [d" uniquely identifies a calibration. KPAWIR® assigns the Calibration Data Id when a calibration is
defined. A calibration consists of a background analysis, calibration standard analyses for one or both ranges, and the
associated Calibration Configuration Id. Multiple Calibration Data Ids are created for a single, multiple-calibration-standard
batch by inclusion of different standards. Since raw data are reevaluated before the generation of every report, data are
unambiguously related to a specific Calibration Data Id reported with the sample data and its corresponding calibration
data. The Calibration Data Id and its included analyses are stored as a permanent part of the data in the KPAWIn©
database.
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"Analysis Detalls - Callbration Alarms/Warning"

The "Alarms/Warnings" are codes of the alarms and warnings violated during the Calibration. The Alarms/Warnings
configuration tab defines the conditions of concern. Alarm levels are incidental to the condition or are specified in other
Configuration Tabs for the analysis. ‘

"Final Result - Final Result”

The "Final Result" is the Analytical Result corrected for sample preparation and analytical sample dilution factors. The
sample preparation dilution factor is the total final concentration of the prepared sample divided by the amount of authentic
sample that is used in the sample preparation. The analytical sample dilution factor is the final amount of the diluted
analytical sample divided by the amount of the aliquot of prepared sample taken for analysis. The Final Result is the
product of the Analytical Result and the dilution factors. For example if the sample preparation dilution factor for a 1 ml
portion of authentic sample that is ultimately diluted to 10 mi by the end of sample preparation is 10 (10 ml/1 ml). The
analytical sample dilution factor for 1 mi of the prepared sample diluted to 100 m! is 100 (100 mi/1 ml). The Final Result for
an Analytical Result of 2 ppb is 2 ppm (2ppb * 10 * 100).

“Final Result - % Recovery”

The “% Recovery" is the difference between the measured and true concentrations of a spike divided by the true
concentration expressed as a percent.

For a spiked sample or a single-sample Method of Standard Addition analysis, the measured concentration is found by

interrogating the batch calibration by the difference between the intercept intensity of the spiked sample and the intercept

of the unspiked sample. The true concentration is the product of the spike concentration and the spike volume,

For a three-sample Method of Standard Addition analysis the measured concentration is found by interrogating the batch

calibration by the intensity intercept of the basis sample. The true concentration is found by interrogating the internal

calibration of the basis sample and the Method of Standard Addition spiked samples by the intercept of the basis sample.
"Final Result - Calibration Error”

The "Calibration Error” is the correlation coefficient of the least-squares regression of a three-sample Method of Standard
Addition analysis.

"Final Result - Slope Error (%)"

The “Slope Error (%)" is the absolute difference between the slope of the external batch calibration and the slope of the
internal calibration for a three-sample Method of Standard Additions analysis divided by the slope of the internal calibration
expressed as a percent.

"Result - Range"
The "Range" can be Low or High and indicates the analytical range used for the analysis.
"Result - Time Gates"

The "Time Gates" indicates the initial and final time gates used for the least-squares regression of the intensity data. The
Maximum Intensity/ Pulse and the Minimum Intensity Factor settings in the KPA Unit Settings Configuration Tab may force
a deviation from the user-specified values as a result of gate shifting or gate dropping.

"Result - Reference Ratio"

The "Reference Ratio” is the ratio of the Reference Intercept for the sample to the Reference Intercept for the background
(Reference Mark). The intercepts are the extrapolation of the smoothed reference intensities or, as default, the
coincidence corrected reference intensities if smoothing is deselected.

"Result - Concentration"

The “Concentration” in the Analytical Results frame reports the magnitude of the KPA measurement, uncorrected for
dilution factors, in the specified units,
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"Result - Lifetime”
“Lifetime" is the time in microseconds required for the population of the excited state to decrease to 1/e of its original '
value. The slope of the least-squares regression of KPA intensity data is the negative inverse of the sample lifetime
expressed in milliseconds.

"Result - R Squared”

The "R Squared" value is the correlation coefficient of the linear least-squares regression of the corrected sample
" intensities versus time function (related to time gate.) ’ : ’

*Result - Intercept”

The "Intercept” is the corrected sample intensity at time zero estimated from the linear least-squares regression of the
intensity data. :

"Result - Integrated Intensities”
The "Integrated Intensities" is the sum of all corrected sample intensities in the range of time gates specified for the linear
least-squares regression meeting the Maximum Intensity/Pulse and Minimum Intensity Factor specifications in the KPA
Unit Settings Configuration Tab for the sample.

"Result - Sample Alarms/Warnings"
The "Sample Alarms/Warnings" are codes of the alarms and wamings violated during the analysis. The Alarms/Warnings

Configuration Tab for the analysis defines the off-standard conditions. Alarms are reported by an "A" followed by two digits
for the condition in the Alafmm/Warning tab. Warnings are reported similarly with a "W rather than an "A",
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‘ "Kinetic Phosphorescence-Analyzer System Contacts”

Summary Description

The “Kinetic Phosphorescence Analyzer System Contacts” screen displays the Technical information concerning the
KPAWIn® system. it provides users with The Technical Contacts including telephone numbers, Fax numbers, e-mail
addresses and the address of Chemchek Instruments, Inc.
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"Kinetic Phosphorescence Analyzer Technical Information”

Summary Description
The “Kinetic Phospherescence Analyzer Technical Information” screen displays technical information concerning the

KPAwin Hardware system. It provides users with the minimum technical hardware requirements to operate the KPAWIN®
software.

"Contacts"

The "Contacts" button displays the Technical Contacts at Chemchek Instruments, Inc.

"OK"
The "OK" button exits the display and returns to the previous display.

"Hardware Requirements"
This frame displays the Hardware System Requirements to run the KPAWIn® software in a reasonably responsive mode.

Extensive data computations and manipulations occur during the analysis process. Consequentty, a faster processor,
memory, and video display is needed to enhance the performance of the software.
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"Units Administration Menu"

Summary Description
The "Units Adminisfration” form has text areas that contain unit information such as units, unit's name, conversion
formulas, and conversion factors. A checkbox indicates if the above listed unit is Active or Inactive. Setting or clearing the
checkbox changes the Status of each. If the Select button is depressed, a list of current units from the KPAWIn©

. Database is displayed. The user then selects one of these units and the database information populates the text areas
with the database entries.

"Units Drop-down List"

The "Units" drop-down list displays all units currently entered in the KPAWIN® Database. |t displays whenever the Select
button is depressed.

"Inactive Units”

The "Inactive” checkbox identifies a unit that is not currently Active.
"Add"

The “"Add" buiton opens a néw Units Administration form and positions the cursor in the first entry of the. form.
“Apply"

The "Apply" button updates the KPAWIn® database and returns to the Units Administration display.
"Cancel"

The "Cancel" button restores the Units Administration form and the KPAWIn® database to the original values, exits the
current display and returns to the previous display.

"Clear Entries”

The "Clear" button clears all existing data from the Units Administration display and returns to the current display.

“OK"
The "OK" button updates any record in the Units Administration farm and the KPAWIN® database, exits the current display
and returns to the previous display. '

"Select"
The "Select" button queries the KPAWIN® database and displays a drop-down list of all active units of measurement in the
database. The user then selects one unit to edit.

"Units ID"

The "Units Id" box identifies the concentration units of the input and oufput data for an individual sample.
“"Concentration Name”

The "Concentration Name" box identifies the concentration units of the input and output data for an individual sample,
“Concentration Multiplier”

The "Concentration Multiplier" is the numerical value, exclusive of density and specific activity factors, that is divided into
the value of the Concentration Name to convert the input units to KPAWIN® database units of ugA.
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"Sample/Standard Quantity”

The " Sample/Standard Quantity " identifies thé units of sample/standard consistent with the input Concentration Name.
The Sample/Standard Quantity is always ml for input Concentration Units expressed on a per volume basis. The
Sample/Standard Quantity is always g for input Concentration Units expressed on a per mass basis.

"Sample/Standard Quantity Multiplier"

The "Sample/Standard Quantity Multiplier” is the numerical value, exclusive of density, multiplied by the identified
Sample/Standard Quantity to convert the input units to KPAWIN® database units of pl. The value is always .001 with per
mass unit selection prompting the user for a density in g/ml. This conversion is applied to input and output units
automatically to provide a consistent basis for the database. It does not require user action.
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“User Administration Menu”

Summary Description

The User Administration form has a number of text boxes that contain user information such as User Id and Name. It also
has a checkbox indicating if the above listed user is Active or Inactive. You change the Active/Inactive Status simply by
setting or clearing the checkbox. The form also provides the option to include user passwords. [n addition, if the select
button is depressed, a list of current users from the KPAWIR® Database is displayed. The user then selects one of these
users and the database information populates the text areas.

"Drop-down User List”

The "User” drop-down list displays all users currently entered in the KPAWIn® Database. It displays whenever the Select
button is depressed.

"Inactive User"
The "Inactive” checkbox identifies a user that is not Active. Only active users are displayed in the Login selection list.
"Standard User"
- The "Standard User" checkbox identifies a user with routine privileges. Only a supervisor can edit this screen.-
"Supervisor"

The "Supervisor" checkbox indicates a user with al! privileges within the KPAWIn® software.

"Add"
The "Add" butten opens a new User Administration form and positions the cursor in the first entry of the form.

"Apply”
The "Apply" button updates the KPAWIN® database and returns to the User Administration display.

"Cancel"
The "Cancel" button restores the User Administration form and the KPAWIn®© database 1o the original values and clears
the current display.

"Clear Entries”
The "Clear" butfon clears all existing data from the User Administration display and returns to the display.

"OK"
The "OK" button updates any record in the User Administration form and the KPAWiIn® database, exits the current display
and returns to the previous display.

"Select"”
The "Select" button queries the KPAWIN® database and displays a drop-down list of alt users in the database. A
supervisor then selects one user to edit.

"KPAWIn® Login ID”

The "KPAWIn® Login (d" field contains the KPAWIN® Login Id. A Supervisor enters it when the user information is
entered.

"User First Name"”

The “First Name” field contains the User First Name. A Supervisor enters it when the user information is entered.
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"User Last Name"
The "Last Name" field contains the User Last Name. A Supervisor enters it when the user information is entered.
"User Password”

The "User Password” field contains the User Password, if required. A Supervisor enters it when the user information is
entered.

"User Password Conformation"”

The "User Password Confirmation” field is used to Confirm or Verify the User Password.
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E52

E91
E92
E93
E9%4
E9S

E101
'E102
E103
E104
E105
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E201
E202
E203
E204
E205
E206
E207
E208
E209
E210
E211
E212
E213
E214
E215
E216
E217
E218

KPAWIn© Error Codes

KPAWin© Program Errors
KPAWINR® Error: Unexpected

KPAWIN® Error: Bad Routine Call Parameter

KPAWIN® Error: Incorrect call to Move Samples
KPAWIN® Error: Message Format is Bad

KPAWIn® Error: Undefined Alarm and Warning Message
KPAWIn® Error; Report Record not found

'KPAWIN® Error: Sample Record does not exist

KPAWIN® Error: Intensity Record does not exist
KPAWIN® Error: Configuration
KPAWIN® Error; ToolBar Menu

KPAWIiIn© Database Errors
KPAWIn® Database Error
KPAWIN® Database Error: Record NOT Found

User Control Messages
User Escape

User Abort
User Cancel
User Ignore
User Retry

Sample Changer Error Messages (100 Series)
Sample Changer Movement Data is Missing

Sample Changer Error

RackNb: & VialNb: NOT Valid

Sample Changer Error

ERROR - Number of Sample Vials Exceed number of Mix Vials
Reference Lifetime Too Short

Reference Intensity |s Excessive

Auto Changer Error

Calculations Error Messages (200 Series)
Unable To Calculate Reference Intercept

Unable To Calculate Sample Intercept

Equals Water Blank

Not enough Samples available for &1& calculatlon
Basis Sample Loop

Auto Calibration Completed

All Samples must contain same number of Measurements
Spike and Sample have same Integrated Intensities
Initial Analysis Volume is Zero

Sample Must have Standard Concentratlon Specified
There are NO Valid Calibration Points

Calibration Curve Fit Error

KPA NOT Calibrated

Precounts High For High Range

Confidence Test Aborted

Basis Sample Must Be Assigned before Measurement
Basis Sample Must Be Measured First

There are NO Calibration Points
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CurveFit Error Messages (400 Series)
E401 Inverse Bad

. DBRoutines Error Messages (500 Series)
ES01 Database File: & FileName & could NOT be Closed
E502 Database File: & FileName & could NOT be Opened"

. KPA Error Messages (600 Series)
E601 Check KPA & Msg
E602 Auto Changer Error -

E603 Put Sample & Sampleld Msg{SampleData)
E604 Put Sample Intc KPA Cancel/Error

E605 Gilson Device Not Responding

E630 KPA Analyze Error

KPAIO Error Messages (700 Series)
E701 KPA Not Responding
E702 This KPA Cannot Use this Command
E703 Sample Intensity KPA Data Read Error
E704 Reference Intensity KPA Data Read Error
E705 Max Nb of Intensities & Data values must be received
E706 Piace RANGE selector switch in the & SwitchMsg & position”
E707 This KPA Cannot Use the OUTALL Command
E708 There are no Standards for this sample
E709 ~Reference Intensity Is Excessive
E710 KPA NOT Ready
E711 Waiting for KPA Data
E712 Waiting for KPA Laser
E713 KPA Checksum Error
E714 KPA Background Measurement Required

MDIControl Error Messages {800 Series)
E801 Cannot find FindString

SelectCalData Error Messages (900 Series)
E901 No & Title & Found

ShowResults Error Messages (1000 Series)
E1001 Reference R’ < .99

Utilities Error Messages (1100 Series)
E1101 KPAWIn® Configuration
E1102 The Value &1& is NOT WITHIN the Acceptable Range
E1103 Range Must be Between &Value1& and &Value2&
E1104 Resetting to Previous Value
E1105 & DataText & Validation Rule is NOT vatlid & Validation Rule

MDIForm Error Messages (1200 Series)
E1201 Only ONE instance of + KPAWIn + is allowed

General Confiq Error Messages (1300 Series)
E1301 Invalid Configuration Name provided - Default; & DefaultName & Used
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Environmental Restoration Group, Inc.
8809 Washington St NE, Suite 150
Albuquerque, NM 87113

ph: (505) 298-4224

WWW. ERGofﬁce com

"To: Tom Wohlford(HMC),Toby Wlht (WES) | Date: Agust 8, 2017
From: Randy Whicker (ERG) Project: HMC Grants Reclamation Project
Direct: 970-556-1174 Task(s): Radiation Protection Administrator
Cc: Chuck Farr (ERG)

Subject: Occupational dose and toxicity assessment for potential uranium exposure at Zeolite facilities

Dear Mr. Wohlford and Mr. Wright,

Per the request of Toby Wright (Wright Environmental Services, Inc.), this Technical Memorandum
provides conservative occupational radiation dose and non-radiological (toxicity) assessments for workers
that could potentially be occupationally exposed to uranium when working at the Zeolite water treatment
facilities at the Homestake Mining Company of California (HMC) Grants Reclamation Project. The intent
of this information is to support a license amendment application regarding operation of these facilities
as part of HMC’s continued efforts to remediate impacted groundwater at the HMC Grants Reclamation
Project site.

Please let me know if you have questions or need more information.
Thanks,

Randy Whicker, CHP
RPA, HMC Grants Reclamation Project

€ERG

Environmental Restoration Group, Inc.
8809 Washington St. NE, Suite 150
Albuquerque, NM 87113

Email: RandyWhicker@ergoffice.com

August 8, 2017 ‘ 1 €ERG



Occupational Dose/Toxicity Assessment — Zeolite Facilities HMC Grants Reclamation Project

Occupational Dose/Toxicity Assessment for Zeolite Facility Operations

1. Introduction

This Technical Memorandum provides conservative radiological dose and chemical toxicity assessments
for workers at the Homestake Mining Company of California (HMC) Grants Reclamation Project whom
could become occupationally exposed to uranium when working at the Zeolite water treatment facilities.
The Zeolite facilities, designed to remove uranium from impacted groundwater, include two separate
systems {300 and 1,200 gallons per minute (gpm) water treatment capacity] located on top of the Large
Tailings Pile. Treatment pond series (trains) containing Zeolite media beds are filled with impacted
groundwater during water treatment cycles. During occasional maintenance periods, the water is drained
and media beds are exposed to the atmosphere. Each circumstance has the potential for occupational
exposure to uranium as described below.

2. Potential Exposure Scenarios

Based on inspection of the Zeolite facilities and review of operational procedures conducted by HMC's
Radiation Protection Administrator (RPA) on July 21, 2017, the following two potential pathways for
occupational exposure to uranium from Zeolite water treatment operations have been identified:

1) Accidental ingestion of dissolved uranium in contaminated influent groundwater.

2) Incidental inhalation of airborne particulates from Zeolite beds when water treatment ponds are
drained for maintenance and become exposed to the atmosphere (the media beds can dry out, and
under this condition there is the potential for resuspension of Zeolite particulates to air).

For the ingestion pathway, it was conservatively assumed for this dose assessment that a worker could
conceivably fall into one of the ponds and accidentally ingest as much as 1 liter of water containing
elevated levels of dissolved uranium. For the inhalation pathway, it was conservatively assumed that a
worker could be intermittently exposed to airborne particulate matter resuspended from dry zeolite beds
containing elevated levels of uranium.

Assumptions
3. Source Terms Influent Concentration 0.4mg/l
Effluent Concentration 0.03mg/l
. Flow Rate 300gpm
The source terms used for each occupational exposure  {Time between Regeneration 60days
scenario are based on the assumptions and calculations ~ |Cveles )

. . ) . . 1 Cell Volume of Zeolite 15045¢f
shown at right regarding uranium concentrations in  [7¢.jite Density 53.7Ibs/cf
influent groundwater and maximally loaded Zeolite

. : : Calculated Results
media as developed by Hydro-Engineering, LLC. The ke
P ) Yy g & . v Volume of Water Treated 25,920,000 gal
parameters for this assessment are the estimated |mMass of Uranium deposited 80.01bs
concentrations of uranium in influent groundwater and  |Uranium in Zeolite Concetration 99.03mg/kg
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Occupational Dose/Toxicity Assessment — Zeolite Facilities HMC Grants Reclamation Project

in loaded Zeolite media. These estimates are believed to be conservative.

For the ingestion pathway, the concentration of uranium in the ingested water is assumed equivalent to
an average influent concentration of 0.4 mg/L as indicated above.

For the inhalation pathway, mass-based and radioactivity-based concentrations of uranium in the inhaled
air were calculated based on the concentration of uranium in loaded zeolite media as given above (= 100
mg/kg), an assumed mass loading factor for inhalation of 0.0001 g/m? [the default value for releases from
soil to air as given in the RESRAD-OFFSITE computer code (ANL, 2013}], and a specific activity for natural
uranium of 0.691 uCi/g (ORISE, 2017). o

Using applicable parameters noted above, the assumed mass-based concentration of uranium in air was
calculated as follows:

m
)=1x10"23
m

k 0.0001
100ﬂ( g ) ( 9
- kg \1000g m3
Using applicable parameters noted above, the assumed activity-based concentration of uranium in air was

calculated as follows:

m k 0.0001 0.691uCi m3 Ci
100—‘9( J )( 9)( J )( s l) =69 x 101552
kg \1000g m3 1000 mg g 1x106mlL mL

4. Radiological Dose Assessment

INGESTION PATHWAY

For the ingestion pathway, 10 CFR 20 Appendix B gives an Annual Limit on Intake (ALI) for biologically
soluble and insoluble forms of natural uranium as follows: '

e Soluble uranium ALI (non-stochastic) = 10 uCi (critical organ = bone surface)
* Insoluble uranium ALI (stochastic) = 20 uCi

The amount of uranium activity ingested under the assumed scenario is calculated as follows:

0.4 mg) (0.000691 uCi

Ingestion Intake = ( I

L) =28x10"% uCi
mg )(1 ) X uci

Assuming that dissolved uranium in the influent groundwater is biologically soluble, the assumed intake
of uranium via the ingestion pathway would result in a committed dose equivalent (CDE) to bone of:

50 rem) (1000 mrem

= (2. —4 C'(
CDE = (2.8 x 107* uCi) 10 ACi

) =14 mrem
rem
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Occupational Dose/Toxicity Assessment — Zeolite Facilities HMC Grants Reclamation Project

Assuming that the dissolved uranium in the influent groundwater is biologically insoluble, the assumed
ingestion intake of uranium would result in a committed effective dose equivalent (CEDE) to the whole
body of:

5 rem) (1000 mrem

— _4 [
CEDE = (2.8 x 10™* uCi) (zoua

) = 0.07 mrem
rem

The bioclogical solubility of dissolved uranium in treated groundwater has not been established, but
regardless of solubility class, the conservatively calculated doses above are negligible relative to the
annual stochastic dose limit (5 rem/yr} or non-stochastic dose limit (50 rem} for workers as specified in
10 CFR 20.1201.

INHALATION PATHWAY

For the inhalation pathway, 10 CFR 20 Appendix B gives a Derived Air Concentration (DAC) for soluble and
insoluble forms of natural uranium as follows:

e Soluble uranium DAC =5 x 10 uCi/mL
e Insoluble uranium DAC =2 x 10" uCi/mL

It would be unrealistic to assume that any worker could be continuously exposed to the calculated
airborne uranium activity concentration of 6.9 x 10* uCi/mL (Section 3). It was instead conservatively
assumed that on an annual basis, a worker is exposed to this airborne uranium concentration 10% of the
time (200 hours out of a total of 2,000 work hours per year). Based on this assumption, the annual CEDE
from inhalation of uranium for each solubility class are calculated as follows:

15 MCI - 1DAC 2.5mrem 3
—) _— ) = 6.9 X 107> mrem
mL/\ s 10_10;1_6'1
mlL

CEDE (soluble V) = (6.9 X 10 DAC — hr

(200 hrs) (

uCT (200 hrs)

uCi) 1 DAC (2.5 mrem
1182~
2x10 -

CEDE (insoluble U) = (6.9 x 10715 ) = 0.2 mrem

m DAC — hr

Regardless of the actual biological solubility of uranium loaded on Zeolite media, the expected CEDE to
any worker is negligible relative to the 5 rem dose limit for radiation workers. This would also be true ifa
worker were continuously exposed for 2,000 hours/year to this concentration of insoluble uranium in air
due to releases of particulate Zeolite media to air (the expected CEDE under this scenario would be about
2 mrem).
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5. Non-radiological (Toxicity) Assessment

Although the biological solubility of dissolved uranium in treated groundwater, or uranium adsorbed to
Zeolite media, has not been established, it is known that soluble forms present a toxicity concern for the
kidneys. 10 CFR 20.1201(e) requires licensees to the limit the intake of soluble uranium by workers to
10 mg in any 1-week period based on chemical toxicity. For the accidental ingestion scenario, the
occupational intake of uranium from ingestion of 1 liter of influent groundwater at the Zeolite facilities
would be 0.4 mg. To exceed the 10 mg/week regulatory limit, a worker would have to ingest 25 liters of
influent groundwater in 1 week.

With respect to the 10 mg/week regulatory limit on intakes via the inhalation pathway, footnote 3 of
Appendix B to 10 CFR 20 gives an average airborne concentration limit of 0.2 mg/m? for soluble uranium.
Assuming a mass-based concentration of soluble uranium in air of 1 x 10° mg/m3 as previously calculated
(Section 3), a breathing rate of 20 L/minute, and a maximum plausible exposure time of 40 hours in any
given week, the calculated weekly inhalation intake to a worker occupationally exposed to uranium in
airborne particulates from the Zeolite beds was calculated as follows:

3 -
. mg{ m 20 L\ /60 min _
- -5 — 4
Inhalation Intake =1 x 10 3 (1000 L)( -in) ( o ) (40 hours) = 48 x 107* mg

The calculated maximum plausible intake of uranium via the inhalation pathway when working at the
Zeolite facilities (4.8 x 10 mg) is insignificant relative to the 10 mg/week regulatory limit on intakes based
on toxicity concerns.

6. Conclusions

The results of this assessment indicate that potential occupational exposures to uranium from Zeolite

facility operations will not result in significant radiological doses or intakes with respect to toxicity
concerns. The conservatively calculated estimate for each occupational health endpoint evaluated is far
below any regulatory limits.
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